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AAN DE SLAG

INSTALLATIE
Windows

Installatie
Start MuseScore
Verwijderen
Foutopsporing

Mac OS X
Installatie
Verwijderen

Linux
Fedora

Zie ook

INSTALL ON WINDOWS
Install

Start MuseScore

Uninstall
Troubleshooting
External links

INSTALL ON MACOS
Install
Uninstall
Install with Apple Remote Desktop
External links

INSTALL ON LINUX
AppImage

Step 1 - Download
Step 2 - Give execute permission
Step 3 - Run it!
Installing the AppImage (optional)
Using command line options

Distribution Packages
Fedora

External links

INSTALL ON CHROMEBOOK
Desktop program
Android app (playback only)
External links

MAAK EEN NIEUWE PARTITUUR
Starthulpscherm
Maak een nieuwe partituur
Titel, componist en andere informatie
Instrumenten (en zang)
Een notenbalk toevoegen aan een instrument
Selecteer voortekens en tempo
Maatsoort, Opmaat en aantal maten
Aanpassingen achteraf
Sjablonen

Map voor systeemsjablonen
Map voor gebruikerssjablonen

Zie ook
Externe links

TAALINSTELLINGEN EN BIJWERKEN VAN DE VERTALINGEN
Taal wijzigen
Bijwerken vertalingen
Zie ook

CONTROLEREN OP NIEUWE VERSIE
Automatische controle
Handmatige controle
Zie ook

BASISFUNCTIES

NOTEN INVOER
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Basic note entry
Step 1: Starting position
Step 2: Note input mode
Step 3: Duration of the note (or rest)
Step 4: Enter pitch (or rest)
Other shortcuts

MIDI keyboard
Coloring of notes out of an instrument's range
Small notes
Note properties
Note changing (with no rhythm change)
See also
External links

BEWERKINGSMODUS
Bewerkingsmodus

Tekst
Lijnen
Noten

Zie ook

PALETTEN EN WERKRUIMTES
Paletten gebruiken
Werkruimtes

Eigen werkruimte

Vooraf ingestelde paletten
Hoofdpalet
Zie ook

INSTELLINGENOVERZICHT EN OBJECT EIGENSCHAPPEN
Instellingenoverzicht

Categorieën

Eigenschappen (benaderd via rechts klikken)
Maat-eigenschappen
Notenbalk-eigenschappen
Tekst-eigenschappen

Zie ook

MAATBEWERKINGEN
Toevoegen
Invoegen
Verwijderen
Eigenschappen

Notenbalken
Maatduur
Overige

Nummering
Splitsen en samenvoegen
Zie ook

STEMMEN
Wanneer gebruik je stemmen
Instructies
Verborgen ruimte rusten
Wissel de stem van noten
Zie ook
Externe links

KOPIËREN EN PLAKKEN
Kopiëren
Plakken
Snelle herhaling
Selectiefilter
Zie ook
Externe links

SELECTIE MODUS
Selectie van een enkel object
Selectie van meerdere aaneengesloten objecten tegelijk (een bereik)
Selectie van meerdere niet-aaneengesloten objecten tegelijk
Selecteer alle soortgelijke elementen
Waarvoor kan dit gebruikt worden?
Zie ook

WEERGAVE MODI
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Pagina/Doorlopende weergave
Pagina weergave
Doorlopende weergave

Schaal
Meerdere partituren weergeven
Schermvullend
Navigator
Zie ook

MAAK ONGEDAAN... EN DOE OPNIEUW...

SLA OP/EXPORTEER/DRUK AF
Menu Bestand

Bestandsformaten in: 'Sla op', 'Sla op als…', 'Sla een kopie op...', 'Sla selectie op…' en 'Sla online op...'
Bestandsformaten in: 'Exporteer', 'Partijen exporteren'
Druk af

Zie ook

PARTITUREN ONLINE DELEN
Een account aanmaken
Deel een partituur direct vanuit MuseScore
Upload een partituur op MuseScore.com
Bewerk een partituur op MuseScore.com
Zie ook

WERKELIJKE TOONHOOGTE
Zie ook

NOTATIES

MAATSOORTEN
Voeg een maatsoort toe aan een partituur
Verwijder een maatsoort
Maak je eigen maatsoort
Standaard waardestrepen wijzigen
Samengestelde maatsoorten
Afwijkende duur van de maatsoort: Opmaten en Cadenza
Lokale maatsoorten
Maatsoort wijzigen en andere objecten
Zie ook

MAATSTREPEN
Het type maatstreep aanpassen
Maak Omspannen/Gepaarde notenbalken
Zie ook

MUZIEKSLEUTELS
Toevoegen
Verwijderen

TOONSOORTEN
Een nieuwe toonsoort toevoegen
Een bestaande toonsoort vervangen
Een toonsoort verwijderen
Herinneringsvoortekens
Herstellingstekens bij wijziging van de voortekens
Toonsoorten en meermaatsrusten
Herinneringsvoortekens en Sectie-einden
Toonsoorten aanpassen

ADEMHALINGEN EN PAUZES

ANTIMETRISCHE FIGUREN
Instructies
Noteninvoermodus
Eigenschappen
Stijl
Zie ook
Externe links

ARPEGGIOS EN GLISSANDOS
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Externe links

ARTICULATIONS AND ORNAMENTS
Articulations
Ornaments
Add articulation/ornament

Add accidental to an ornament
Add fermata to a barline
Keyboard shortcuts

Adjust position
Articulation properties
See also
External links

BEND/TOONBUIGING
Toonbuiging toevoegen
Toonbuiging bewerken
Hoogte aanpassen
Positie aanpassen
Aangepaste toonbuigingen

HAARSPELDEN
Haarspelden toevoegen
Haarspelden aanpassen
Haarspeld afspelen

HAKEN
Toevoegen
Wisselen
Aanpassen
Horizontale verplaatsing
Verwijderen

LEGATOBOOG
Eerste Methode
Tweede Methode
Derde Methode
Aanpassingen
Gestippelde lijn
Zie ook

LIJNEN
Lengte aanpassen
Zie ook

MAATRUSTEN
Helemaatsrust
Meermaatsrust

Instructie
Beperkingen

Onderbreek meermaatsrust

OCTAVE LINES
Apply an octave line
Change length
Custom lines
External links

OVERBINDING
Eerste methode
Tweede methode
Overbinding omkeren
Gebonden akkoorden
Gebonden unisono noten

SIERNOTEN
Instructies
Externe links

TREMOLO

VOORTEKENS
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Herbepaal toonhoogtes
Zie ook
Externe links

WAARDESTREPEN
Zie ook

HERHALINGEN
Afspelen
Herhalingssymbolen en -tekst
Sprongen
Zie ook
Externe links

VOLTA
Tekst
Afspelen
Externe links

TRANSPONEREN
Chromatisch transponeren - op toonsoort
Chromatisch transponeren - op interval
Diatonisch transponeren
Transponerende instrumenten
Zie ook

DRUMNOTATIE
MIDI toetsenbord
Computer toetsenbord
Muis
Drumset
Roffel
Externe links

TABLATUUR
Een tablatuur notenbalk maken

Met de 'Nieuwe Partituur' wizard
Door het wijzigen van het type notenbalk

Wijzig instrument snaargegevens (stemming)
Tablatuur instellingen

Combineer een standaard notenbalk met een tablatuur notenbalk
Maak een gekoppeld standaard/TAB notenbalk paar
Maak een niet-gekoppeld standaard/TAB notenbalk paar

Invoeren nieuwe noten
Noten bewerken
Overzicht van toetsen
Externe links

GELUID EN AFSPELEN

AFSPEEL MODE
Afspeelpaneel
Aftellen
Afspelen met Metronoom
Lus

GELUID WIJZIGEN EN AANPASSEN
Mixer

Dempen en Solo
Knoppen
Geluid

Wijzig instrument
Geluid wijzigen in notenbalk (pizz., gedempt, etc.)
Zie ook

INSTRUMENTWIJZIGING IN NOTENBALK
Toevoegen van een instrumentwijziging
Zie ook

SOUNDFONT
Overzicht
Een SoundFont installeren
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De-installeren

Synthesizer
Lijst met SoundFonts

Gespecialiseerde SoundFonts

Probleemoplossing
Zie ook
Externe links

SWING
Swing Inschakelen
Terug naar gewoon ritme
Swing-instellingen

Swing tekst instellingen
Globale swing-instellingen

SYNTHESIZER
Overzicht
SoundFont

Volume
Effecten

Stemming
Aanpassen van de Stemming
Standaard stemming instellen
Stemming instellen voor een individuele partituur
Zie ook

TEMPO
Tempotekst
Afspeelpaneel

DYNAMIEK
Dynamische tekens

Aanpassen van het afspeel volume voor een dynamiek teken

Afspeelpaneel
Externe links

TEKST

TEKST ALGEMEEN
Tekst toevoegen
Tekst opmaak
Notenbalk- en systeemtekst

Notenbalktekst
Systeemtekst

TEKST BEWERKEN
Tekst bewerken

Bewerkingscommando's en toetsenbord sneltoetsen
Sneltoetsen voor speciale karakters

Symbolen en speciale karakters
Zie ook

TEKSTSTIJL
Tekststijlen en tekst-eigenschappen
Tekst soorten
Een nieuwe tekst stijl maken
Toepassen opties
Tekst opnieuw instellen naar stijl
Zie ook

STAFF AND SYSTEM TEXT
Staff text
System text
See also
External links

AKKOORDSYMBOLEN
Akkoordsymbolen syntax
Akkoordsymbool stijl

Verschijning
Noot spelling
Positionering

Zie ook
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VINGERZETTING
Zie ook

LIEDTEKST
Speciale karakters
Individuele liedtekst regels aanpassen
Zie ook
Externe links

REPETITIETEKENS
Hoe maak je ze
Eigenschappen
Automatisch opvolgend repetitieteken
Zoek naar een repetitieteken
Zie ook

OPMAAK

OPMAAK EN LAY-OUT
Mogelijkheden om de lay-out te beïnvloeden
Opmaak → Pagina-instellingen...
Opmaak → Vergroot uitrekking, Verminder uitrekking
Stijl → Algemeen... → Partituur
Stijl → Algemeen... → Pagina
Stijl → Algemeen... → Koptekst, voettekst, nummers
Stijl → Algemeen... → Systeem
Stijl → Algemeen... → Maat
Stijl → Algemeen... → Maatstrepen
Palet → Afbrekingen & afstandshouders
Stijl → Algemeen... → Noten
Stijl → Algemeen... → Muziekleutels
Stijl → Algemeen... → Gebroken Akkoorden
Stijl → Algemeen... → Waardestrepen
Stijl → Algemeen... → Legatobogen/Overbindingen
Stijl → Algemeen... → Groottes
Stijl → Algemeen... → (De)Crescendo, Volta, Ottava
Stijl → Algemeen... → Pedaal, trillen
Stijl → Algemeen... → Akkoordsymbolen, fretborddiagrammen
Stijl → Algemeen... → Basso continuo
Stijl → Algemeen... → Articulaties, versieringen
Stijl → Algemeen... → Voortekens
Stijl → Algemeen... → Antimetrische figuren
Ruimte bewerken tussen individuele noten
Toepassen en OK knoppen
Pas toe op alle partijen
Opslaan en Laden Stijl
Zie ook
Externe links

GENERAL STYLE: MEASURE
Introduction
Options

PAGINA-INSTELLINGEN
Pagina-afmetingen
Pagina marges
Notenbalkafstand/schalen
Overige

AFBREKINGEN EN AFSTANDSHOUDERS
Toevoegen van een afbrekingen of afstandshouders
Verwijder een afbreking of afstandshouder
Sectie-einde
Zie ook

KADERS
Horizontaal kader
Verticaal kader
Tekstkader
Een kader maken
Een kader verwijderen
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Zie ook
Externe links

AFBEELDINGEN
Zie ook

AFBEELDINGSOPNAME
Zie ook

ELEMENTEN UITLIJNEN

GEAVANCEERDE ONDERWERPEN

ALBUM
Een Album Maken
Laad Album
Album afdrukken
Partituren Samenvoegen
Album Opslaan

BASSO CONTINUO (BECIJFERDE BAS)
Toevoegen van een nieuwe basso continuo indicatie
Tekst opmaak

Getallen
Voortekens
Gecombineerde figuren
Haakjes
Voortzettingslijnen
Duur

Bewerken bestaande basso continuo figuren
Stijl
Juiste syntaxis
Overzicht van toetsen

BESTANDSFORMATEN
MuseScore eigen formaten

MuseScore formaat (*.mscz)
Ongecomprimeerd MuseScore formaat (*.mscx)

MuseScore back-up bestanden
MuseScore back-up bestand(*.mscz, of *.mscx,)

Bekijken en afdrukken (alleen exporteren)
PDF (*.pdf)
PNG (*.png)
SVG (*.svg)

Beluisteren (Alleen exporteren)
WAV audio (*.wav)
FLAC audio (*.flac)
Ogg Vorbis (*.ogg)
MP3 (*.mp3)

Delen met andere muziek software
MusicXML (*.xml)
Gecomprimeerde MusicXML (*.mxl)
MIDI (*.mid, *.midi, *.kar)
MuseData (*.md) (Alleen importeren)
Capella (*.cap, *.capx) (Alleen importeren)
Bagpipe Music Writer (*.bww) (Alleen importeren)
BB (*.mgu, *.sgu) (Alleen importeren)
Overture (*.ove) (Alleen importeren)
Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (Alleen importeren)

Zie ook

FRETBORDDIAGRAM
Toevoegen van een Fretborddiagram, barré en positie nummer

GEDEELDE NOOTKOPPEN

GEREEDSCHAPPEN
Voeg toe/verwijder regelafbrekingen
Verdeel / Voeg samen

Verdeel
Voeg samen

Vul met schuine strepen
Schakel 'Ritmische schuine streep-notatie' om
Herbepaal opeenvolgende repetitietekens
Zie ook
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HOOFDPALET
Symbolen
Zie ook

MIDI IMPORTEREN
Beschikbare bewerkingen

NOTE INPUT MODES
Step-time
Re-pitch
Rhythm
Real-time (automatic)
Real-time (manual)

Real-time Advance shortcut

See also
External links

NOTENBALK-EIGENSCHAPPEN
Overzicht
Bewerk notenbalk-eigenschappen

Geavanceerde stijl-eigenschappen

Standaard en Percussie notenbalk specifieke eigenschappen
Tablatuur notenbalk specifieke eigenschappen

Fret markeringen
Notenwaarden
Voorbeeld

OUDE MUZIEK MOGELIJKHEDEN
Notatie zonder onderverdeling in maten
Mensurstrich
Ambitus
Mensurale maatsoort
Zie ook

PARTIJEN MAKEN
Instellen van de partijen

Alle partijen in één keer instellen

Partijen exporteren
Opslaan

PARTITUUR INFORMATIE
Reeds bestaande meta labels
Aanpassen van een meta label
Een nieuw meta label toevoegen
Koptekst/voettekst
Zie ook

PLUGINS
Installatie

Windows
Mac OS X
Linux

Aan-/uitzetten plugins
Maak/bewerk/uitvoeren plugins
Standaard geïnstalleerde Plugins

ABC Import
Break Every X Measures (Onderbreek Iedere X Maten)
Notes → Color Notes (Noten Kleuren)
Create Score (Maak partituur)
helloQml
Notes → Note Names (Noot Namen)
panel (paneel)
random (willekeurig)
random2 (willekeurig 2)
run (uitvoeren)
scorelist (partituur lijst)
ScoreView (Partituur weergave)
Walk (Loop)
Gereedschappen

RECOVERED FILES
Behavior of saving after session recovery
Finding recovered files
See also
External links
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209

TOEGANKELIJKHEID
Inleiding
Originele instellingen
Wegwijs maken
Het partituur venster
Partituur lezen

Vooruit of achteruit in tijd verplaatsen
Verplaatsen tussen noten op een bepaalde punt
Partituur lezen filteren

Partituur afspelen
Partituur bewerken
Aanpassingen

VOORKEUREN
Algemeen
Werkblad
Noteninvoer
Partituur
I/O
Import
Exporteer
Sneltoetscombinaties
Werk bij
Zie ook

WAARDESTREPEN DOOR MEERDERE NOTENBALKEN
Zie ook

NIEUWE MOGELIJKHEDEN IN MUSESCORE 2.X

ZIE OOK

BIJWERKEN VANAF MUSESCORE 1.X
Hoe kan ik MuseScore bijwerken
Openen van 1.x partituren in MuseScore 2
Lokale her-opmaak/lay-out
Het geluid gebruiken van MuseScore 1.x

ONDERSTEUNING

HELPEN EN VERBETEREN VAN DE VERTALING
Software vertaling
Website en handboek vertaling
Zie ook

HOE VRAAG JE OM HULP EN VUL JE EEN BUG RAPPORT IN
Zie ook

TERUG NAAR FABRIEKSINSTELLINGEN
Instructies voor Windows
Instructies voor Mac OS X
Instructies voor Linux (pas aan voor andere versie dan Ubuntu)
Zie ook

BEKENDE INCOMPATIBILITEIT MET ANDERE HARDWARE EN SOFTWARE
Hardware incompatibilities
Software incompatibiliteit

AVG Internet Security hangt MuseScore
Lettertype probleem in Mac OS X
Lettertype probleem in Linux
Sla op als dialoog leeg in Linux

BIJLAGEN

BEKENDE BEPERKINGEN VAN MUSESCORE 2.0
Basisfuncties

Sla selectie op
Lokale Maatsoorten

Noteninvoer
Tablatuur notenbalk gekoppeld aan een standaard notenbalk

Geluid en afspelen
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Instrument wijzigen
Mixer

Opmaak
Koptekst & voettekst

SNELTOETSCOMBINATIES
Navigeren
Noteninvoer

Duur/Lengte
Stemmen
Toonhoogte
Interval

Richting
Articulaties
Tekst invoer
Liedtekst invoer
Weergave
Zie ook

OPDRACHT REGEL OPTIES
Qt Gereedschap Opties
Zie ook
Externe links

WOORDENLIJST
Externe links

TABLE OF CONTENTS

GETTING STARTED
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SOUND AND PLAYBACK

TEXT

FORMATTING
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NEW FEATURES IN MUSESCORE 2.0

SUPPORT
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Published on MuseScore (https://musescore.org)

Dit handboek is geschreven voor MuseScore versie 2.0 en hoger. Het wordt onderhouden door de MuseScore
community. Leer hoe je kan meehelpen .

Aan de slag

Deze paragraaf helpt je om MuseScore te installeren en in gebruik te nemen. Je zal ook leren hoe je een nieuwe partituur
moet maken.

Installatie

MuseScore werkt op verschillende computer systemen inclusief Windows, Mac OS X en Linux.

Windows

Installatie

Je kunt het Windows installatie pakket op de Nonexistant node nid: 27 pagina van de MuseScore website downloaden.
Klik op de link om de download te starten. Je internet browser zal je vragen om de download te bevestigen. Klik Bestand

Opslaan.

Zodra de download klaar is, dubbelklik het bestand om de installatie te starten. Windows kan nu een veiligheidsdialoog
tonen waarin gevraagd wordt om te bevestigen of je de software wilt uitvoeren. Klik Uitvoeren om verder te gaan, je zult
dan kort het volgende venster zien:

NOT FOUND: Win-Install-Wizard-1a.png

gevolgd door:

NOT FOUND: Win-Install-Wizard-1b.png

Als je dit niet ziet maar iets anders, dan is het mogelijk dat de .msi extensie niet gekoppeld is aan msiexec.exe. Je kunt de
extensie koppeling oplossen , of gebruik maken van de verplaatsbare versie van MuseScore .

De installatie gaat verder met:

NOT FOUND: Win-Install-Wizard-1c.png

Als je op Cancel klikt, nu of later, dan zie je:

NOT FOUND: Win-Install-Wizard-2a.png

Als je op Next klikt om te verder te gaan, dan zal de installatie wizard de condities van de gratis software
licentieovereenkomst tonen.

NOT FOUND: Win-Install-Wizard-2b.png

Lees de condities van de overeenkomst en zorg dat het vakje naast de tekst I accept the terms in the License Agreement  is
aangevinkt en klik op Next om verder te gaan. Nu moet de installatie locatie voor MuseScore worden bevestigd.

NOT FOUND: Win-Install-Wizard-3.png

Als je een nieuwe versie van MuseScore installeert en de oude versie wilt behouden op de computer, dan moet je de
locatie wijzigen (versie 2.0 en 1.x kunnen naast elkaar worden gebruikt en overschrijven elkaar niet, hiervoor is geen
aanpassing nodig). In andere gevallen klik op Next om verder te gaan.

NOT FOUND: Win-Install-Wizard-4.png

Klik Install om verder te gaan.

Geef de installatie wizard een paar minuten om de benodigde bestanden en configuratie te installeren. Je ziet het
volgende scherm:

NOT FOUND: Win-Install-Wizard-5b.png
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en als laatste:

NOT FOUND: Win-Install-Wizard-5c.png

Klik Finish om de installatie af te sluiten. Je mag het installatie pakket dat je hebt gedownload verwijderen.

Start MuseScore

Om MuseScore te starten, kies Start → Alle Programma's → MuseScore 2 → MuseScore 2.

Verwijderen

Je kunt MuseScore verwijderen in 32-bit Windows met het commando:

    cd C:\Program Files\MuseScore
    Uninstall.exe /S

en op 64-bit Windows met het commando:

    cd C:\Program Files (x86)\MuseScore
    Uninstall.exe /S

Foutopsporing

In Windows XP en Vista kan de installatie door het systeem geblokkeerd worden. Als je MuseScore niet kunt installeren,
klik dan met rechts op het bestand dat je gedownload hebt en kies Eigenschappen. Als je de tekst ziet: "Dit bestand is
afkomstig van een andere computer en wordt mogelijk geblokkeerd om deze computer te beveiligen", klik dan op
"Blokkering opheffen", "OK" en dubbelklik nogmaals op het bestand.

Mac OS X

Installatie

Je vind het DMG (disk image) bestand op de Nonexistant node nid: 27 pagina van de MuseScore website. Klik op de Mac
OS X link om de download te starten. Zodra de download klaar is, dubbelklik op het DMG bestand om het disk image te
mounten.

NOT FOUND: Mac_Install.png

Sleep het MuseScore icoon naar de Applicatie map icon.

Indien je niet als administrator bent aangemeld, dan kan Mac OS X mogelijk om een wachtwoord vragen: klik Authenticate

en voer het wachtwoord in om verder te gaan.

NOT FOUND: Mac_Install_2.png

Wanneer de applicatie klaar is met het kopiëren, verwijder dan het disk image. Je kunt MuseScore nu starten vanuit de
Applicatie map, Spotlight of Lauchpad.

Verwijderen

Verwijder MuseScore uit de Applicatie map.

Linux

Zie de Nonexistant node nid: 27 pagina voor instructies behorende bij MuseScore op Linux. Pakketten zijn beschikbaar
voor Debian, Unbuntu, Fedora en PCLinuxOS. Voor andere distributies is het nodig om de applicatie te compileren van de
bron. Voor de instructies, specifiek voor Fedora, zie hieronder.

Fedora

1. Importeer de GPG sleutel:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve
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2. Ga naar de Nonexistant node nid: 27 pagina van de MuseScore website. Klik op de link voor de stabiele Fedora
download en kies het juiste rpm pakket voor jouw platform.

3. Afhankelijk van jouw platform, gebruik één van de volgende twee commando's om MuseScore te installeren

voor platform i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm

voor platform x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm

Als je problemen hebt met het geluid, zie dan Fedora 11 en geluid

Zie ook

Hoe kan ik de taal van MuseScore aanpassen
Hoe kan ik MuseScore installeren zonder administrator rechten
Hoe kan ik MuseScore uitvoeren als Administrator in Windows

Install on Windows

Install

If you're on Windows 10, MuseScore can be installed from the Windows Store. Clicking here  will open Musescore's
page in the Store app. There you will only have to click Get the app >  and MuseScore will be downloaded and installed.

Otherwise you can get the Windows installer from the download  page of the MuseScore website. Click on the link to
start the download. Your Internet browser will ask you to confirm that you want to download this file. Click Save File.

When the download finishes, double-click on the file to start the installation. Windows may prompt you with a security
window to confirm this before running the software. Click Run to continue, you'll then briefly see

followed by
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In case you don't see this installer window but something else, it's possible that the .msi extension is not associated with
msiexec.exe. Either you can fix the association , or download and use the portable version of MuseScore  instead.

Continuing you'll see

If you click Cancel, here or later, you'll see:

If instead you click Next to continue, the setup wizard displays the terms of the free software license.
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Read the terms of the license, make sure the box next to "I accept the terms in the License Agreement" is checked, and
click Next to continue. Next the installer will ask you to confirm the location in which to install MuseScore.

If you are installing a newer version of MuseScore but still want to keep the old version on your computer, then you
should change the folder (note that MuseScore 2 can coexist with MuseScore 1 with no changes needed). Otherwise click
Next to continue.
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Click Install to continue.

Give the setup wizard a few minutes to install the necessary files and configurations. You'll see

and finally
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Click Finish to exit the installer. You may delete the installer file you downloaded.

Start MuseScore

To start MuseScore, from the menu, select Start→All Programs→MuseScore 2→MuseScore 2.

Uninstall

You can uninstall MuseScore from the menu by selecting Start→All Programs→MuseScore 2→Uninstall MuseScore; or via
Windows' Control Panel. Note that this will not remove your scores nor your MuseScore settings.

Troubleshooting

On Windows XP and Vista, the installer might be blocked by the system. If you don't manage to install MuseScore, right
click the downloaded file and click Properties. If there is a message "This file came from another computer and might be
blocked to help protect this computer", click on "Unblock", "OK" and double click on the downloaded file again.

External links

How to install MuseScore on Windows without administrator rights
How to run MuseScore as Administrator on Windows
How to change the language in MuseScore

Install on macOS

Install

You will find the DMG (disk image) file on the download  page of the MuseScore website. Click on the macOS link to
start the download. When the download is complete, double-click the DMG file to mount the disk image.
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Drag and drop the MuseScore icon to the Applications folder icon.

If you are not logged in as administrator, macOS may ask for a password: click Authenticate and enter your password to
proceed.

When the application has finished copying, eject the disk image. You can now launch MuseScore from the Applications
folder, Spotlight, or Launchpad.

Uninstall

Simply delete MuseScore from Applications folder.

Install with Apple Remote Desktop

You can deploy MuseScore to multiple computers with the "Copy" feature of ARD. Since MuseScore is a self-contained
application you can simply copy the application to the '/Application' folder on the target machines. It is also possible to
install multiple versions of the application as long as their names differ.

External links

How to run MuseScore 2.x on Mac OS X 10.6
How to change the language in MuseScore

Install on Linux

As of MuseScore 2.0.3 you can, for the first time, get hold of a copy for Linux straight from the download  page, just like
Windows and Mac users. This is possible thanks to the AppImage packaging format, which runs on pretty much all Linux
distributions. If you prefer, there is still the option to get it the traditional way via your distribution's package manager (but
you may have to wait for it to get packaged by the relevant maintainer). Of course, you can always build from source .
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AppImage

The AppImage format  is a new way of packaging Linux applications. AppImages are portable - they don't have to be
installed - and they run on pretty much any Linux distribution. Dependencies are included in the one AppImage file.

Step 1 - Download

Before you download an AppImage, you need to know your processor's architecture. These terminal commands will show
it:

    arch

or

    uname -m

The output will be something like "i686", "x86_64" or "armv7":

i686 (or similar) - 32-bit Intel/AMD processor (found on older machines).
x86_64 (or similar) - 64-bit Intel/AMD processor (modern laptop and desktop computers, most Chromebooks).
armv7 (or later) - ARM processor (phones & tablets, Raspberry Pi 2/3 running Ubuntu Mate, some Chromebooks,
usually 32-bit at present).

Now you can head over to the download  page and find the AppImage that best matches your architecture. Once
downloaded, the file will be named "MuseScore-X.Y.Z-$(arch).AppImage".

Step 2 - Give execute permission

Before you can use the AppImage you need to give permission for it to be run as a program.

From the Terminal:

This command gives the user (u) permission to execute (x) the AppImage. It works on all Linux systems.

    cd ~/Downloads
    chmod u+x MuseScore*.AppImage

Note: Use the "cd" command to change directory to wherever you saved the AppImage.

From a File Manager:

If you prefer to avoid the command line, there is usually a way give execute permission from inside a File Manager.

In GNOME Files (Nautilus), simply:

1. Right-click on the AppImage and select "Properties".
2. Open the "Permissions" tab.
3. Enable the option labelled "Allow executing file as a program".

The process may be slightly different in other file managers.

Step 3 - Run it!

Now you should be able to run the program simply by double-clicking on it!

When you downloaded the AppImage it was probably saved in your Downloads folder, but you can move somewhere else
it at any time (e.g. you could put it on your desktop for easy access). If you ever want to remove it then simply delete it.

Installing the AppImage (optional)

You can run the AppImage without installing it, but you must install it if you want it to be completely integrated with your
desktop environment. This has the following benefits:

Adds the AppImage to your Applications Menu or Launcher
Sets the correct icons for MuseScore's files (MSCZ, MSCX) and for MusicXML files (MXL, XML)
Makes the AppImage available via your File Manager's right-click "Open with..." menu
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To install it, run the AppImage from the Terminal with the "install" option (see immediately below). This copies a desktop
file and various icons to your computer. If you want to remove them you will need to run the "remove" option before you
delete the AppImage. This does not affect any scores created with any version of MuseScore.

Using command line options

Running the AppImage from the Terminal allows you to use various command line options. The AppImage has some
special options in addition to MuseScore's normal command line options.

You will need to change directory (cd) to wherever the AppImage is saved your system, for example:

    cd ~/Desktop
    ./MuseScore*.AppImage [option...]

Or give the path to the AppImage:

    ~/desktop/MuseScore*.AppImage [option...]

Use the "--help" and "man" options to get more information about the available command line options:

    ./MuseScore*.AppImage --help   # displays a complete list of command line options
    ./MuseScore*.AppImage man      # displays the manual page (explains what the options do)

Distribution Packages

Fedora

1. Import the GPG key:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve
 

2. Go to the download  page of the MuseScore website. Click on the link for the stable Fedora download and choose
the correct rpm package for your architecture.

3. Depending on your architecture, use one of the two sets of commands to install MuseScore

for arch i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm
 

for arch x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm
 

If you have difficulty with sound, see Fedora 11 and sound .
See also the hints for the various distributions on the download page .

External links

How to run the MuseScore AppImage on Linux  - video
How to change the language in MuseScore

Install on Chromebook

Desktop program

MuseScore's desktop program will not work natively on Chrome OS, but there are some workaround solutions:

1. Since Chrome OS 69, certain chromebook models are able to run Linux apps and so you can install MuseScore for
Linux as provided on our Download page . Feedback about the installation process and supported hardware is
welcome on the forum
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2. Via software-on-demand service such as rollApp : By just visiting this website, you can run MuseScore in the
browser. You can access your scores via cloud services such as Google Drive or save them to your online
MuseScore account through the menu File→Save Online.... Note that currently, sound and playback does not work on
rollApp.

3. Via Crouton : Involves installing a Linux based operating system which runs in parallel with Chrome OS, and then
installing MuseScore on Linux.

Android app (playback only)

Alternatively, it is possible to install MuseScore's Android app  on recent Chromebooks. You will need to update to the
latest version of Chrome OS first. See the Chromebook support documentation for help installing Android apps on
Chromebooks , and a list of supported devices . The app only supports playback of existing scores, not score editing
or creation, but you can sign-in to your MuseScore account for easy access to all your scores on MuseScore.com.

External links

How to run MuseScore on a Chromebook
Check the installation procedure from the comments in this thread
How to change the language in MuseScore

Maak een nieuwe partituur

Bij het starten van MuseScore, krijg je het Starthulpscherm te zien.

Starthulpscherm

Je kunt kiezen tussen de volgende opties:

Maak een nieuwe partituur (door het icoon met het plusteken te gebruiken)
Open een recent geopende partituur
Als je MuseScore voor het eerst opent, open de zelfstudie-partituur "Getting Started"
Open een bestaande partituur uit de bestanden op uw computer
Zie de partituur van de dag: "In the spotlight"
Zoek naar muziek op musescore.com
Link naar mobiele applicaties
Link om MuseScore te volgen op sociale netwerken
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Maak een nieuwe partituur

Om een nieuwe partituur te maken als het starthulpscherm niet open staat, kies: Bestand → Nieuw... of gebruik de sneltoets
Ctrl+N (Mac: Cmd+N). Hiermee opent de wizard "Maak een nieuwe partituur".

Titel, componist en andere informatie

Voer de titel, de componist en andere informatie in zoals hierboven getoond, en klik op Volgende > en u krijgt:
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Hier kunt je een sjabloon kiezen om de partituur op te baseren.
Sjablonen worden hieronder in meer detail besproken.
Als je op "Instrumenten kiezen" klikt dan krijg je de mogelijkheid om precies te bepalen welke instrumenten in de partituur
zullen worden gebruikt.

Instrumenten (en zang)
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Het venster Instrumenten is ingedeeld in twee kolommen.
De linker kolom bevat een lijst van instrumenten en zang waaruit je kan kiezen.
De rechterkolom is aanvankelijk leeg. Hier komen de instrumenten voor de partituur.

De lijst in de linker kolom is ingedeeld in instrumentenfamilies.
Klik op een categorie om alle instrumenten van die familie te tonen.
Kies een instrument en klik op Toevoegen.
Het instrument dat je gekozen hebt verschijnt nu in het rechter deelvenster.
Je kunt meerdere instrumenten en/of stemmen toevoegen indien gewenst.

De standaardinstelling is "Algemene Instrumenten", maar boven de instrumentenlijst (links) kun je andere keuzes maken
zoals "Jazz-instrumenten", "oude muziek", e.a.

Je kunt ook de naam van het instrument invullen in het zoekvak onder de instrumentenlijst (links).
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De lijst "Alle instrumenten" wordt gefilterd en je krijgt alleen de instrumenten in de lijst waar het trefwoord in voorkomt.

Het standaard notenbalk-type heeft vijf lijnen maar sommige instrumenten kunnen gebruik maken van andere notenbalk-
types (drum/percussie, getokkelde snaarinstrumenten).

De volgorde van de instrumenten in de rechterkolom is de volgorde zoals ze op de partituur zullen verschijnen. Om de
volgorde te wijzigen: gebruik de knoppen: Omhoog of Omlaag

Als je klaar bent klik Volgende >.

Een notenbalk toevoegen aan een instrument

Met de optie Voeg notenbalk toe kun je een Dubbele notenbalk creëren voor de instrumenten die meer dan één
notenbalk gebruiken, zoals piano of gitaar + tablatuur.
Klik op een notenbalklijn in één van de instrumenten in het rechter deelvenster, waardoor deze oplicht. Bijvoorbeeld:
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Notenbalk 1 zoals in de afbeelding hierboven.

Klik ofwel op Voeg notenbalk toe of op Voeg gekoppelde notenbalk toe.

Het eerste zal een toepasselijke, onafhankelijke notenbalk toevoegen aan de door u geselecteerde.
Het tweede zal een toepasselijke, gekoppelde notenbalk toevoegen.

Het verschil is dat de wijzigingen die je hebt aangebracht aan een gekoppelde notenbalk, automatisch worden vertaald
naar de andere notenbalk. Bijvoorbeeld het koppel gitaar + tablatuur. (zie Tablatuur)
De tussenruimten in een dubbele notenbalk kan worden ingesteld via: Tussenruimten in een dubbele notenbalk instelling.

Selecteer voortekens en tempo

Hier kun je twee zaken instellen:
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Voortekens (door op één van de keuzemogelijkheden te klikken) en
Tempo (door eerst een vinkje te zetten naast "Tempo" en vervolgens het BPM (Beats Per Minute/Slagen per minuut) in te
stellen.
Als je klaar bent, klik op: Volgende>

Maatsoort, Opmaat en aantal maten

Hier kun je de initiële maatsoort instellen.
Als de partituur begint met een opmaat, moet je dat aangeven door een vinkje te zetten naast "Opmaat" en vervolgens de
Duur in te stellen (dezelfde instelling als "werkelijke duur" in de contextmenu Maateigenschappen).
Het aantal maten kun je hier ook opgeven, maar uiteraard kun je achteraf maten Toevoegen of Verwijderen.

Klik op Klaar om de nieuwe partituur te creëren.
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Aanpassingen achteraf

Je kunt alle instellingen die zijn opgegeven tijdens de procedure "Maak een nieuwe partituur" achteraf wijzigen, zelfs als je
al een tijdje in de partituur gewerkt hebt.

Om maten toe te voegen of te verwijderen, of om een opmaat te maken, zie: Maatbewerkingen

Om Tekst te wijzigen, zie: Tekst wijzigen.
Om een ontbrekende Titel (of een ander Tekstonderdeel) toe te voegen, kies: Voeg toe → Tekst → Titel (of een ander
Tekstonderdeel)

Om instrumenten toe te voegen, te verwijderen of de volgorde te wijzigen, kies: Bewerken → Instrumenten....

Sjablonen

In het tweede venster van de wizard kun je een sjabloon kiezen om de partituur op te baseren (zie boven voor details).
Om een partituur te maken met deze methode volstaat het om op de sjabloon te klikken in plaats van Instrumenten
kiezen. Handel de wizard verder af zoals gebruikelijk.

Sjabloon bestanden zijn gewone MuseScore bestanden, opgeslagen in een speciale map.
Standaard worden twee mappen voor sjablonen gemaakt: een map voor systeemsjablonen waarin de door MuseScore
meegeleverde sjablonen zijn opgeslagen en een map voor gebruikerssjablonen waarin eigen sjablonen kunnen worden
opgeslagen. Je kunt een eigen sjabloon maken die zal worden weergegeven in de wizard door de partituur op te slaan in
deze map.

Map voor systeemsjablonen

In Windows vindt je die meestal hier: C:\Program Files\MuseScore 2\templates of in de 64-bit versie: C:\Program Files (x86)\MuseScore

2\templates.

In Linux, kijk onder /usr/share/mscore-xxx als je met de the package manager geïnstalleerd hebt. Als je MuseScore zelf
gecompileerd hebt in Linux, kijk dan onder /usr/local/share/mscore-xxx (xxx staat voor de versie die je gebruikt).

In Mac OS X, kijk onder /Applications/MuseScore 2.app/Contents/Resources/templates.

Map voor gebruikerssjablonen

De map voor eigen sjablonen kun je zelf configureren in Bewerken → Voorkeuren... → General, MuseScore maakt zelf een map
met dit doel.

In Windows, de map voor gebruikerssjablonen bevindt zich in %HOMEPATH%\Documents\MuseScore2\Templates.

In Mac OS X en Linux, bevinden de mappen voor gebruikerssjablonen zich in ~/Documents/MuseScore2/Templates.

De wizard "Nieuwe partituur maken" zal zowel de systeemsjablonen als de gebruikerssjablonen tonen.

Zie ook

Toonsoorten
Maatsoorten
Muzieksleutels
Tempo
Notenbalk-eigenschappen

Externe links

Video zelfstudie: MuseScore in Minuten: Les 1 - Partituur opzetten

Taalinstellingen en bijwerken van de vertalingen

MuseScore is geïnstalleerd en werkt met de Systeem-taal van het besturingssysteem.
Deze taal is afhankelijk van het land, de taalinstellingen op de PC en de gebruiker (de meeste programma's maken
gebruik van deze taal)
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Taal wijzigen

1.Kies: Bewerken → Voorkeuren... (Mac: MuseScore → Voorkeuren...)
2. In de tab Algemeen ziet u een sectie Taal:

Hier kun je een andere taal kiezen uit een lijst en eventuele bijgewerkte versie van de vertaling downloaden met de knop:
Werk vertalingen bij
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Een nieuw venster verschijnt, met de door gekozen taal bovenaan. - Zie verder.

Zoals aangegeven moet je MuseScore afsluiten en opnieuw opstarten om de wijziging door te voeren.

Bijwerken vertalingen

Je kunt de vertalingen bijwerken via Bewerken --> Voorkeuren... (zoals hierboven beschreven), maar er is ook een andere
methode:

1. Ga naar Help → Databronnen-beheer...

2. Klik op de knop "Werk bij" van uw keuze

Ook hier moet je MuseScore afsluiten en opnieuw opstarten om de wijziging door te voeren.

Zie ook

Helpen vertalen en de vertaling verbeteren

Controleren op nieuwe versie

Er zijn twee manieren om op nieuwe versies te controleren.

Automatische controle

1. Kies: Bewerken → Voorkeuren... (Mac: MuseScore → Voorkeuren...)
2. Selecteer de tab Werk bij

3. Vink aan: Controleer op een nieuwe versie van MuseScore

32



Voortaan zal MuseScore bij iedere opstart controleren op nieuwe versies en indien nodig een melding geven als er een
nieuwe versie beschikbaar is.

Handmatige controle

1. Selecteer Help → Controleer op nieuwe versie
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2. Er verschijnt een dialoogvenster met vermelding van de status: ofwel "Geen nieuwe versie beschikbaar" ofwel "Een
nieuwe versie voor MuseScore is beschikbaar:" gevolgd door een link om deze te downloaden.

Zie ook

Voorkeuren: Werk bij

Basisfuncties

In het vorige hoofdstuk: "Aan de slag" namen we de installatie van het programma onder handen en de procedure: "Een
nieuwe partituur maken".
Dit hoofdstuk beschrijft de algemene methoden voor interactie met de partituur.

Noten invoer

Basic note entry

Noten en rusten toevoegen aan de notenbalk vereist vier eenvoudige stappen:

1. Selecteer uw uitgangspositie voor de noteninvoer
2. Selecteer de noteninvoer modus (N)
3. Selecteer de duur van de noot (of rust) die u wilt invoeren
4. Voer de toonhoogte (of rust) in met behulp van sneltoetsen, muis of een MIDI-keyboard

Om noten toe te voegen die beginnen/eindigen op verschillende tijdstippen (polyfonie): zie Stemmen.
Voor akkoorden, blijf hier verder lezen

Step 1: Starting position

Selecteer eerst een noot, of rust op de partituur als uitgangspositie voor de noteninvoer.
Als u geen uitgangspositie hebt geselecteerd zal de curor zich aan het begin van de partituur bevinden als u schakelt naar
de (see below).

Noteninvoer in MuseScore vervangt de bestaande noten/rusten in een maat door uw invoer (overschrijven i.p.v.
invoegen).

U kunt trouwens op elk punt een nieuwe maat invoegen (see Measure operations: Insert), of gebruik maken van de
functie copy and paste om een reeksnoten te verplaatsen.

Step 2: Note input mode

The "N" button at the left on the Note Input toolbar indicates whether you are in note input mode. To enter or leave note input

mode, you can click on the button, or you can use the shortcut N. To leave note input mode, you can also hit Esc.

Step 3: Duration of the note (or rest)

After entering note input mode, select the duration you need from the Note input toolbar, or use the corresponding shortcut.

Note that if you have an irregular rhythm division (such as three eighth notes in the time of two), see Tuplet

The shortcuts for selecting the duration are as follows:
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1: 64th (hemidemisemiquaver)
2: 32nd (demisemiquaver)
3: 16th (semiquaver)
4: Eighth (quaver)
5: Quarter (crotchet)
6: Half (minim)
7: Whole (semibreve)
8: Double whole (breve)
9: Longa
.: A period (dot) changes the selected duration into a dotted note/rest

Step 4: Enter pitch (or rest)

For all instruments (except unpitched percussion), you can add note pitches using the mouse by clicking directly on the
staff. (For instructions specific to percussion see Drum notation). However, you may find it quicker to use a MIDI keyboard
(see below), or your alphabetical computer keyboard. The following examples use the latter method.

Enter pitches by typing the corresponding letter on your keyboard: C D E F G A B C

0 (Zero) creates a rest: for example, typing C D 0 E gives the result shown below. Notice that the duration you select for the
notes (quarter/crotchet notes in this example) also determines the duration of the rest (quarter/crotchet rest).

During note input, the cursor automatically advances in the score. If you want to add a chord note to your previous entry,
hold Shift and enter a note name: C D Shift+F Shift+A E F

To create chords with notes of different durations, see Voices.

If you want to create a dotted note, press .. For example 5 . C 4 D E F G A

When you type a note on the keyboard, MuseScore places it closest to the previous note entered (above or below). When
entering chords, though, the new notes are added above the current note (bottom-up).
If either of these leads to a note ending up in the wrong octave, move it up or down by using the following shortcuts:

Ctrl+↑ (Mac: ⌘+↑): Increase the pitch of a note by one octave.
Ctrl+↓ (Mac: ⌘+↓): Decrease the pitch of a note by one octave.

Other shortcuts

Other useful editing shortcuts available in note input mode:

↑ (Up): Increase the pitch of a note by a semitone (uses ♯).
↓ (Down): Decrease the pitch of a note by a semitone (uses ♭).
Alt+Shift+↑: Increase the pitch of a note using key signature
Alt+Shift+↓: Decrease the pitch of a note using key signature
J: change note to enharmonic note
R: Duplicate the last entered note
Q: Halve the duration of the last entered note
W: Double the duration of the last entered note
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Backspace: Undo last entered note
X: Flip direction of note stem
Shift+X: Move note head to opposite side of stem

MIDI keyboard

You can also insert pitches using a MIDI keyboard.

1. Connect your MIDI keyboard to the computer and switch the former on
2. Start MuseScore (this must be done after the keyboard is switched on)
3. Create a new score
4. Click the rest (selecting it) in measure 1 to indicate where you want note input to begin
5. Press N to enter note input mode
6. Select a note duration such as 5 for quarter notes (crotchets), as described above
7. Press a note on your MIDI keyboard

The pitch should be added to your score.

Note: The MIDI keyboard enters one note or chord at a time. This mode of note input (often called "step-time entry") is fast
and reliable. Some notation software try to interpret "real-time entry", in which the musician plays a passage and the
software tries to produce notation. However, such results are generally unreliable. MuseScore focuses on more reliable
forms of note input.

If you have multiple MIDI devices connected to your computer, you may need to inform MuseScore which is the MIDI
keyboard. Go to Edit → Preferences... (Mac: MuseScore → Preferences...). In the preferences dialog, click on the I/O tab and select
your device under the section labeled "PortAudio".

Coloring of notes out of an instrument's range

Notes within the playable range of an instrument or voice part appear black, while those extending beyond the normal
range of an instrument are marked red. For some instruments, the range depends on the skill of the musician. For these
instruments, notes outside the range of an early amateur appear dark yellow, and notes outside the typical range of a
professional appear red.

The colors are informational and appear on the computer screen, but not on printed copies. To disable note colors,
choose Edit → Preferences... (Mac: MuseScore → Preferences...), click on the Note Input tab, and unmark "Color notes outside of
usable pitch range".

Small notes

1. Select the note(s) you want in small size
2. In the inspector you can change size of individual notes as well as chords with the tickable box "Small" (either in

Chord or Note part of the inspector)
You can change all small size proportions (even if it is unconventional) in Style → General → Sizes

Note: In the Inspector, Small in the 'Note' section reduces only the note head size; for chords, the stem, beam, and flag
sizes are reduced as a whole.

Note properties

See Layout and formatting, especially the sections about notes, accidentals and tuplets
See Inspector and object properties for properties for a note or selection of notes

Note changing (with no rhythm change)

If there is only one note, the best way is to select it and change it with either mouse, or keyboard.
If there is more than one note and no rhythm change, you can use either transposition (if the interval is strictly the same),
or re-pitch mode.

See Re-pitch mode
See Transposition

If your accidentals seem strange, you could also try Respell pitches mode (see Accidental: Respell pitches).
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See also

Drum notation
Preferences
Shared Noteheads
Tuplet
Voices
How to enter a chord
How to enter a rest
How to span a stem over two staves

External links

Video tutorial: MuseScore in Minutes: Lesson 3 - Note input
Video tutorial: MuseScore in Minutes: Lesson 4 - MIDI Keyboard Input
Video tutorial: MuseScore in Minutes: Lesson 5 - More Input Ideas

Bewerkingsmodus

Bewerkingsmodus

Vele componenten van de partituur kunnen gewijzigd worden in de Bewerkingsmodus.

Om over te schakelen naar de bewerkingsmodus doet je het volgende:
dubbelklik op een element
rechtsklik en kies Bewerk Element

selecteer het element (eenmaal klikken) en gebruik de sneltoets Ctrl+E (Mac: Cmd+E).
Om de Bewerkingsmodus te verlaten, druk Esc.

Tekst

Voor de Tekstbewerkingsmodus, zie Tekst bewerken.

Lijnen

Lijnen en verwante elementen, zoals Legatobogen, Arpeggios en Haken, vertonen "handgrepen" in de bewerkingsmodus
waarmee je de vorm kunt aanpassen, hetzij met toetsenbord commando's, hetzij door te slepen met de muis.

Legatoboog in bewerkingsmodus:

Beschikbare toetsenbordcommando’s:

←: Verplaatst de handgreep naar links: één (notenbalk)spatie.
(Een notenbalkspatie is de afstand tussen twee notenbalklijnen, zoals ingesteld in Pagina-instellingen)
→: Verplaatst de handgreep naar rechts: één spatie.
↑: Verplaatst de handgreep naar boven: één spatie.
↓: Verplaatst de handgreep naar onder: één spatie.
Ctrl+← (Mac: ⌘+←): Verplaatst de handgreep naar links: 0.1 (notenbalk)spatie.
Ctrl+→ (Mac: ⌘+→): Verplaatst de handgreep naar rechts: 0.1 (notenbalk)spatie.
Ctrl+↑ (Mac: ⌘+↑): Verplaatst de handgreep naar boven: 0.1 (notenbalk)spatie.
Ctrl+↓ (Mac: ⌘+↓): Verplaatst de handgreep naar onder: 0.1 (notenbalk)spatie.
Alt+←: Verplaatst de handgreep naar links: 0.01 (notenbalk)spatie.
Alt+→: Verplaatst de handgreep naar rechts: 0.01 (notenbalk)spatie.
Alt+↑: Verplaatst de handgreep naar boven: 0.01 (notenbalk)spatie.
Alt+↓: Verplaatst de handgreep naar onder: 0.01 (notenbalk)spatie.
Shift+←: Verplaatst de ankers (de noot of de maat waaraan de handgreep gehecht is) van de handgreep naar links
Shift+→: Verplaatst de ankers (de noot of de maat waaraan de handgreep gehecht is) van de handgreep naar rechts
Tab: Ga naar de volgende handgreep
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Noten

Als je, om wat voor reden dan ook, de positie van een noot handmatig wilt verschuiven naar links of naar rechts zet deze
dan eerst in de bewerkingsmodus zoals hierboven beschreven en gebruik de pijltjestoetsen.
Als alternatief kun je in de weergave Instellingenoverzicht "Horizontale verschuiving" gebruiken. Je hoeft dan niet over te
schakelen naar de bewerkingsmodus.
Opgemerkt dient te worden dat de stok in de bewerkingsmodus niet horizontaal verplaatst kan worden. U kunt wel de lengte
aanpassen. Om de horizontale positie aan te passen moet je de weergave Instellingenoverzicht gebruiken.

Zie ook

Tekst bewerken
Legatobogen
Haken
Lijn
Waardestrepen
Haarspelden

Paletten en werkruimtes

Een palet is een plaats die een groep gerelateerde muzieksymbolen bevat. Een collectie van paletten wordt een
werkruimte genoemd en deze bevindt zich standaard aan de linkerzijde van het scherm. Het kan worden losgekoppeld,
groter/kleiner worden gemaakt en worden versleept naar iedere gewenste locatie. Het kan ook aan de rechterzijde van het
scherm worden geplaatst waarbij de gehele lengte kan worden gebruikt of de halve lengte waarmee het de ruimte kan
delen met het Instellingenoverzicht.

MuseScore heeft twee vooraf ingestelde werkruimtes: Basis (de standaard met minder paletten en minder opties in ieder
palet) en Geavanceerd (zie → hieronder). Je kunt ook je eigen werkruimte maken.

Je kunt het palet weergeven/verbergen door te kiezen: Weergave → Paletten of je gebruikt de sneltoets F9 (Mac: fn+F9).

Paletten gebruiken

Klik op de titel van een palet om de inhoud zichtbaar te maken. De symbolen kunnen vanuit het palet worden toegevoegd
aan de partituur door:

Selecteer één of meerdere elementen in de partituur en dubbelklik op het symbool in het palet
Sleep het symbool vanuit het palet naar de gewenste positie in de notenbalk

Bijvoorbeeld: je kunt snel een tenuto (—) toevoegen aan een groep noten:

1. Selecteer een aantal noten (klik op de eerste; Shift+ klik op de laatste)
2. In de sectie “Articulaties & versieringen” dubbelklik je op het Tenuto symbool

Om andere muziek symbolen toe te voegen aan een palet, zie Eigen palet .

Werkruimtes

Werkruimtes zijn een set van paletten.

MuseScore bevat twee vooraf ingestelde werkruimtes - Geavanceerd en Basis (de laatste is een uitgeklede versie van
de eerst genoemde met minder paletten en minder symbolen). Kies een van beide met de keuze-lijst aan de onderkant
van het scherm onder de paletten zelf.
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Eigen werkruimte

Je kunt een eigen  werkruimte maken door eerst de gewenste werkruimte te selecteren waarop je eigen werkruimte
moet worden gebaseerd en dan te klikken op + knop en de naam voor de nieuwe werkruimte in te voeren. Als basis voor
de nieuwe werkruimte wordt de werkruimte die was geladen bij het klikken op de +. Hierna kunt u de paletten en symbolen
in deze werkruimte zelf aanpassen.

In een eigen werkruimte kun je, door met rechts te klikken op de naam van een palet, het volgende doen:

Een nieuw leeg palet invoegen
De volgorde van de paletten bepalen
Een palet opslaan (*.mpal)
Een palet laden (*.mpal)
Een palet verwijderen
Palet-eigenschappen bekijken (hier kun je de "Laat 'Meer elementen...' zien" optie aanzetten)

Vooraf ingestelde paletten

De uitgebreide Geavanceerde werkruimte bevat de volgende paletten:

Siernoten
Muzieksleutels
Toonsoorten
Maatsoorten
Maatstrepen
Lijnen
Arpeggios en glissandos
Ademhalingen en pauzes
Haken
Articulaties en versieringen
Voortekens
Dynamische tekens
Vingerzetting
Nootkoppen
Tremolo
Herhalingen en sprongen
Tempo
Tekst
Afbrekingen en afstandshouders
Doedelzakverfraaiingen
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Waardestreep-eigenschappen
Kaders en maten
Fretborddiagrammen

Hoofdpalet

Symbolen die je niet kunt vinden in de paletten van de geavanceerde werkruimte, kunt u wellicht vinden in het Hoofdpalet
door op Z te drukken (op het toetsenbord) of door Shift+F9 te drukken.

Zie ook

Palet Aanpassen
Hoofdpalet

Instellingenoverzicht en object eigenschappen

Voor de meeste elementen zijn er geavanceerde opties beschikbaar die benaderd kunnen worden door er met rechts op
te klikken (ook wel bekend als secondaire klik) en er zijn ook eigenschappen die zichtbaar worden gemaakt in het
Instellingenoverzicht venster en die daar ook in gewijzigd kunnen worden.

Instellingenoverzicht

Het Instellingenoverzicht venster wordt standaard aan de rechterzijde van het scherm weergegeven. Om het
Instellingenoverzicht venster wel of niet weer te geven ga je naar het Weergave menu en plaats of verwijder je het vinkje bij
Instellingenoverzicht of gebruik je de snelkoppeling F8 (Mac: fn+F8).

Zodra een element geselecteerd is worden de eigenschappen zichtbaar in het Instellingenoverzicht venster en kunnen
deze worden aangepast. Zo goed als alle elementen op de pagina kunnen op deze manier worden geselecteerd en
bewerkt - noten, tekst, maatstrepen, articulaties, etc. Een groep van elementen kan worden geselecteerd en gelijktijdig
worden aangepast. Indien de geselecteerde objecten verschillende types zijn dan worden alleen de gemeenschappelijke
eigenschappen van deze objecten weergegeven die kunnen worden aangepast.

Categorieën

Er zijn verschillende optie beschikbaar in de diverse categorieën van het Instellingenoverzicht venster.

Element heeft de volgende mogelijkheden: Zichtbaar, Kleur en Horizontale/Verticale correctie instelling.

Zichtbaar is een algemeen gebruikte eigenschap die je instaat stelt om de meeste element te onzichtbaar te
maken. Indien Zichtbaar niet is aangevinkt, dan wordt het element in grijs weergegeven in MuseScore om aan te
geven dat deze onzichtbaar zijn en niet worden afgedrukt of worden weergegeven in een geëxporteerd PDF of
afbeelding. (Opmerking: met Weergave → Laat onzichtbare objecten zien , is het mogelijk om onzichtbare elementen volledig
onzichtbaar te maken, zowel op het scherm als bij het afdrukken.) Je kunt ook de zichtbaarheid van de
geselecteerde elementen wisselen (wisselen tussen zichtbaar en onzichtbaar) met de toetsenbord snelkoppeling V.

Kleur laat je de kleur kiezen voor het element. Het element blijft deze kleur behouden bij het afdrukken en
exporteren.

Horizontale correctie instelling en Verticale correctie instelling laten je de exacte plaats van een element
bewerken door het invoeren van exacte waarden voor de correctie vanaf de standaard positie in een X/Y
coördinaten vlak.

Andere categorieën worden alleen weergegeven in specifieke gevallen, zoals Maatstreep, dat alleen aanwezig is indien
een maatstreep is geselecteerd.
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Sommige elementen kunnen een relatie hebben met andere elementen. Een voorbeeld hiervan is een geselecteerde noot
die een punt en waardestreep heeft, zoals de geselecteerde E in deze afbeelding:

Diverse verschillende categorieën met opties gerelateerd aan de noot worden zichtbaar in het Instellingenoverzicht
venster, inclusief Akkoord, Noot en Segment. Merk op dat je ook toegang hebt tot andere opties voor gerelateerde
elementen onderaan in het venster, inclusief Stok en in dit voorbeeld Waardestreep en Punt.

Indien je een maat selecteert, dan laat het Instellingenoverzicht venster alleen die opties zien die algemeen zijn voor
iedere noot in die maat: Zichtbaar en Kleur. Om de eigenschappen van de maat zelf te bewerken klik je met rechts op
een leeg gedeelte van de maat en selecteer je "Maat-eigenschappen" zoals hieronder zichtbaar is.

Wanneer er verschillende elementen zijn geselecteerd en er zijn verschillende waarden voor een bepaalde eigenschap,
dan worden deze in het blauw weergegeven. Als je deze eigenschap aanpast, dan wordt dit aangepast voor alle
geselecteerde elementen.

Eigenschappen (benaderd via rechts klikken)

Maat-eigenschappen

Om de eigenschappen van een maat aan te passen klik je met rechts op een leeg gedeelte van de maat en kies je "Maat-
eigenschappen".
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Vanuit het maat-eigenschappen venster kun je naar de vorige of volgende verplaatsen via de knoppen onderaan het
venster: NOT FOUND: Previous:Next Buttons.png (merk op dat terwijl het venster wel wijzigt, de zichtbaar
geselecteerde maat in de partituur niet wijzigt. Let hier goed op). Voor meer details, zie Maat-eigenschappen.

Notenbalk-eigenschappen

Notenbalk-eigenschappen zijn ook toegankelijk door met rechts te klikken op een maat of door met rechts te klikken op de
naam van een instrument.
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Notenbalk-eigenschappen bevat zowel een Notenbalk-eigenschappen sectie als een Partij-eigenschappen sectie:

Notenbalk opties omvatten kleur, aantal lijnen, afstand tussen de lijnen, verberg opties, notenbalk schaal en zo verder.

Partij opties omvatten instrumentnaam, partijnaam (gebruikt bij het partijen maken), speel transpositie en toonhoogte
bereik.

Tekst-eigenschappen

Zie Tekst-eigenschappen.

Zie ook

Maatbewerkingen
Noteninvoer
Opmaak en lay-out
Notenbalk-eigenschappen
Partijen maken
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Maatbewerkingen

Toevoegen

Om een lege maat achteraan de partituur toe te voegen druk je op Ctrl+B (Mac: ⌘+B)
of kies: Voeg toe → Maten → Voeg één maat toe.
Om meerdere lege maten achteraan de partituur toe te voegen druk je op Alt+Shift+B (Mac: Option+Shift+B) of kies: Voeg toe →

Maten → Voeg maten toe....

Invoegen

Om een lege maat in te voegen in de partituur selecteer je een maat en druk: Ins of kies Voeg toe → Maten → Voeg één maat in.
Om meerdere lege maten in te voegen druk je op Ctrl+Ins of kies: Voeg toe → Maten → Voeg maten in....

Verwijderen

Selecteer een maat en druk op Ctrl+Del (Mac: Fn+⌘+Del).

Eigenschappen

Om de maat-eigenschappen te wijzigen: rechtsklik op een lege plek in de maat en kies: Maat-eigenschappen...:

Notenbalken

Met de eigenschap "Zichtbaar" kun je schakelen tussen "zichtbaar" en "verborgen". Dit heeft betrekking op de noten
en de notenbalklijnen van de huidige maat.
Met de eigenschap "Zonder Stok" kun je schakelen tussen "met" en "zonder" stok. Met andere woorden: van de
noten die normaal een stok hebben zijn alleen de notenkoppen zichtbaar.

Maatduur

De nominale duur van de maat is gelijk aan de maatsoort, weergegeven op de partituur.
Je kunt de werkelijke duur van een maat aanpassen, ongeacht de maatsoort.
Normaal is de weergegeven duur en de werkelijke duur identiek
Toch kan een maat (bijvoorbeeld opmaat, anacrouse) een effectieve duur hebben die korter is of langer is als de
maten zijn samengevoegd (zie verder).
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In de onderstaande figuur heeft de opmaat een nominale duur van 4/4 maar een werkelijke duur van 1/4. Voor de
middelste maten zijn nominale duur en werkelijke duur gelijk (4/4). De complementaire maat achteraan heeft een
nominale duur van 4/4 maar een werkelijke duur van 3/4:

Overige

Sluit uit van matentelling 
Gebruik deze optie voor onregelmatige maten die niet mee moeten geteld worden in de nummering. Bijvoorbeeld
een opmaat.
Voeg toe aan maatnummer 
Je kunt zowel positieve als negatieve waarden invullen.
Dit heeft uiteraard effect op de nummering van alle volgende maten.
Merk op dat (-1) overeenkomt met "Sluit uit van matentelling"

Opmaakuitrekking 
Je kunt de horizontale afstand tussen de elementen (noten, rusten,..) vergroten of verkleinen met deze optie. Dit
zorgt voor een meer nauwkeurige controle over de exacte afstanden dan de menu-opdrachten of de sneltoetsen
voor Uitrekking vergroten/verminderen ({ en }), die bereikbaar zijn buiten het dialoogvenster.
Aantal herhalingen 
Als de maat de laatste maat is van een herhaling, kunt u het aantal herhalingen opgeven.
Onderbreek meermaatsrust 
Deze eigenschap onderbreekt een meermaatsrust aan het begin van de geselecteerde maat. Deze optie moet
worden ingesteld voordat je kiest voor de optie Maak meermaatsrusten in het menu Stijl → Algemeen..., in de tab Partituur.

Meermaatsrusten worden automatisch afgebroken op belangrijke plaatsen, zoals herhalingstekens, maatsoort
veranderingen, dubbele maatstrepen, onregelmatige maten, enz.
De standaard voor partituren is uit, voor partijen is aan.

Nummering

MuseScore nummert automatisch de eerste maat van elk systeem (behalve maat nummer 1), maar aanpassingen zijn
mogelijk.

Kies: Stijl → Algemeen...Koptekst, voettekst, nummers

Markeer het selectievakje "Maatnummers" om de automatische nummering aan te zetten
Markeer “Laat eerste zien” als u wilt dat het eerste maat nummer ook zichtbaar is.
Markeer “Alle notenbalken” als je iedere notenbalk wilt nummeren. Anders wordt alleen de eerste notenbalk van elk
systeem genummerd.
Kies "Elk systeem" als je alle systemen wilt nummeren of "Interval".
In het laatste geval: specifieer de lengte van het interval.

Bijvoorbeeld:
1: alle maten worden genummerd
5: nummering om de vijf maten.

Splitsen en samenvoegen

Met deze nieuwe optie kun je maten splitsen en samenvoegen. Eventuele waardestrepen en de maateigenschappen
worden automatisch aangepast.

Samenvoegen

1. Selecteer de maten die je wilt samenvoegen
2. Kies: Bewerken → Maat → Voeg maten samen

Opmerking: Alle notenbalken van het systeem worden samengevoegd op dezelfde plaats.
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Splitsen

1. Selecteer een noot of een akkoord.
2. Kies: Bewerken → Maat → Splits maat

Opmerking: Alle notenbalken van het systeem worden gesplitst op dezelfde plaats.

Zie ook

Hoe maten verwijderen?
Hoe een maat over meerdere systemen spreiden?
Hoe een partituur maken zonder maatsoort en sleutel?

Stemmen

Met stemmen kunnen er meerdere noten in één notenbalk staan die op hetzelfde moment beginnen maar een
verschillende duur hebben. In andere muzieknotatie software worden stemmen ook wel "lagen" genoemd.

In een meerstemmige maat heeft stem 1 gewoonlijk de stokken naar boven (bovenstem) en stem 2 de stokken naar
beneden (onderstem).

Wanneer gebruik je stemmen

Indien de stokken in tegengestelde richting moeten staan in een akkoord op één notenbalk.
Indien noten met een verschillende duur in één notenbalk gelijktijdig moeten worden gespeeld.

Instructies

Start met het invoeren van de bovenstem (de noten met de stokken omhoog in het beeld hierboven). Tijdens het invoeren
kunnen sommige noten de stokken naar beneden hebben, deze worden automatisch omgedraaid zodra de tweede stem
wordt toegevoegd.

Als je een toetsenbord (computer of MIDI) om de noten in te voeren, dan gebruik je de ← toets om de cursor terug te
plaatsen aan het begin van de notenbalk (of maat). Als je gebruikt maakt van de muis om de noten in te voeren dan is dit
niet nodig.

Klik op de "Stem 2" knop  (aan de rechterzijde in de werkbalk).

Voer alle noten in voor de onderstem (de noten met de stokken naar beneden). Zodra je klaar bent dan ziet kan het er als
volgt uitzien:
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Merk op dat Noteninvoermodus aan moet staan om een andere stem te selecteren.

Verborgen ruimte rusten

Alleen de rusten van de stemmen 2, 3 en 4 kunnen worden verwijderd, die van de hoofd stem (1 - blauw) kunnen worden
verborgen.

Om een rust te verbergen selecteer je de rust en toets je de V of verwijder je het vinkje bij "Zichtbaar" bij de
Instellingenoverzicht, deze kan worden aangezet vanuit het Weergave menu of met de snelkoppeling F8 (Mac: fn+F8). Als
je Laat onzichtbare objecten zien in het Weergave menu aan hebt staan, dan is de rust nog steeds in het grijs zichtbaar op het
scherm. De verborgen rust is niet zichtbaar bij het afdrukken of exporteren als PDF, PNG, SVG, etc.

Wissel de stem van noten

1. Selecteer het notenbereik
2. Bewerken → Stemmen

3. Wissel de gewenste stem

Let op: De selectie kan noten bevatten van meerdere stemmen, maar slechts twee worden er gelijktijdig aangepast.

Zie ook

Hoe voeg je twee notenbalken samen in één met twee stemmen
Hoe voer je meerdere noten in op een notenbalk met een verschillende duur
Hoe maak ik overlappende unisono noten

Externe links

Video zelfstudie: Hoe Schrijf je Twee Partijen in Eén Notenbalk: Stemmen

Kopiëren en plakken

Kopiëren en plakken is een nuttig hulpmiddel voor het herhalen van een deel van de muziek of voor het verschuiven van
een passage met één tel of één maat.
Alvorens te selecteren, te kopiëren en te plakken, druk op Esc om er zeker van te zijn dat je niet in de noteninvoermodus
bent.

Kopiëren

1. Klik op de eerste noot van de selectie.
2. Shift+Klik op de laatste noot van de selectie.

Een blauwe rechthoek benadrukt het gebied dat je hebt geselecteerd.
3. Kies Bewerken → Kopiëer of druk Ctrl+C (Mac: ⌘+C)

Plakken

1. Klik op de noot of de maat waar je de gekopieerde selectie wilt laten beginnen
2. Kies Bewerken → Plak of druk Ctrl+V (Mac: ⌘+V)

Snelle herhaling

1. Selecteer een noot of een maat of passage zoals beschreven (zie boven)
2. Druk R en MuseScore dupliceert het geselecteerde object.

Selectiefilter

Je kunt het filter gebruiken (alvorens te kopiëren) om exact te bepalen welke elementen moeten worden gekopieerd.

1. Zet de filter klaar door F6 (Mac: fn+F6) te drukken of kies in het menu Weergave → Selectiefilter

Deze verschijnt standaard onder de paletten, maar kan verplaatst en veranderd worden.
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Sleep je het selectiefilter in het venster van de Paletten of in het venster Instellingenoverzicht, dan neemt deze het
volledige deelvenster in beslag. Onderaan kun je schakelen naar het oorspronkelijke venster.

 of 

2. De-selecteer de elementen die u NIET wilt kopiëren, bijvoorbeeld Articulaties en Legatobogen.

3. Kopieer en plak zoals gebruikelijk.
(In dit voorbeeld zijn de maten 4 en 5 op deze manier gekopieerd en geplakt in maat 12 (en 13))

4. Je ziet dat de Legatoboog niet is gekopieerd.
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Zie ook

Als je noten wilt wijzigen zonder ritmewijziging dan kun je Transponeren en de Herbepaal toonhoogte-modus
combineren met kopiëren en plakken.

Externe links

Video zelfstudie: Liedteksten, kopiëren & dynamiek

Selectie modus

Er zijn meerdere manieren om een object te selecteren:

Selectie van een enkel object

Klik op het object

Selectie van meerdere aaneengesloten objecten tegelijk (een bereik)

1. Selecteer het eerste element van het bereik door erop te klikken
2. Hou de Shift-toets ingedrukt
3. Selecteer het laatste element van het bereik door erop te klikken

Alle geselecteerde elementen verschijnen in een blauwe rechthoek.

Opmerking 1: Sommige elementen kunnen als bereik geselecteerd worden: noten, rusten, articulaties, enz

Opmerking 2: Zie: Kopiëren en plakken: Selectiefilter om slechts enkele elementen uit een bereik te selecteren.

Selectie van meerdere niet-aaneengesloten objecten tegelijk

1. Selecteer het eerste element door erop te klikken
2. Hou de Ctrl-toets ingedrukt
3. Selecteer de andere elementen door erop te klikken

Opmerking 1 (hierboven) geldt hier ook.

Selecteer alle soortgelijke elementen

1. Selecteer een element
2. Rechtsklik → Selecteer >

3. Meerdere opties zijn mogelijk
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Alle soortgelijke elementen (in de hele partituur)
Alle soortgelijke elementen in dezelfde notenbalk
Alle soortgelijke elementen in bereikselectie, alleen als er een →bereik geselecteerd is
Meer......

Onder "Meer…" vindt u het volgende:

Bijvoorbeeld: Selecteer een Mol (Voorteken)
Je kunt volgende opties aanklikken en combineren:

Zelfde subtype (in dit voorbeeld: alleen mollen, geen kruisen of hersteltekens)
Zelfde notenbalk
Zelfde stem
Zelfde systeem
In selectie (optioneel)

U kunt volgende acties aanklikken (niet combineerbaar)

Vervang selectie
Voeg toe aan selectie
Zoek in selectie
Haal uit de selectie (optioneel)

Waarvoor kan dit gebruikt worden?

Kopiëren en plakken
Bewerkingsmodus om meerdere objecten tegelijk te verplaatsen
Instellingenoverzicht en object eigenschappen

Zie ook
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Hoofdstuk: Basisfuncties, Sectie: Noteninvoer
Hoofdstuk: Notaties, Sectie: Voortekens
Hoofdstuk: Tekst, Sectie: Tekst wijzigen en Raster-gebaseerd verplaatsing van symbolen en notenbalktekst

Weergave Modi

De bladmuziek kan in verschillende modi worden getoond:

De hierna volgende opties (behalve Pagina/Doorlopende weergave) bevinden zich in het menu “Weergave”

Pagina/Doorlopende weergave

In de mode "Pagina weergave" zie je de opmaak, zoals die is ingesteld voor de printer, voor afbeeldingsbestanden of voor
PDF-documenten.
In de mode "Doorlopende weergave" wordt de partituur weergegeven als een ononderbroken geheel.

Opmerking: Als je schakelt tussen beide weergaven wordt de partituur opnieuw opgemaakt. Het kan gebeuren dat je
enkele handmatige aanpassingen moet doen.

Hier kun je schakelen:

Pagina weergave

In de weergave "Pagina weergave" wordt de partituur weergegeven als een of meer pagina's van een bepaalde grootte en
met marges.
Je kunt alle lijnen en pagina-einden zien, zowel de handmatig toegevoegde als de door de software automatisch
berekende.
(Handmatige pagina-einden kunnen bijvoorbeeld nuttig zijn om een goede pagina verdeling te krijgen in orkestrale delen)

Doorlopende weergave

In de weergave " Doorlopende weergave" wordt de partituur getoond als een ononderbroken systeem.
Als het beginpunt van de partituur niet zichtbaar is worden vervangende tekens weergegeven voor maatnummers,
instrumentnamen, muzieksleutels, maatsoort en toonsoort (in een blauwe band, links).

Alvorens een pagina af te drukken of voordat je een partituur online opslaat, schakel naar de weergave "Pagina
weergave" om regelafbrekingen en pagina-einden te controleren.

Opmerking: Omdat de opmaak van de weergave "Doorlopende weergave" eenvoudiger is, zal MuseScore sneller werken
dan in de weergave "Pagina weergave".

Schaal

Zowel in de weergave "Pagina weergave" als in de weergave "Doorlopende weergave" kun je hiermee de schaal instellen.
Dit heeft geen invloed op het formaat van de afdruk.
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In de keuzelijst kun je een bepaald percentage selecteren of kiezen uit:
* Paginabreedte
* Hele pagina
* Twee pagina’s
Deze zijn gerelateerd aan de breedte van het venster.

Je kunt ook gebruik maken van de opties Bekijk dichterbij en Bekijk verderaf in het "Weergave" menu.

Tenslotte, hou de Ctrl (Mac: Cmd)-toets ingedrukt en scroll omhoog of omlaag om dichterbij of verderaf te bekijken.

Meerdere partituren weergeven

Als je meerdere partituren geopend hebt, kunt je deze naast elkaar
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of boven elkaar weergeven.
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Je kunt de scheidingslijn verplaatsen door deze te verslepen.

Schermvullend

In deze modus wordt het scherm volledig gevuld, zodat er meer inhoud zichtbaar is.

Navigator

Als je een lange partituur hebt en je wilt zien waar je je bevindt of als je wilt springen naar een bepaalde pagina, gebruik
dan de Navigator, onderaan de partituur.
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Het blauwe venstert vertegenwoordigt het gebied van de partituur dat zichtbaar is in het hoofdvenster.
Je kunt dit gebied verschuiven:
• Met de schuifbalk (of scrollwiel van de muis)
• Door te slepen
• Door het blauwe venster in de Navigator te verslepen
• Door op de plaats van bestemming te klikken in de Navigator

Om de Navigator In- of uit te schakelen, ga naar het menu Weergave en kies Navigator of gebruik de sneltoets F12 (Mac:
fn+F12).

Zie ook

Sla op/Exporteer/Druk af
Bestandsindeling
Opmaak en Lay-out

Maak ongedaan... en Doe opnieuw...

MuseScore onthoudt een onbegrensd aantal acties

De standaard sneltoetsen zijn:

Maak ongedaan:Ctrl+Z (Mac: ⌘+Z)
Doe opnieuw:Ctrl+Shift+Z of Ctrl+Y (Mac: ⌘+Shift+Z)
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Of gebruik de knoppen in de werkbalk:

Sla op/Exporteer/Druk af

De functies "Sla op", "Sla op als…", "Sla een kopie op..." en "Sla selectie op…" genereren MuseScore-eigen
bestandstypes (.mscz en .mscx) . (zie verder)
De functies "Exporteer…" en "Partijen exporteren..." genereren NIET MuseScore-eigen bestandstypes (MusicXML, MIDI,
meerdere beeld- en audioformaten). (zie verder)
Met "Druk af..." wordt afgedrukt vanuit MuseScore.

Menu Bestand

Beschikbaar zijn: 'Sla op', 'Sla op als…', 'Sla een kopie op...', 'Sla selectie op…' en 'Sla online op...'; 'Exporteer...',
'Partijen exporteren' en 'Druk af...'

Bestandsformaten in: 'Sla op', 'Sla op als…', 'Sla een kopie op...', 'Sla selectie op…' en 'Sla online op...'

Bestandsformaten in: 'Exporteer', 'Partijen exporteren'
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Merk op dat het Ongecomprimeerd MuseScore-bestand (*.mscx) beschikbaar is in beide lijsten.

Druk af

Afhankelijk van de printer krijg je toegang tot verschillende afdruk-opties.
Meestal zijn de volgende opties beschikbaar:
Afdrukbereik:

• Alles
• De selectie
• De huidige pagina
• Pagina’s van tot…
Aantal exemplaren:

• Aantal
• Gesorteerd of niet

Zie ook

Bestandsformaat
Partijen beheer

Partituren online delen

Ga naar musescore.com/sheetmusic  om meer partituren van MuseScore te bekijken.

Je kunt de partituren online opslaan en delen op de website MuseScore.com .
Je kunt de partituur "privé" opslaan voor persoonlijke toegang vanuit iedere computer of publiekelijk delen.
MuseScore.com maakt het bekijken en afspelen mogelijk van partituren in de web browser.
Een extra functie getiteld VideoScores maakt synchronisatie mogelijk tussen de partituren en een YouTube-video.
Voor gebruik buiten de webbrowser, kunt je de partituren downloaden in diverse formaten (zoals PDF, MIDI, MP3,
MusicXML, en het originele MuseScore bestand).

Een account aanmaken

1. Ga naar MuseScore.com  en klik op "Maak account aan ". Kies een gebruikersnaam, voer een geldig e-
mailadres, voer een wachtwoord in en druk op "Create New Account".
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2. Wacht even tot je een email ontvangt van MuseScore.com ondersteuning. Krijg je geen email, controleer dan de
"Spam" map.

3. Klik op de link in de email en bezoek je gebruikers profiel .

Deel een partituur direct vanuit MuseScore

Je kunt een partituur direct online opslaan middels Bestand → Sla online op....

Opmerking: Indien je nog geen MuseScore gebruiker hebt, dan kun je deze eerste aanmaken door te klikken op de Maak
account aan link. Dit opent je browser en laad de pagina https://musescore.com/user/register .

Voer nu je email adres of MuseScore gebruikersnaam en wachtwoord in. Na het succesvol aanmelden kun je de
informatie over de partituur invoeren.
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1. De titel is de titel van de partituur.
2. De beschrijving komt er naast te staan.
3. In je "Maak deze partituur privé" kiest dan is deze alleen zichtbaar voor jezelf en voor diegene aan wie je zelf de

"verborgen link" geeft. Plaats je hier geen vinkje dan is je partituur zichtbaar voor iedereen.
4. Kies een licentie opte. Door gebruik te maken vaan een Creative Comons licentie , sta je anderen toe je partituren

onder bepaalde voorwaarden te gebruiken.
5. Je kunt labels toevoegen om de partituur te kenmerken op MuseScore.com - deze worden gescheiden door een

komma.

6. Indien je de partituur al eerder online hebt opgeslagen, dan wordt deze automatisch vervangen. Verwijder het vinkje
Bestaande partituur bijwerken om de partituur als een nieuwe partituur op te slaan.

Upload een partituur op MuseScore.com

Je kunt een partituur ook direct op MuseScore.com opslaan.

1. Klik op de Upload link  op MuseScore.com.
2. Je hebt dezelfde mogelijkheden als in het 'Sla online op' menu.
3. Je hebt ook toegang tot meer informatie, zoals het Genre.

Opmerking: Indien je de upload limiet van vijf partituren bereikt, dan kun je nog steeds uploaden Deel een partituur direct
vanuit MuseScore maar alleen de laatste vijf zijn zichtbaar. Als je meer wilt opslaan, upgrade dan eerst naar een Pro
Account .

Bewerk een partituur op MuseScore.com

Als je een aanpassing wilt doen in één van je partituren op MuseScore.com of het MuseScore bestand wilt bewerken op
je computer, volg dan deze stappen:

1. Ga naar de partituur pagina op MuseScore.com.
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2. Klik op de bewerk link.
3. In dit formulier kun je het bestand, de informatie en privileges aanpassen.

Zie ook

Hoe verwijder ik een partituur van MuseScore.com

Werkelijke toonhoogte

Met de knop Werkelijke toonhoogte kun je schakelen tussen:

---> Noten verschijnen op de notenbalk zoals ze werkelijk klinken.
---> Noten verschijnen zoals transponerende instrumenten ze nodig hebben.

Dit kan de voortekens en/of de sleutel wijzigen.

Opmerking: Als je transponerende instrumenten in de partituur hebt opgenomen, zorg er dan voor dat je de "Werkelijke
toonhoogte"-mode verlaat voor het af drukken anders kunnen de muzikanten de juiste sleutel niet spelen.

Zie ook

Transponeren: Transponerende instrumenten
Voortekens: Herbepaal toonhoogte

Notaties

In het hoofdstuk "Basisfuncties" leerde je noten in te voeren en te werken met de paletten.
Het hoofdstuk "Notaties" beschrijft de verschillende types van notatie in detail, inclusief meer gevorderde toepassingen.

Zie ook "Geavanceerde onderwerpen"

Maatsoorten

Maatsoorten zijn beschikbaar in het palet maatsoorten. Je kunt ze hiervandaan slepen en op de partituur zetten (zie
Paletten voor meer informatie over hoe te werken met paletten in MuseScore).

Voeg een maatsoort toe aan een partituur

Om een maatsoort toe te voegen gebruik je één van de volgende methodes:

Sleep een maatsoort vanuit het palet naar de plaats in de maat
Selecteer een maat en dubbelklik op een maatsoort in het palet
Selecteer een noot of rust en dubbelklik een maatsoort in het palet

De maatsoort zal hierbij een het begin van de maat worden geplaatst.

Om een maatsoort te vervangen gebruik je één van de volgende methodes:

Sleep een maatsoort naar een bestaande maatsoort
Selecteer een maatsoort in de partituur en dubbelklik op een maatsoort in het palet

Verwijder een maatsoort

Om een maatsoort te verwijderen in de partituur selecteer je deze en druk je op Del.

Maak je eigen maatsoort
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Als er een maatsoort nodig is die niet in het werkruimte palet voorkomt, dan kan deze worden aangemaakt in de
Maatsoort sectie van het Hoofdpalet: Druk op (Shift+T) om deze te openen.

Om een nieuwe maatsoort te maken selecteer je een bestaande in het hoofdpalet en verander je de verschillende
parameters (teller, noemer, waardestrepen) in het Maak maatsoort aan  paneel. Om de nieuw aangemaakt maatsoort aan de
lijst toe te voegen druk je op de Voeg toe knop. Zodra deze is toegevoegd kun je het slepen naar de gewenste locatie in de
partituur. Om een maatsoort te verwijderen uit het hoofdpalet, klik je er met rechts op en kies je ""Wis".

U kunt een maatsoort vanuit het hoofdpalet toevoegen aan een eigen werkruimte door het naar het Palet in de werkruimte
te slepen.

Standaard waardestrepen wijzigen

Om een aanpassing te maken aan hoe de waardestrepen de noten verbinden in een deel of de gehele partituur klik je met
rechts op de relevante maatsoort (in de partituur) en kies "Maatsoort-eigenschappen":
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Hier kun je onafhankelijk de waardestreep patronen voor 1/8, 1/16 en 1/32 noten in het "Nootgroepen" paneel aanpassen.

Om een waardestreep te onderbreken, klik je op de noot die na de onderbreking komt. Om de waardestreep te herstellen
klik je op dezelfde plaats. Opmerking: deze methode werkt alleen indien alle secundaire (of sub) waardestrepen aanwezig
zijn op de gewenste locatie - indien dit niet het geval is gebruik dan de iconen (zie hieronder). De Herstel knop maakt alle
wijzigingen ongedaan die in de sessie zijn gedaan.

Je kunt ook wijzigingen maken in het waardestreep patroon door een van de iconen  (linksonder in het
venster) naar een noot te slepen in het "Nootgroepen" paneel:

 Start waardestreep bij deze noot.

 Laat de waardestreep doorlopen bij deze noot.

 1/8ste noot waardestreep aan de linkerkant van deze noot.

 1/16de noot waardestreep aan de linkerkant van deze noot.

Samengestelde maatsoorten

In de meeste gevallen hoeft alleen het eerste van het bovenste nummer te worden aangepast. De overige bovenste
nummers zijn voor samengestelde maatsoorten , deze bevatten verschillende nummers bovenaan gescheiden door een
plus teken.
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Afwijkende duur van de maatsoort: Opmaten en Cadenza

Er zijn situatie waarbij de werkelijke duur van een maat anders is dan die gespecificeerd door de maatsoort. Opmaten en
Cadenza zijn daar een goed voorbeeld van. Om de werkelijk duur van een maat te wijzigen zonder de maatsoort te
veranderen, zie Maatbewerkingen: Eigenschappen, Maatduur.

Lokale maatsoorten

De maatsoort kan verschillend zijn voor verschillende notenbalken. Hier een voorbeeld uit Bach's 26. Goldberg Variation:
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MuseScore gebruikt het concept van een algemene (globale) maatsoort en een werkelijk (lokale) maatsoort. Sleep een
object uit het palet en plaats het op een notenbalk om de algemene maatsoort te wijzigen. De algemene maatsoort wordt
gebruikt om te tellen (zoals te zien is in de status lijn) en is de referentie voor tempo markeringen. De algemene
maatsoort is gelijk voor alle notenbalken en is normaal gesproken gelijk aan de werkelijke maatsoort.

De werkelijke maatsoort kan worden ingesteld in het maatsoort-eigenschappen dialoog en kan afwijken van de algemene
maatsoort in iedere notenbalk (linkerhand 18/16 in het voorbeeld).

De tekst voor de maatsoort kan onafhankelijk van de werkelijke waarde worden ingesteld.

Een lokale maatsoort kan worden ingesteld door de maatsoort te plaatsen terwijl de Ctrl toets ingedrukt wordt gehouden.
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De lokale maatsoort is slechts voor één notenbalk geldig. De algemene maatsoort wordt overgenomen in alle
notenbalken.

Maatsoort wijzigen en andere objecten

Meermaatsrusten worden onderbroken wanneer een wijziging in de maatsoort plaatsvindt.
Een sectie-einde voorkomt dat een extra maatsoort symbool wordt getoond aan het einde van de maat.

Zie ook

Toonsoorten

Maatstrepen

Het type maatstreep aanpassen

Maatstrepen kunnen worden toegevoegd door een maatstreep-symbool uit het palet "Maatstrepen" te slepen naar een
(reeds aanwezige) maatstreep op de notenbalk.

Om een maatstreep volledig te verbergen: selecteer deze en druk V of verwijder het vinkje Zichtbaar in het venster
“Instellingenoverzicht” (F8 (Mac: fn+F8)).

Maak Omspannen/Gepaarde notenbalken

Om de maatstrepen te verlengen over meerdere notenbalken: dubbelklik op een maatstreep (zie Bewerkingsmodus).

Sleep vervolgens de handgreep naar de volgende notenbalk.

De partituur wordt in zijn geheel bijgewerkt nadat je de Bewerkingsmodus hebt verlaten (klik ergens op de achtergrond).

Zie ook

Maatbewerkingen

Muzieksleutels

Muzieksleutels kunnen worden toegevoegd of gewijzigd door een muzieksleutel-symbool uit het palet Muzieksleutels te
slepen naar een maat of bovenop een andere sleutel.

Gebruik F9 (Mac: ⌥+⌘+K) om het venster paletten te tonen of te verbergen.

Opmerking: Sommige muzieksleutels zijn alleen beschikbaar vanuit het hoofdpalet.
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Toevoegen

Sleep een muzieksleutel uit het palet naar een leeg gedeelte van een maat. Dit creëert een muzieksleutel aan het begin
van de maat.
Sleep een muzieksleutel bovenop een bepaalde noot om een muzieksleutel te creëren ergens in het midden van een
maat. Als dat niet de eerste sleutel van de notenbalk is wordt deze kleiner weergegeven.

Als voorbeeld een piano-partituur:
De bovenste notenbalk begint met een sol-sleutel maar schakelt onmiddellijk over naar een fa-sleutel. Na één noot en één
rust herneemt de sol-sleutel.

Opmerkingen:

Als een muzieksleutel bovenop een noot (in het bijzonder op de eerste noot) wordt gesleept, heeft dat geen invloed
op de eigenschap "muziekhulpsleutel".
Om te bepalen of de wijziging betrekking heeft op een noot of op de maat: controleer de kleurverandering terwijl je
sleept.
Je kunt ook vooraf een noot of een maat selecteren en dan dubbelklikken op een sleutel-symbool in het palet.

Verwijderen

Selecteer een sleutel en druk op Del.

Opmerkingen:

Het veranderen van een sleutel zal de toonhoogte van de noten niet veranderen. In plaats daarvan worden de noten
verplaatst om de toonhoogte te behouden.
Speciale/weinig gebruikte sleutels worden niet weergegeven in het standaard palet. Deze zijn te vinden in het eerder
genoemde Hoofdpalet .

Toonsoorten

Toonsoorten zijn beschikbaar in het Toonsoorten palet in de Basis en Geavanceerde werkruimte. Je kunt een eigen
toonsoort maken met het Toonsoorten hoofdpalet (druk op Shift+K om deze op te roepen), hierin kun je gebruik maken
van een breed scala aan niet-standaard symbolen.
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Een nieuwe toonsoort toevoegen

Een nieuwe toonsoort toevoegen aan alle notenbalken

Sleep een toonsoort vanuit het palet naar een leeg van de maat, of
Selecteer een maat en dubbelklik op de toonsoort in het palet, of
Selecteer een noot en dubbelklik op de toonsoort in het palet.

Een nieuwe toonsoort toevoegen aan één notenbalk

Indien je de toonsoort alleen voor één notenbalk wilt aanpassen en de andere niet wilt veranderen:

Hou de Ctrl (Mac: ⌘) toets ingedrukt bij het slepen van de toonsoort vanuit het palet naar de maat.

Een bestaande toonsoort vervangen

Vervang de toonsoort voor alle notenbalken

Sleep de toonsoort vanuit het palet naar de toonsoort die vervangen moet worden (of naar de maat die de toonsoort
bevat), of
Selecteer de toonsoort die vervangen moet worden en dubbelklik op de nieuwe toonsoort in het palet.

Vervang de toonsoort voor één notenbalk

Indien je de toonsoort alleen in één notenbalk wilt vervangen en de andere niet wilt veranderen:

Hou de Ctrl (Mac: ⌘) toets ingedrukt bij het slepen van de toonsoort vanuit het palet naar de te vervangen toonsoort
(of maat die de toonsoort bevat).

Een toonsoort verwijderen

Klik op een bestaande toonsoort en druk op Del, of
Sleep het lege toonsoort symbool vanuit het palet (in de geavanceerde werkruimte) naar de maat.

Herinneringsvoortekens

Standaard laat MuseScore alleen herstellingstekens zien bij het wijzigen naar een toonsoort zonder voortekens (C Maj/A
min). In alle andere gevallen laat het alleen de nieuwe toonsoort zien:

In de weergave “Instellingenoverzicht” (F8) kun je de optie "Laat herinneringstoonsoort zien" vinden waarmee je bepaalt of
de herinneringsvoortekens getoond worden of niet.
Deze optie geldt alleen voor het geselecteerde voorteken.
Wilt u de herinneringsvoortekens voor hele partituur tonen (of juist niet) ga dan naar:
Stijl → Algemeen... → Pagina

Pas de optie "Maak toonsoort herinneringen aan" aan

Herstellingstekens bij wijziging van de voortekens
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Je kunt kiezen of je de herstellingstekens wilt tonen bij het wijziging van de voortekens.
Kies: Stijl → Algemeen ... → Voortekens en je ziet volgende opties:

Je kunt kiezen tussen OKen Toepassen.
Indien van toepassing kun je ook kiezen voor Pas toe op alle partijen.

De optie 'Vóór de toonsoort bij wijziging naar minder kruisen of mollen' heeft het volgende resultaat:

De derde optie 'Ná de toonsoort bij wijziging naar minder kruisen of mollen. Ervóór bij wisseling tussen kruisen en mollen'
heeft het volgende resultaat:

Toonsoorten en meermaatsrusten

Meermaatsrusten worden onderbroken bij het wijzigen van de toonaard.

Zie Meermaatsrusten

Herinneringsvoortekens en Sectie-einden

Een herinneringsvoorteken wordt niet geplaatst voor een Sectie-einde.
Zie: Afbrekingen en afstandhouders: Sectie-einde

Toonsoorten aanpassen

Druk Shift+K of Shift+F9 of kies: Weergave → Hoofdpalet... → Toonsoorten om het Hoofdpalet te tonen.
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Je kunt gebruik maken van al deze voortekens (bijvoorbeeld Mol met pijl omhoog)
Je kunt zelfs halve kruisen en halve mollen gebruiken.
De zelf ontworpen toonsoort verschijnt niet in de standaard paletten. Deze moet je dus slepen vanuit het Hoofdpalet.

Opmerking: de geluidsweergave van een aangepaste toonsoort wordt niet ondersteund.

Ademhalingen en pauzes

Ademhalingen kunnen worden toegevoegd door een ademhaling-symbool uit het palet "Ademhalingen" te slepen naar
een noot. Het teken wordt achter de noot geplaatst.
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Ademhalingen in de partituur:

Cesuren werken op dezelfde manier.

Antimetrische figuren

Antimetrische figuren worden gebruikt om een afwijkend ritme van de gangbare onderverdeling in de huidige maatsoort te
maken. Als voorbeeld, een achtste triool in een 4-4 maatsoort verdeelt de kwartnoot in drie tellen in plaats van twee.

Instructies

Om een triool te maken begin je met het selecteren van een noot in de partituur die de gehele waarde van de triool heeft.
Als voorbeeld, een triool van achtste noten heeft de "gehele duur" van één kwartnoot.

Vanuit het hoofd menu, kies Noten → Antimetrische figuren → Triool. Dit maakt een triool door de gehele noot te verdelen in drie
gelijke delen.

Deze kunnen nu verder worden aangepast.

Noteninvoermodus

Het invoeren van een antimetrisch figuur in noteninvoermodus gaat iets anders dan de methode zoals hierboven is
uitgelegd. Je selecteert eerst de lengte en voert daarna de toonhoogte in. Hieronder staat de stap-voor-stap instructie om
een triool van achtste noten te maken.

1. Activeer de noteninvoermodus door het intoetsen van N
2. Zorg dat de invoer cursor op de plaats staat waar je het antimetrische figuur wilt beginnen (gebruik eventueel het

pijltje naar rechts en links om dit aan te passen)
3. Kies de duur van gehele triool in de noot invoer werkbalk. In dit voorbeeld, klik op de kwartnoot (of type 5 op het

toetsenbord)
4. In het hoofd menu, kies Noten → Antimetrische figuren → Triool, of type Ctrl+3 (Mac: ⌘+3)
5. Merk op dat de waarde van de achtste noot automatisch wordt geselecteerd. Klik op de notenbalk om de noten toe

te voegen of voer ze in via de computer of het MIDI toetsenbord.

Eigenschappen

Om de weergave eigenschappen van een antimetrisch figuur aan te passen selecteer je het nummer van het
antimetrische figuur of de haak en gebruik je het Instellingenoverzicht (F8).
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Als zowel het nummer als de haak niet zichtbaar zijn, selecteer dan een noot in het antimetrisch figuur en gebruik de
Antimetrisch figuur knop onderaan het Instellingenoverzicht om het bovenstaande dialoog te krijgen.

Voor de 'Richting', kies 'Auto' om de haak aan dezelfde kant van de noot te plaatsen als de stok of waardestreep. Kies
'Omhoog' of 'Omlaag' om expliciet aan te geven of de haak boven of onder de noot moet komen te staan onafhankelijk
van de positie van de stok of waardestreep.

Voor het 'Nummersoort', kies 'Getal' om een getal weer te geven, 'Verhouding' om de ratio aan te geven of 'Niets' om
geen nummer weer te geven.

Voor de 'Haaktype', kies 'Automatisch' om de haak te verbergen bij noten met een waardestreep en om de haak weer te
geven als het antimetrische figuur losse noten of rusten bevat. Kies 'Haak' of 'Niets' om expliciet aan te geven om de haak
weer te geven of niet.

Als je de haak of het nummer verplaatst, dan kun je zien dat de verticale en horizontale vaste afstand worden bijgewerkt
(standaard afstand is 0sp voor beide)
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Je kunt de standaard instellingen terug zetten met de pijl terug knop aan de rechterkant.

Stijl

Ga naar Stijl → Algemeen... en selecteer Antimetrische figuren. Hiermee kunnen de eigenschappen van de antimetrische figuren
worden aangepast.
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Er zijn twee aanpassingen mogelijk: Verticaal en Horizontaal

Verticale aanpassing heeft drie opties met waarden in (notenbalk) spaties en één wel/niet gekozen optie
Maximale hellingshoek: standaard waarde is 0,50; bereik is van 0,10 tot 1,00
Verticale afstand vanaf stok (zie (2) hieronder): standaard waarde is 0,25; bereik is van -5,00 tot 5,00
Verticale afstand vanaf de nootkop (zie (3) hieronder): standaard waarde is 0,50; bereik is van -5,00 tot 5,00
Ontwijk de notenbalken: standaard waarde is geselecteerd

Horizontale aanpassing heeft vier opties met waarden in (notenbalk) spaties
Afstand voor de stok van de eerste noot (zie (5) hieronder): standaard waarde is 0,50; bereik is van -5,00 tot
5,00
Afstand voor de kop van de eerste noot: standaard waarde is 0,00; bereik is van -5,00 tot 5,00
Afstand achter de stok van de laatste noot (zie (6) hieronder): standaard waarde is 0,50; bereik is van -5,00 tot
5,00
Afstand achter de kop van de laatste noot: standaard waarde is 0,00; bereik is van -5,00 tot 5,00
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Zie ook

Hoe maak ik een triool en andere antimetrische figuren

Externe links

Antimetrisch figuur  bij Wikipedia
Hoe maak ik Antimetrisch figuren in MuseScore  [video]
De handleiding voor Antimetrische figuren in MuseScore  [video]

Arpeggios en glissandos

Arpeggios kunnen worden toegevoegd door een arpeggio-symbool uit het palet "Arpeggios en Glissandos" te slepen
naar een noot of een akkoord in de partituur.

Om de lengte van de arpeggio aan te passen: dubbelklik op de arpeggio en sleep de grepen omhoog of omlaag.

Glissandos kunnen worden toegevoegd door een glissando-symbool uit het palet " Arpeggios en Glissandos" te slepen
naar de eerste van twee opeenvolgende noten op dezelfde notenbalk.

Om de tekst (en nog een paar eigenschappen) van de glissando aan te passen: open het deelvenster
“Instellingenoverzicht” (F8) of rechtsklik en kies "Glissando eigenschappen"

Als er niet genoeg plaats is tussen twee noten, plaatst MuseScore geen tekst.

Externe links

Arpeggio  op Wikipedia
Glissando op Wikipedia

Articulations and ornaments

A comprehensive set of symbols can be found in the Articulations and Ornaments palette in the Advanced workspace:
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There is also an abbreviated version in the Basic workspace.

Articulations

Articulations are the symbols added to the score to show how a note or chord is to be played. The principal symbols in
this group are:

Fermatas
Staccato
Mezzo-staccato / Portato
Staccatissimo
Tenuto
Sforzato
Marcato

Specialist articulations are also included for bowed and plucked strings, wind instruments etc.

Ornaments

Ornaments include:

Mordents, Inverted Mordents, Pralltrillers
Trills
Turns
Bends

Note: Appoggiaturas and acciaccaturas can be found in the Grace Notes palette.

Add articulation/ornament

Use either of the following methods:

Select a note or a range of notes, then double-click a symbol in a palette.
Drag a symbol from a palette onto a notehead.

Add accidental to an ornament

To apply an accidental to an existing ornament, such as a trill:

1. Select the note to which the ornament is attached;
2. Open the Symbols section of the Hoofdpalet;
3. Search for and apply the desired accidental to the score (small accidentals can be found using the search term

"figured bass");
4. Drag the accidental into position (or reposition using keyboard shortcuts or the Inspector).

Add fermata to a barline

A fermata can be applied directly to a barline by selecting the barline and double-clicking the fermata from a palette. This
does not affect playback though.

Keyboard shortcuts

Toggle Staccato: Shift+S
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Toggle Tenuto: Shift+N

Toggle Sforzato (accent): Shift+V

Toggle Marcato: Shift+O

Add Acciaccatura (grace note): /

Keyboard shortcuts can be customized in MuseScore's Preferences.

Adjust position

Immediately after adding an articulation or ornament from a palette, the symbol is automatically selected: It can then be
moved up or down from the keyboard as follows:

Press up/down arrow keys for fine positioning (0.1 sp at a time);
Press Ctrl+↑ or Ctrl+↓ (Mac: Cmd+↑ or Cmd+↓) for larger vertical adjustments (1 sp at a time).
To flip a symbol to the other side of the note (where applicable), select it and press X.

To enable adjustments in all directions from the keyboard:

1. Double click on the symbol to enter Edit mode, or click on it and press Ctrl+E (Mac: Cmd+E) , or right-click on the
symbol and select "Edit element";

2. Press arrow keys for fine positioning (0.1 sp at a time); or press Ctrl+Arrow (Mac: Cmd+Arrow) for larger adjustments (1
sp at a time).

You can also change the horizontal and vertical offset values in the Inspector. To position more than one symbol at a
time, select the desired symbols and adjust the offset values in the Inspector.

Note: The symbol can also be repositioned by clicking and dragging, but for more precise control, use the methods above.

Articulation properties

Most properties of articulations/ornaments can be edited from the Inspector. Other properties (i.e. direction and anchor
position) can also be accessed by right-clicking on the symbol and selecting Articulation Properties….

You can also make global adjustments to all existing and subsequently-applied articulations by selecting Style… →
General… → Articulations, Ornaments.

See also

Grace notes

External links

Ornaments  at Wikipedia

Bend/Toonbuiging

Toonbuigingen kunnen aangemaakt worden via het Bend/Toonbuigingssymbool , te vinden in het palet Articulaties
& versieringen in de Geavanceerde werkruimte.

Toonbuiging toevoegen

Om een of meerdere toonbuigingen aan je partituur toe te voegen kan je de volgende methodes gebruiken:

Selecteer een of meerdere noten en dubbelklik op het Bend/Toonbuigingssymbool in het palet.
Sleep een Bend/Toonbuigingssymbool vanuit het palet op een noot.

Toonbuiging bewerken

Om een toonbuiging te bewerken kan je:

rechtsklikken op het symbool in je partituur en in het menu kiezen voor "Bend/Toonbuigingseigenschappen".

een Toonbuiging selecteren in je partituur en vervolgens in het Instellingenoverzicht op de knop "Eigenschappen"
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klikken.

Aan de linkerzijde van het Bend/Toonbuigingseigenschappen__venster kan je een aantal voorgedefinieerde types
kiezen. Aan de rechterzijde zie je een grafische voorstelling van de huidige toonbuiging, bestaande uit een grijze
lijn vormgegeven door middel van vierkante blauwe __controlepunten (zie afbeelding hierboven). De helling van de
lijn geeft het verloop van de toonbuiging aan.

De verticale as van de grafiek geeft aan hoeveel de toonhoogte zal gebogen worden: 1 eenheid (lichtgrijze lijn) komt
overeen met een kwarttoon: 2 eenheden met een halve toon, 4 eenheiden met een volledige toon, enz… De horizontale
as is gerelateerd met de visuele lengte van de buiging: elk grijs lijnsegment (tussen twee blauwe controlepunten) maakt
de lijn op de partituur 1sp (notenbalkafstand) langer.

Je past de toonbuiging aan door controlepunten toe te voegen of te verwijderen op de grafiek:

Om een controlepunt toe te voegen klik je op een (lege) kruising van grafieklijnen.
Om een controlepunt te verwijderen klik je op het controlepunt.

Voor elk toegevoegd controlepunt wordt de toonbuigingslijn 1sp langer; elk verwijderd controlepunt maakt de lijn 1sp
korter. Het begin en eind controlepunt kunnen enkel op en neer verplaatsen.

Hoogte aanpassen

De hoogte van een toonbuigingssymbool is automatisch aangepast zodat deze net boven de notenbalk staat. Je kan de
hoogte verminderen, indien gewenst, met volgende methode:

1. Plaats een extra noot op de bovenste lijn van de notenbalk, verticaal net boven de noot waarop je de bend wenst te
starten.

2. Voeg een toonbuigingssymboool aan de hoge noot toe. Nu heb je een symbool met de minimale hoogte.
3. Om de hoogte van het symbool te vergroten verplaats je de noot omlaag.
4. Sleep het toonbuigingssymbool omlaag naar de gewenste positie.
5. Maak de hoogste noot onzichtbaar en onhoorbaar (dmv het Instellingenoverzicht).

Positie aanpassen

De positie van een toonbuiginssymbool kan op een van de volgende manieren aangepast worden:

Versleep het symbool met de muis.
Selecteer het symbool en pas de horizontale/verticale correctie instelling aan in het Instellingenoverzicht.
Dubbelklik op het symbool; of klik er eenmaal op en duw dan Ctrl+E (Mac: Cmd+E); of klik rechts op het symbool en
kies "Bewerk element". Gebruik vervolgens de pijltjestoetsen op je toetsenbord voor fijne aanpassingen (0,1sp per
keer); of Ctrl+pijltje (Mac: Cmd+pijltje) voor grotere aanpassingen (1sp per keer).

Aangepaste toonbuigingen

Eenmaal je een eigen aangepaste toonbuiging hebt aangemaakt, kan je die als symbool aan een palet toevoegen voor
toekomstig hergebruik door het naar het palet te slepen terwijl je Ctrl+Shift (Mac: Cmd+Shift) ingedrukt houdt.
Zie Eigen Werkruimte.

Haarspelden
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Haarspelden zijn Lijn-objecten .

Haarspelden toevoegen

Haarspelden kunnen worden toegevoegd door een haarspeld-symbool uit het palet "Lijnen" te slepen naar een notenkop.
Standaard wordt de lijn getrokken tot het einde van de maat en de haarspeld is niet geselecteerd.
Je kunt ook de sneltoetsen gebruiken:
< genereert een crescendo
> genereert een diminuendo
In dit geval wordt de lijn getrokken tot aan de eerstvolgende noot, maar de haarspeld is geselecteerd zodat je direct met
de aanpassing kunt beginnen (zie verder).

Of anders: selecteer een beginpunt (notenkop), hou de Shift-toets ingedrukt en klik op het eindpunt. Dubbelklik vervolgens
op het haarspeld-symbool uit het palet.

Haarspelden aanpassen

1. Dubbelklik op de haarspeld om deze in de Bewerkingsmodus te zetten.

2. Gebruik de handgrepen links en rechts om de lengte aan te passen.
Shift+→ of Shift+← verplaatsen de ankers, hetgeen het afspelen zal beïnvloeden. Bovendien is het met deze methode
mogelijk om de haarspeld uit te breiden over de regelafbrekingen heen.

3. Gebruik de handgreep op de schuine zijde om de hoek aan te passen

4. Gebruik de handgreep in het midden om de haarspeld te verplaatsen

5. → of ← en Ctrl+→ of Ctrl+← (Mac: Cmd+→ of Cmd+←) verplaatsen het geselecteerde punt zonder het anker te
verplaatsen.
Deze methode is enkel geschikt voor kleine visuele aanpassingen. Het herstelcommando: Ctrl+R (Mac: Cmd+R) zal
deze kleine aanpassingen ongedaan maken, maar het anker blijft ongewijzigd.

Om de haarspeld te verlengen of te verkorten, gebruik Shift+→ of Shift+← waarmee je tevens het anker verplaatst (zie
hierboven).

Haarspeld afspelen

Het afspelen van crescendo's en diminuendo's heeft alleen effect van één noot naar de volgende. Het is momenteel niet
mogelijk de dynamiek te wijzigen tijdens het verloop van één noot.
Haarspelden beïnvloeden het afspelen alleen als er Dynamische tekens worden gebruikt vóór en nà de haarspeld.
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Haken

Toevoegen

Haken kunnen worden toegevoegd door een haak-symbool uit het palet "Haken" te slepen naar een lege plaats in de
eerste maat van een systeem.

Wisselen

Je kunt het haak-type wijzigen door een nieuwe haak boven op een bestaande haak te slepen.

Aanpassen

Dubbelklik op de haak om deze in de bewerkingsmodus te zetten. Je kunt de haak nu spreiden over een willekeurig aantal
notenbalken van het systeem.

Horizontale verplaatsing

Als je een haak meer naar links of naar rechts wilt verplaatsen: Dubbelklik an op de haak om deze in de
Bewerkingsmodus te zetten en druk Shift+← of Shift+→.

Verwijderen

Om een haak te verwijderen selecteer je de haak en druk dan op Del

Legatoboog

Een Legatoboog is een gebogen lijn tussen twee of meer noten die aangeeft dat deze moeten gespeeld worden zonder
onderbreking. Als het de bedoeling is om twee noten van dezelfde toonhoogte te verbinden, zie: Overbindingen

Eerste Methode

1. Indien nodig, verlaat de Noteninvoermodus en selecteer de eerste noot:

2. S genereert een legatoboog:

3. Shift+→ verplaatst het einde van de boog naar de volgende noot:
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4. X wisselt de boogrichting:

5. Esc beëindigt de Bewerkingsmodus:

Tweede Methode

1. Indien nodig, verlaat de Noteninvoermodus en selecteer de eerste noot:
2. Hou de Ctrl-toets (⌘ on a Mac) of de Shift-toets ingedrukt en selecteer de laatste noot (met de muis)
3. Druk S

Derde Methode

1. Deze methode is van toepassing als je in de Noteninvoermodus bent. Voer de eerste noot in van de sectie waarover
een Legatoboog moet worden geplaatst.

2. Druk S om de sectie te beginnen.
3. Voer de laatste noot in van de sectie.
4. Druk nogmaals S om de sectie te beëindigen.

Aanpassingen

De handgrepen, zoals weergegeven in de stappen 2 t/m 4 van methode 1, kunnen aangepast worden met de muis. Met
de twee buitenste kun je het begin en het einde van de boog aanpassen. Met de twee binnenste kun je de omtrek van de
boog aanpassen

Een legatoboog kan meerdere systemen en pagina's overspannen. Het startpunt en het eindpunt zijn verankerd aan een
noot, een akkoord of een rust. Wanneer de noten worden herschikt door een verandering in opmaak, omvang of stijl, zal
de boog mee bewegen en het formaat past zich aan.

In dit voorbeeld wordt de legatoboog overspannen van de bas naar de G-sleutel.
Selecteer de eerste noot van de legatoboog (met de muis). Hou de Ctrl-toets ingedrukt (⌘ on a Mac) selecteer (met de
muis) de laatste noot van de boog en druk: S om een legatoboog toe te voegen.

Gestippelde lijn

Gestippelde legatobogen komen in de muziek voor waar het gebruik varieert tussen coupletten. Gestippelde bogen
worden soms ook gebruikt als suggestie van een arrangeur (in tegenstelling tot de markeringen van de componist). Om
een bestaande legatoboog in een gestippelde of gestreepte boog te veranderen moet je hem selecteren en dan bij de
instellingenoverzicht (F8) kan het 'Lijntype' worden gewijzigd van 'Doorgetrokken' in 'Gestippeld' of 'Gestreept'.

X wisselt de richting van de geselecteerde boog.

Zie ook

Overbinding
Bewerkingsmodus
Noteninvoer

Lijnen

80



Lijnen kunnen worden toegevoegd door een lijn-symbool uit het palet "Lijnen" te slepen naar de partituur of door eerst
een notenbereik te selecteren en daarna te dubbelklikken op het lijn-symbool.
Net zoals eerder hangt het aantal items dat getoond wordt af van de instellingen van de Nonexistant node nid: 39841.

Het Basis palet:

De volledige lijst, beschikbaar in de geavanceerde werkruimte:

Lengte aanpassen

Als je de lengte van een lijn wijzigt met de muis, zal de positie van het anker op de maat (of noot) niet veranderen.
Daarom wordt de volgende methode aanbevolen:

1. Als je je in de Noteninvoermodus bevindt, druk dan Esc om deze te verlaten.

2. Dubbelklik op de lijn die je wilt wijzigen om naar de Bewerkinsmodus te schakelen.

3. Verplaats de handgrepen met behulp van de volgende sneltoetsen:

Shift+→ om het anker naar rechts te verplaatsen (één noot of maat)
Shift+← om het anker naar links te verplaatsen (één noot of maat)

4. Als je de lengte op zich wilt aanpassen zonder daarbij de noten of de maten waaraan de lijn verankerd is te
wijzigen, sleep dan de handgrepen met de muis of gebruik:

→ om het anker naar rechts te verplaatsen (één eenheid)
← om het anker naar links te verplaatsen (één eenheid)

Zie ook
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Haarspelden
Volta (Prima en Seconda Volta)
Oude muziek functies (Ambitus)

Maatrusten

Helemaatsrust

Wanneer er in een hele maat geen noten staan, dan wordt een helemaatsrust gebruikt. Een helemaatsrust lijk op een
hele noot rust, maar is gecentreerd in het midden van de maat en in plaats van dat deze gelijk is aan vier kwart tellen
heeft deze de waarde van de hele maat lengte afhankelijk van de huidige maatsoort.

Om een helemaatsrust te maken selecteer je een maat en druk je op Del. Alle noten en rusten in deze maat worden
vervangen door een hele maat rust.

Meermaatsrust

Rusten over meerdere maten geven een lange lengte van stilte aan voor een instrument en worden vaak gebruikt in
ensemble bladmuziek. Ze worden automatisch onderbroken op belangrijke plaatsen, zoals een dubbele maatstreep,
repetitieteken, muzieksleutel of maatsoort wijzigingen, etc.

Het getal boven de meermaatsrust geeft aan hoe lang de rust duurt.

Instructie

1. Vanuit het menu, kies Stijl → Algemeen...

2. Kies de "Partituur: optie, indien deze nog niet is geselecteerd
3. Plaats een vinkje bij "Maak meermaatsrusten"

Als alternatief, druk op M op het toetsenbord om de meermaatsrust optie aan of uit te zetten.

Beperkingen

De stijl optie combineert automatisch de lege maten in meermaatsrusten in de gehele partituur. Het is daarom aanbevolen
om eerst alle noten in te voeren en dan de meermaatsrust optie aan te zetten.

Onderbreek meermaatsrust

Zie ook: Maat bewerkingen: Onderbreek meermaatsrust

Je wilt een meermaatsrust opsplitsen in twee meermaatsrusten.

De optie moet worden aangezet voordat de "Maak meermaatsrusten" optie in Stijl → Algemeen..., in de "Partituur" optie
wordt aangezet.
Selecteer de eerste maat waar de volgende meermaatsrust moet beginnen, klik met rechts en kies Maateigenschappen
→ Onderbreek meermaatsrust

Opmerking: Meermaatsrusten worden onderbroken door een repetitieteken (niet bij gewone tekst), sectie einde,
muzieksleutel of maatsoort wijziging, of dubbele maatstreep.

Octave lines

Octave (Ottava) lines are used to indicate that a section of music is to be played one or more octaves above or below
written pitch: The line may be dotted or solid. Ottavas are available in the Lines palette of the Basic and Advanced
workspaces.

8─────┐or 8va─────┐: Play one octave above written pitch
8─────┘or 8vb─────┘: Play one octave below written pitch
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8va/8vb lines are particularly common in piano scores, though they are sometimes used in other instrumental music.1

15ma (2 octaves above) and 15mb (2 octaves below) are also occasionally used.

Apply an octave line

Use one of the following:

Select a range of notes, then double click an octave line from a palette.
Select one or more measures, then double click an octave line from a palette.
Click on a note, then double-click an octave line from the palette (extends line from selected note to end of bar).
Drag an octave line from a palette onto a note (extends line from selected note to end of bar).

See also, Lines: Adjust vertical position.

Change length

See Lines: Change length.

Custom lines

Octaves can be customized just like any other line. See Lines: Custom lines and line properties.

External links

Octave  at Wikipedia

1. Gerou/Lusk. Essential Dictionary of Music Notation (Internet Archive ). ↩�

Overbinding

Een overbinding is een gebogen lijn tussen twee noten met dezelfde toonhoogte. Indien je een gebogen lijn wilt die over
meerdere tonen moet, zie dan Legatoboog.

Eerste methode

Selecteer de eerste noot:

+ maakt een overbinding:

(+ of de overbinding knop, , te vinden rechts bovenaan naast de noten in de noot invoer werkbalk)

Tweede methode
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Om overbinding te maken tijdens het noten invoeren, druk op de + of de overbinding knop , na de eerste noot van de
boog.

Overbinding omkeren

X wisselt de positie van een overbinding, van boven de noot naar onder de noot en visa versa.

Gebonden akkoorden

Om een overbinding toe te voegen tussen twee akkoorden, selecteer de stok van het eerste akkoord of Shift + klik op het

eerste akkoord en druk dan op + of de overbinding knop . Noteninvoermodus mag hierbij niet aanstaan.

Gebonden unisono noten

Indien akkoorden moeten worden gebonden die unisono noten bevatten dan is de beste manier:

1. Wijs iedere noot van het unisono paar toe aan een andere stem.
2. Zorg dat één van de noten is ingesteld op "zonder stok" (dit om de dubbele stok te verwijderen).
3. Voeg de overbinding stem voor stem toe. Pas de positie en lengte aan waar nodig.

Siernoten

Korte voorslagen (Acciaccatura) worden weergegeven als kleine nootjes met een streep door de stok. Lange
voorslagen (Appoggiatura) hebben geen streep door de stok. Beiden worden voor de noot (met normaal formaat)
geplaatst.

Instructies

Siernoten kunnen worden toegevoegd door een siernoot-symbool uit het palet Siernoten te slepen naar een noot (met
normaal formaat).
U kunt ook een notenkop selecteren en vervolgens dubbelklikken op het siernoot-symbool.
Om meerdere siernoten toe te voegen: sleep achtereenvolgend de siernoten naar de notenkop.
Om een akkoord van siernoten in te voegen: plaats de eerste siernoot; hou de Shift-toets
ingedrukt + type de letterbenaming van de noten (C, D, E etc...)

Om de duur van een siernoot te wijzigen: selecteer deze (door er op te klikken) en klik daarna op een van de symbolen op

de werkbalk:  of gebruik de sneltoetsen 1 t/m 9 (zie Noteninvoer).

Het kan zijn dat ja na een noot (zoals een triller) de siernoot handmatig moet bijstellen met Ctrl + pijltjes.

Externe links

Voorslag  op Wikipedia
Appoggiatura  op Wikipedia (engels)
Acciaccatura  op Wikipedia (engels)

Tremolo
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Tremolo is het snel herhalen van één noot of het snel wisselen tussen twee of meer noten. Het wordt aangegeven met
schuine strepen door de stokken van de noten. Als de tremolo tussen twee of meer noten is, dan worden de strepen
tussen hen geplaatst. Tremolo symbolen worden ook gebruikt voor het noteren van een roffel op de trom.

Het tremolo palet bevat aparte symbolen voor de tremolo's voor één noot (hieronder te zien met de stokken) en voor twee
of meer noten (hieronder te zien zonder de stokken).

Om een tremolo toe te voegen aan een enkele noot selecteer je de noot en dubbelklik daarna op het gewenste symbool
in het tremolo palet.

In een tremolo die bestaat uit twee noten heeft iedere noot de waarde van de hele tremolo. Om een tremolo met de duur
van een halve noot te maken, voor eerst twee normale kwart noten in en na het toevoegen van de tremolo aan de eerste
noot, wordt de noot waarde automatisch gewijzigd in halve noten.

Voortekens

Voortekens kunnen worden toegevoegd / gewijzigd door een voortekensymbool uit het Palet Voortekens te slepen naar
een noot in de partituur.

Als je alleen de toonhoogte van één noot wilt aanpassen: selecteer de noot en druk:

↑: Verhoogt de toonhoogte met een halve toon (voorkeur voor kruisen).
↓: Verlaagt de toonhoogte met een halve toon (voorkeur voor mollen).
Ctrl+↑ (Mac: Cmd+↑): Verhoogt de toonhoogte met een octaaf.
Ctrl+↓ (Mac: Cmd+↓): Verlaagt de toonhoogte met een octaaf.
J: Maakt van de noot een enharmonische noot (bv fa = mi #).

Om de bestaande voortekenens te veranderen in een waarschuwend voorteken (tussen haakjes) sleep je de haakjes van
het Palet Voortekens naar het bestaande voorteken (niet de notenkop). Om de haakjes verwijderen selecteer je het
voorteken en drukt je op Del.

Als je later de toonhoogte van de noot met de cursortoetsen wijzigt, worden de handmatige instellingen aan de voortekens
verwijderd.

Herbepaal toonhoogtes

De menufunctie Noten → Herbepaal toonhoogtes probeert de juiste voortekens te raden voor de hele partituur.

Zie ook

Toonsoort: Wijzigen

Externe links

Alteratie  op Wikipedia

Waardestrepen

Waardestrepen worden automatisch geplaatst, maar kunnen handmatig worden aangepast.
Waardestrepen kunnen worden toegevoegd door een waardestreep-symbool uit het palet "Waardestreep-eigenschappen"
te slepen naar een noot.
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Je kunt ook eerst de noot selecteren en daarna dubbelklikken op het gewenste waardestreep-symbool.

 start de waardestreep bij deze noot.

 beëindig de waardestreep niet bij deze noot.

 geef deze noot geen waardestreep.

 start een tweede waardestreep bij deze noot.

 start een derde waardestreep bij deze noot.

 (terug naar) automatisch (= de standaard): MuseScore bepaalt de waardestreepeigenschap aan de hand van
de maatsoort.

 start een gevederde waardestreep (trager) bij deze noot.

 start een gevederde waardestreep (sneller) bij deze noot.

Om de hoek van de waardestreep te bepalen of om de afstand van de waardestreep naar de noot (dat wil zeggen de
lengte van de stok) te wijzigen, dubbelklik je op de waardestreep om het in de Bewerkingsmodus te komen. De rechter
handgreep is geselecteerd.

Pijl omhoog/omlaag zal nu de hoek aanpassen.
Door het selecteren van de linker handgreep en het gebruik van de op/neer pijltjestoetsen zal de stok verlengen/
verkorten.
Als je klaar bent: druk Esc om de bewerkingsmodus te verlaten.

Om een waardestreep boven of onder de noten te plaatsen kun je deze knop gebruiken in de tweede werkbalk:  of
gebruik de sneltoets “X”.

Zie ook

Waardestreep over de notenbalk
Bewerkingsmodus
Noteninvoer
Hoe plaats ik een waardestreep over een rust
Hoe plaats ik een waardestreep tussen twee noten

Herhalingen

Het begin en einde van eenvoudige herhalingen kan worden ingesteld door gebruik te maken van de juiste maatstrepen.
Voor instructies voor eerste en tweede einden maten, zie Volta

Afspelen

Zorg dat de optie "Laat herhalingen horen"  aanstaat om ze te horen tijdens het afspelen. Je kunt dit uitschakelen
door de knop te de-selecteren.

In de laatste maat van een herhaling kun je middels eigenschappen "aantal herhalingen" instellen hoe vaak de herhaling
moet worden gespeeld.
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Herhalingssymbolen en -tekst

Tekst en symbolen met betrekking tot herhalingen kunnen worden gevonden in het 'Herhalingen & Sprongen' palet.
Het Herhalingen & sprongen palet bevat de symbolen voor maatherhaling, segno en coda. Het bevat ook 'D.S.', 'D.C.' en
Fine tekst:

Om een object toe te voegen uit het herhalingen palet, sleep het op (niet boven) de gewenste maat (zodat de maat van
kleur wijzigt) en laat het los. Het object komt dan boven deze maat in de partituur te staan.

Sprongen

Sprongen bestaan over het algemeen uit drie delen:

Spring naar label
Speel tot aan label
Verder gaan bij label

Labels zijn namen die worden toegewezen een maten. Twee labels ("start", "end") geven het begin en einde van de
partituur aan en hoeven niet expliciet te worden toegevoegd.

Voorbeelden:

Bij de sprong instructie Da Capo zal het bij het afspelen worden gesprongen naar het begin van de partituur en wordt
deze in zijn geheel herhaald (tot aan het impliciete end label).

Bij de sprong instructie Da Capo al Fine zal bij het afspelen worden gesprongen naar het begin van de partituur en wordt
deze afgespeeld tot aan het Fine/Einde label.

Dal Segno al Fine (of D.S. al Fine) springt naar het Segno label en speelt tot aan het Fine/Einde label.

Dal Segno al Coda springt naar het Segno label en speelt tot aan het eerste To Coda label. Het afspelen gaat dan verder
bij het eerstvolgende Coda label. De eigenschappen van de sprong kan worden ingesteld door met rechts te klikken op
het D.S. al Coda label.

Zie ook

Volta
Hoe separeer ik het coda van de rest van de partituur

Externe links

Video zelfstudie: Codas

Volta

Volta haken, of eerste en tweede einden haken, worden gebruikt om verschillende einden aan te geven voor een
herhaling.
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Om een volta haak in de partituur te plaatsen, sleep je deze vanuit het Lijnen palet en plaats hem op de gewenste plaats.

Om het symbool over meerdere maten te plaatsen moet deze naar de eerste maat worden gesleept zoals
hierboven, vervolgens dubbelklikken om in de bewerkingsmodus te komen en druk dan op Shift+→ om het einde één
of meerdere maten naar rechts te verplaatsen. Je kunt het einde ook een maat terug verplaatsen met Shift+←.

Deze commando's verplaatsen de "logische" start of eind van een volta haak, welke zorgt voor het correct afspelen in
MuseScore en helpt met de opmaak over meerdere systemen. Het verplaatsen van de handgrepen met de muis of
met de linkse en rechtse pijltjes toetsen zonder Shift stelt je instaat de positionering aan te passen maar verandert
niet hoe de herhaling wordt afgespeeld en kan zorgen voor afspeel of spreidingsproblemen.
Als je de handgrepen verplaatst, dan wordt er een gestreepte lijn zichtbaar in de partituur van de handgreep naar de
logische positie:

Tekst

Je kunt de tekst en andere eigenschappen van de volta haak aanpassing in het lijn-eigenschappen dialoog. Klik met
rechts op een volta haak en kies Lijn-eigenschappen.... Het figuur hieronder laat de volta tekst zien als "1.-5."

Je kunt ook met rechts klikken op de volta en het volta-eigenschappen dialoog weergeven. Van hieruit kun je zowel de
tekst (zoals hierboven in het lijn-eigenschappen dialoog) en de herhalingslijst aanpassen. Als je één volta wilt laten spelen
voor sommige herhalingen en een andere volta voor andere herhalingen, voer dan de herhalingen in gescheiden door een
komma. In het onderstaande voorbeeld wordt deze volta gespeeld bij herhaling 1, 2, 4, 5 en 7. Een andere volta bevat het
andere einde, zoals 3, 6 en mogelijk hogere nummers zoals 8, 9, etc.
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Afspelen

Soms moet een herhaling meer dan twee keer worden afgespeeld. In het bovenstaande figuur geeft de volta aan dat het
vijf keer gespeeld moet worden voordat het verder gaat. Als je het aantal keer dat MuseScore een herhaling afspeelt wilt
veranderen, ga dan naar de maat waarin de herhalingsmaatstreep staat en wijzig het 'aantal herhalingen' (zie
Maatbewerkingen: Overige eigenschappen)

Externe links

Video zelfstudie: MuseScore in Minuten: Les 8 - Herhalingen en Einden, deel 1

Transponeren

Met transponeren verhoog of verlaag je een selectie van noten in de notenbalk. MuseScore ondersteund verschillende
vormen van transponeren.

(Zie onder voor details)

Chromatisch transponeren - op toonsoort

Chromatisch transponeren verplaatst noten naar boven of beneden in stappen van een halve toon. Vanuit het hoofd
menu, kies Noten → Transponeer, selecteer de toonsoort om te transponeren - dichtstbijzijnde, omhoog of omlaag.
Standaard wordt hierbij ook de toonsoort veranderd. Indien je dit niet wilt, kun je dit ook uitzetten door "transponeer
toonsoorten" uit te zetten.
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Chromatisch transponeren - op interval

Chromatisch transponeren verplaatst noten naar boven of beneden in stappen van een halve toon. Vanuit het hoofd
menu, kies Noten → Transponeer, selecteer "Op Interval" en kies de gewenste interval uit de lijst en of je omhoog of omlaag
wilt transponeren.
Standaard wordt hierbij ook de toonsoort veranderd. Indien je dit niet wilt, kun je dit ook uitzetten door "transponeer
toonsoorten" uit te zetten.
Je kunt een selectie van noten ook transponeren met de pijltjes toetsen(↑ of ↓), hierbij blijft de toonsoort gelijk.

Diatonisch transponeren

Diatonisch transponeren verplaatst de noten naar boven of naar beneden in de huidige toonladder en toonsoort. Je kunt
een enkele noot verplaatsen door deze naar boven of beneden te slepen. Je kunt een selectie van noten verplaatsen met
Ctrl + klik en slepen.

Transponerende instrumenten

Sommige instrumenten, zoals een Bes trompet of alt sax, zijn transponerende instrumenten. Deze instrumenten klinken
lager of hoger dan de geschreven toonhoogte. MuseScore heeft een ingebouwde optie voor transponerende
instrumenten.

De Werkelijke toonhoogte knop en Noten → Werkelijke toonhoogte uit het hoofd menu laat je wisselen tussen de werkelijke
toonhoogte en de transponerende toonhoogte. Werkelijke toonhoogte helpt componisten en arrangeurs bij het schrijven
van muziek omdat ieder instrument in dezelfde toonsoort staat en de noten in de notenbalk klinken zoals ze in
werkelijkheid zijn. Wanneer werkelijke toonhoogte is uitgeschakeld, dan klinken de noten van sommige instrumenten niet
hetzelfde als de noot geschreven in de notenbalk maar zijn ze geschikt om op het instrument gespeeld te worden. Denk
er aan dat, indien je werkelijke toonhoogte gebruikt, je dit uitgeschakeld voordat je de partijen afdrukt.

Instrument transpositie is reeds ingesteld in MuseScore. Echter, als je een zeldzaam instrument of een transpositie nodig
hebt die niet in MuseScore zit, moet je mogelijk de instrument transpositie handmatig aanpassen. Klik met rechts op een
leeg gedeelte van de notenbalk van het instrument en kies Notenbalk-eigenschappen.... Onderaan in het Notenbalk-
eigenschappen scherm kun je de interval van de transpositie, octaaf verschuivingen en of de interval "Omhoog" (klinkt
hoger dan geschreven) of "Omlaag" (klinkt lager dan geschreven) is.

Zie ook

Hoe kan ik transponeren

Drumnotatie

Drumnotatie en percussie-notatie omvat gestemde en ongestemde notaties.
Als u niet vertrouwd bent met het aanpassen van meerdere stemmen in een notenbalk, zie: Stemmen voor een overzicht.

Het is raadzaam eerst ervaring op te doen met Noten invoer alvorens u aan percussie-notatie begint.

MIDI toetsenbord

De eenvoudigste manier om drumnotatie toe te voegen aan uw notenbalk is via het MIDI toetsenbord. Sommige MIDI
toetsenborden hebben slagwerk markeringen boven/onder elke toets. Als u op de toets voor HiHat drukt, zal MuseScore
de juiste notatie aan de partituur toevoegen. MuseScore zorgt automatisch voor de stokrichting en het type van notenkop.

Computer toetsenbord

Om noten in te voeren op een percussie notenbalk met het computer toetsenbord klik je eerst op de notenbalk en druk je
dan op N om de noteninvoermodus te activeren. Standaard zijn er zeven drum geluiden gekoppeld aan de toetsenbord
snelkoppelingen (A-G), net zoals bij de reguliere noot invoer. Je kunt deze zeven snelkoppeling aan andere drum geluiden
toewijzen via de Bewerk drumset knop in het drum invoer palet (zie →hieronder).
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Als je een nieuwe drum noot wilt invoeren/toevoegen op dezelfde positie van een bestaande noot—bijvoorbeeld als je de
snare en hi-hat geluiden gelijktijdig wilt laten horen—dan moet je bij het invoeren van de nieuwe noot via het computer
toetsenbord de Shift toets indrukken zodat je de bestaande noot niet overschrijft. Dit is dezelfde methode als die wordt
gebruikt voor het invoeren van akkoord voor gestemde instrumenten in MuseScore (zie Noteninvoer).

Muis

Noot invoer voor ongestemd percussie werkt anders dan voor andere instrumenten, hier zijn de speciale stappen:

1. Selecteer een noot of rust in de percussie notenbalk
2. Druk op N om de noteninvoermodus te activeren

Merk op dat het drum invoer palet alleen verschijnt indien je de vorige stappen hebt uitgevoerd:

3. Selecteer een noot lengte in de noot invoer werkbalk aan de bovenkant van het scherm, net zoals bij reguliere
noteninvoer

4. Selecteer het type noot (bv basdrum of snaar) in het drum invoer palet
5. Klik op de percussie notenbalk om de noot toe te voegen aan de partituur

Drumset

Het is mogelijk dat je de geluiden wilt aanpassen die gekoppeld zijn aan de toonhoogte in de notenbalk. Dit kun je doen
door, terwijl je in noteninvoermodus bent van een percussie notenbalk, te klikken op de Bewerk drumset knop aan de
linkerkant. Je kunt ook de toetsenbord snelkoppeling voor specifieke noten aanpassen die je mogelijk gebruikt in de
partituur.

Drumsets worden opgeslagen als .drm bestanden.

Roffel

Om een roffel te maken gebruik je de Tremolo.

Externe links

Video zelfstudie: MuseScore in Minuten: Les 7 - Tablatuur en Drum Notatie
Drum Partijen  [video]
Wijzig het Drum Palet in MuseScore 1.1  [video]
Opslaan van Drumset aanpassingen in MuseScore 1.1  [video]
Gids voor Drum en Percussie notatie

91

https://www.youtube.com/watch?v=wnXLaZW9uA8
http://www.youtube.com/watch?v=KFj7v5S4Akw
http://www.youtube.com/watch?v=PvVBHW-O5Ww
http://www.youtube.com/watch?v=RgsxPLJxZRM
http://web.mit.edu/merolish/Public/drums.pdf


Tablatuur

Muziek voor snaarinstrumenten met fretten wordt vaak genoteerd in tablatuur (Tab) notatie. Hierbij worden een visuele
representatie weergegeven van de snaren en fret nummers die moeten worden gebruikt bij het spelen.

Tablatuur kan ook worden gecombineerd met de gewone notatie:

Wanneer een tablatuur notenbalk wordt aangemaakt dan wordt deze ingesteld op de meest gebruikelijke stemming voor
het instrument dat gekozen is - als voorbeeld, bij een gitaar is de standaard stemming E2, A2, D3, G3, B3, E4. Om de
stemming van een instrument (of andere tablatuur eigenschappen) aan te passen gebruik je het Notenbalk-
eigenschappen dialoog (zie Wijzig instrument snaargegevens).

Een tablatuur notenbalk maken

Met de 'Nieuwe Partituur' wizard

Kies Bestand → Nieuw of gebruik de sneltoets Ctrl + N (Mac: Cmd+N) om de Nieuwe partituur wizard te openen. In de Kies
instrumenten stap, selecteer een (of meerdere) van de tablatuur opties uit de getokkelde snaarinstrumenten lijst in de
linker kolom en kies Voeg toe.

Indien het gewenste instrument niet voorkomt in de "Algemene instrumenten" lijst dan kan het zijn dat deze zich bevindt in
de "Alle instrumenten" lijst - gebruik het selectie optie boven de instrumenten lijst om de categorie van instrumenten die
worden weergegeven te wijzigen. Als alternatief kun je ook de zoek optie gebruiken die onderaan de instrumenten lijst
staat.

Als de gewenste instrument/tablatuur combinatie niet beschikbaar is in de lijst dan kun je het volgende doen:

1. Selecteer een bestaande "getokkelde snaarinstrument" met tablatuur optie.
2. Druk op Voeg toe om deze aan de partituur toe te voegen.
3. Selecteer, indien beschikbaar, de gewenste tablatuur notenbalk type aan de rechterkant in de toegevoegde

instrumenten lijst.
4. Vervolg de Nieuwe partituur wizard en sluit deze.
5. Indien nodig kan het aantal snaren en de stemming van de tablatuur worden aangepast in het Notenbalk-

eigenschappen venster (zie Wijzig instrument snaargegevens).
6. Wijzig, indien gewenst, de notenbalk naam en het instrument in Notenbalk-eigenschappen (zie Wijzig instrument).

Hiermee kun je een tablatuur maken voor ieder chromatisch instrument met fretten.

Opmerking: Voor het maken van een gecombineerde notenbalk/tablatuur, zie Combineer een standaard notenbalk met
een tablatuur notenbalk.

Door het wijzigen van het type notenbalk

Het is ook mogelijk om een standaard type notenbalk om te zetten naar een tablatuur variant en visa versa:

1. Klik met rechts op een lege plaats in een maat van de notenbalk die je wilt veranderen om het context menu weer te
geven

2. Selecteer Notenbalk-eigenschappen... (als deze opties niet wordt getoond dan was de plaats waarop geklikt werd
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waarschijnlijk niet leeg en wordt het context menu van een ander object weergegeven)
3. Indien de notenbalk reeds is ingesteld voor een getokkeld snaarinstrument, ga dan verder met stap 6
4. Indien het instrument zich niet in de "getokkelde snaarinstrumenten" categorie bevindt druk dan op Verander instrument

en kies een geschikt instrument uit de "getokkelde snaarinstrumenten" categorie die de tablatuur optie heeft
5. Klik op OK om het "Notenbalk-eigenschappen" dialoog te sluiten en open het opnieuw
6. Klik op de Geavanceerde stijl-eigenschappen... knop
7. In het Bewerk notenbalktype dialoog, kies voor één van de Tablatuur sjablonen in de Sjaboon lijst en druk op de <

Herstel naar sjabloon knop
8. Pas, indien nodig, het aantal snaren aan bij de "Lijnen" optie bovenaan in het venster
9. Druk op de OK knop om het Bewerk notenbalktype dialoog te sluiten

10. Druk op de Wijzig snaargegevens... knop om het aantal snaren en de stemming te wijzigen (zie Wijzig instrument
snaargegevens).

11. Druk op de OK knop om het Bewerk notenbalk-/partij-eigenschappen dialoog te sluiten

De geselecteerde notenbalk wordt nu omgezet in een tablatuur notenbalk. Selecteer "Standaard" in stap 7 om een
tablatuur notenbalk om te zetten in een standaard notenbalk.

Hiermee is het mogelijk om de partij in een standaard notenbalk in te voeren en dan om te zetten in een tablatuur en visa
versa.

Wijzig instrument snaargegevens (stemming)

Tablatuur 'noten' (of fret markeringen) refereren niet naar toonhoogten maar naar snaren en fret posities. Het is
noodzakelijk dat je tablatuur 'weet' welke snaarstemming je gebruikt anders zijn de toonhoogten die gemaakt worden van
de fret markeringen (bijvoorbeeld in gekoppelde notenbalken bij het afspelen of bij het maken van audio bestanden) niet
juist.

De getokkelde snaarinstrument die beschikbaar zijn in de instrumtenlijst (druk op I om deze te zien) zijn ingesteld op de
'standaard' snaarstemming gegevens. Je kunt de stemming bekijken door met rechts te klikken op een notenbalk in de
partituur en te kiezen voor Notenbalk-eigenschappen en vervolgens te drukken op de Wijzig snaargegevens... knop.

In sommige gevallen is het nodig om deze informatie aan te passen - als voorbeeld wanneer je werkt met een niet-
standaard stemming (scordatura). En indien een specifiek instrument niet in de instrumentenlijst beschikbaar is en er een
gelijksoortig instrument is gekozen bij het maken van de partituur.

Het is belangrijk om de stemming van de notenbalk te controleren voor het invoeren van de noten.

Om de snaar stemming te zien / wijzigingen:

Het volgende is alleen van toepassing voor getokkelde snaarinstrumenten notenbalk (standaard of tablatuur):

1. Klik met rechts op een lege plaats in een maat van de notenbalk die je wilt veranderen om het context menu weer te
geven

2. Selecteer Notenbalk-eigenschappen...
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3. Druk op de Wijzig snaargegevens... knop onderaan het dialoog venster (deze knop is alleen beschikbaar indien het
instrument is ingesteld als een snaar instrument). Het "Snaargegevens" dialoog wordt geopend, controleer de
huidige snaar informatie en maak aanpassingen waar nodig met de Nieuwe snaar..., Bewerk snaar..., Verwijder snaar

knoppen

Opmerking: De selectie vakjes in de Open kolom worden gebruikt om individuele snaren altijd als open (zonder
fret), zoals bij de luit, te markeren.

Als de stemming wordt aangepast wanneer de tablatuur voor het instrument reeds een aantal noten bevat, dan
worden de fret markeringen, waar mogelijk, aangepast zodat dezelfde noten met de nieuwe stemming worden
gehoord.

Het aantal frets (zowel fysieke frets als 'virtuele' posities) bepaald het hoogste fret nummer dan een snaar kan
krijgen.

Iedere wijziging die je aanbrengt in de snaarstemming is alleen van toepassing voor dat instrument en voor die
partituur en zal de standaard/ingebouwde instellingen niet veranderen.

4. Controleer of het "Aantal frets" juist is en pas deze aan indien niet juist

5. Druk op OK om het "Snaargegevens" dialoog venster te sluiten
6. Bij het gebruik van een tablatuur notenbalk, druk op Geavanceerde stijl-eigenschappen en controleer of het aantal "Lijnen"

overeenkomt met het aantal snaren en pas dit, indien nodig, aan. Klik op OK om het dialoog te sluiten
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7. Druk op OK om het "Notenbalk-/Partij-eigenschappen" dialoog venster te sluiten

Met het dialoog venster dat wordt geopend met de Bewerk snaar... functie kun je een nieuwe noot toe kennen aan de
snaar.

Tablatuur instellingen

De standaard eigenschappen van een tablatuur zijn geschikt voor een gitaar in de standaard stemming (E2, A2, D3, G3,
B3, E4). Voor andere instrumenten en/of genres kan het nodig zijn deze eigenschappen aan te passen.

De instellingen van een tablatuur, net zoals voor de overige type van notenbalken, kunnen worden gewijzigd in de
Notenbalk-eigenschappen dialoog.

Combineer een standaard notenbalk met een tablatuur notenbalk

Voor sommige instrumenten is het gebruikelijk om zowel de standaard notenbalk als een tablatuur (TAB) notenbalk te
gebruiken. De standaard notenbalk laat de conventionele notatie zien terwijl de tablatuur notenbalk de snaar en fret
nummers laat zien.

Er zijn twee manieren om dit te doen:

Maak een gekoppeld standaard/TAB notenbalk paar
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In MuseScore is het mogelijk om notenbalken te "koppelen" zodat wijzigingen in de één ook worden toegepast in de
gekoppelde. Indien de standaard notenbalk is gekoppeld aan een tablatuur dan kunnen beide gebruikt worden om de
noten in te voeren.

1. Open de instrument bewerker (menu Bewerken → Instrumenten... of de I toets)
2. Selecteer de notenbalk waar je aan wilt koppelen
3. Druk op de Voeg gekoppelde notenbalk toe knop om een nieuwe notenbalk, gekoppeld aan de geselecteerde, toe te

voegen
4. Selecteer het gewenste Notenbalktype aan de rechtse kant in het venster
5. Druk op OK

Zodra de nieuwe gekoppelde notenbalk is gemaakt kun je de eigenschappen (bv. wijzig in tablatuur) en/of andere
eigenschappen wijzigen zoals hierboven beschreven.

Als akkoorden worden ingevoerd in de normale notenbalk (of worden gekopieerd vanuit een andere notenbalk met Ctrl+C /
Ctrl+V), dan probeert MuseScore in de tablatuur de noten zo goed mogelijk te verdelen over de snaren en daarbij
conflicterende frets (meerdere noten op dezelfde snaar) te voorkomen. Als dat niet mogelijk is dan worden conflicterende
noten in de tablatuur met een rode achtergrond weergegeven en moeten deze met de hand worden aangepast (zie
hieronder Noten Bewerken).

Maak een niet-gekoppeld standaard/TAB notenbalk paar

Indien je een standaard notenbalk wilt gebruiken zonder dat de noten automatisch worden overgenomen, doe dan het
volgende:

1. Open de instrument bewerker (menu Bewerken → Instrumenten... of de I toets)
2. Selecteer de notenbalk waar je aan wilt koppelen
3. Druk op de Voeg notenbalk toe knop om een nieuwe notenbalk toe te voegen
4. Druk op OK

Een andere optie is om een niet-gekoppelde tablatuur notenbalk toe te voegen als een apart instrument:

1. Open de instrument bewerker (menu Bewerken → Instrumenten... of de I toets)
2. Selecteer het instrument met tablatuur optie in de linker kolom
3. Druk op de Voeg toe knop om het instrument toe te voegen
4. Druk op OK

Je kunt nu noten invoeren in beide notenbalk zonder dat deze invloed hebben op elkaar. Je kunt hierbij ook gebruik
maken van de kopieer en plak optie om de muziek van de ene notenbalk in de andere over te nemen.

Invoeren nieuwe noten

Toetsenbord:

Schakel over naar noteninvoermodus (N); een kleine 'blauwe rechthoek' verschijnt om één tablatuur snaar. Dit is de
huidige snaar
Selecteer de noot/rust lengte (zie hieronder)
Druk op de ↑ of ↓ om de gewenste snaar te selecteren
Druk op 0 tot en met 9 om een fret markering van 0 tot en met 9 in te voeren voor de huidige snaar. Om cijfers van
meerdere getallen in te voeren type je iedere getal in volgorde in (het programma weigert hierbij altijd een cijfer in te
voeren dat hoger is dan het maximum aantal frets dat is ingesteld voor het instrument). De toetsen A tot en met L
(waarbij I wordt overgeslagen) kunnen ook worden gebruikt, wat handig is bij het werken met een Franse tablatuur
Het is ook mogelijk om het fret cijfer aan te passen met Shift+↑ of Shift+↓

Muis:

Activeer de noteninvoermodus en kies de gewenste lengte (zie hieronder)
Klik op een snaar om een noot in te voeren
Noten worden initieel gemaakt met fret 0 (of a bij Franse tablatuur); druk meerdere keren op Shift+↑ totdat de juiste
fret is bereikt

MuseScore weigert om een tweede noot in te voeren op een snaar die al een noot bevat, om deze reden is het meestal
beter om bij het schrijven van akkoorden te beginnen bij de hoogste snaar en dan verder te gaan met de lagere.

Selecteer de nootwaarde/lengte die moet worden ingevoerd
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Indien je in e TAB invoer mode bent, dan worden de standaard snelkoppelingen voor het invoeren van de nootwaarden (0
tot en met 9) gebruikt voor het invoeren van de fret cijfers. Om de waarde te selecteren voor de volgende in te voeren noot
kunnen de volgende vier methoden worden gebruikt:

Shift+1 tot en met Shift+9 (beschikbaarheid van deze snelkoppelingen is afhankelijk van het platform en/of toetsenbord
lay-out)
NumPad 1 tot en met Numpad 9 (indien er een numeriek toetsenbord is en NumLock aan staat)
de invoer werkbalk aan de bovenkant van het scherm
Q om de gekozen waarde te verlagen en W om deze te verhogen

Noten bewerken

Zolang je NIET in de invoermodus bent, zijn er drie toets combinaties mogelijk om een fret markering te wijzigen:

Shift+↑ / ↓ wijzigt de toonhoogte. MuseScore selecteert de snaar en de fret, de hoogst mogelijk snaar wordt hierbij
geselecteerd.
↑ / ↓ verandert de fret naar boven/beneden zonder te snaar te wijzigen (in het bereik van 0 tot en met het aantal frets
ingesteld in het "Snaargegevens " dialoog).
Ctrl+↑ / ↓ verplaatst de geselecteerde noot naar de hogere/lagere snaar (indien de snaar vrij is en hij die noot kan
maken).
Shift+X zet de ghost nootkop aan of uit.

Overzicht van toetsen

Noteninvoermodus

Type: Je krijgt:

↑
Selecteer de hogere snaar als de
huidige.

↓ Selecteer de lagere snaar als de huidige.

Shift+1 tot en met Shift+9 Selecteer de lengte

NumPad 1 tot en met NumPad 9 Selecteer de lengte

Q Verlaag de huidige invoer lengte.

W Verhoog de huidige invoer lengte.

0 tot en met 9 Voer een fret cijfer / letter in.

A tot en met K Voer een fret cijfer / letter in (exclusief I).

Shift+↑ Verhoog de huidige fret markering.

Shift+↓ Verlaag de huidige fret markering.

Normale mode

Type: Je krijgt:

Shift+↑
Verhoog de toon van de gekozen noot (MuseScore kiest hierbij de
snaar).

↑ Verhoog de toon zonder de snaar te veranderen.

Shift+↓ Verlaag de toon van de gekozen noot (MuseScore kiest hierbij de snaar).

↓ Verlaag de toon zonder de snaar te veranderen.

Ctrl+↑ Verplaatst de noot naar de bovenliggende snaar, toonhoogte blijft gelijk.

Ctrl+↓ Verplaatst de noot naar de onderliggende snaar, toonhoogte blijft gelijk.

Shift+X Zet de ghost nootkop aan of uit.

Externe links

Video zelfstudie: MuseScore in Minuten: Les 7 - Tablatuur en Drumnotatie

Geluid en afspelen

MuseScore heeft ingebouwde "Geluid en afspeel" mogelijkheden. Dit hoofdstuk beschrijft de afspeel functies en de
manier waarop het geluid van het instrument kan worden uitgebreid naast het ingebouwde piano geluid.
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Afspeel mode

MuseScore heeft een geïntegreerd mengpaneel en synthesizer om de partituur af te spelen.

Door het drukken op de Afspeel  knop, kom je in de Afspeel mode. In de Afspeel mode zijn de volgende commando's
beschikbaar:

Terug naar vorig akkoord ←
Verder naar volgend akkoord →
Terug naar vorige maat Ctrl+← (Mac: Cmd+←)
Verder naar volgende maat Ctrl+→ (Mac: Cmd+→)
Terug naar het begin van de partituur Home (Mac: ⌘+Home)
Weergeven/verbergen Afspeelpaneel F11 (Mac: ⌥+⌘+P)

Druk nogmaals op de afspeel knop om te stoppen en om de Afspeel mode te verlaten.

MuseScore start met afspelen vanaf de plaats waar het als laatste gebleven is. Indien je echter een noot selecteert dan
speelt MuseScore vanaf die plaats. In de werkbalk is ook een terugspoel knop om snel terug te gaan naar het begin van
de partituur voor het afspelen.

Activeer de  Laat herhalingen horen-knop om herhalingen tijdens het afspelen af te spelen.

Afspeelpaneel

Het Afspeelpaneel geeft meer controle over het afspelen inclusief het aanpassen van het tempo, start-eind positie en
algehele volume voor de huidige sessie (deze aanpassing worden niet in de partituur opgeslagen). Vanuit het hoofd menu
kies je Weergave → Afspeelpaneel om het te openen.

Opmerking: Je kunt het standaard volume instellen via de Synthesizer (Weergave → Synthesizer).

Aftellen

Je kunt het aftellen voordat het afspelen begint aan- of uitzetten. Het aftellen speelt een hele maat (volgens de huidige
maatsoort op de afspeel positie); indien het start punt in het midden van een maat is of als het om een 'verkorte' maat
(opmaat) gaat, dan worden er zoveel tellen gespeeld als nodig om die maat op te vullen.
Het dirigent icoon in het afspeelpaneel schakelt het aftellen in of uit.

Afspelen met Metronoom

Je kunt een begeleidende metronoom tijdens het afspelen aan- of uitzetten met het metronoom icoon in het
afspeelpaneel.

Lus

Je kunt het afspelen van een passage herhalen. Gebruik de drie knoppen onderaan het afspeelpaneel om eerst de start
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en eind positie in te stellen en daarna kan de lus worden afgespeeld. De lus kan ook aan/uit worden gezet middels een
knop in de hoofd werkbalk van MuseScore.
Bij de lus start en eind positie is een blauwe vlag wijzend naar rechts respectievelijk links zichtbaar.

Geluid wijzigen en aanpassen

Mixer

De Mixer stelt je instaat de instrument geluiden aan te passen, het volume, het panorama, de reverb. (galm) en de chorus
voor iedere notenbalk in te stellen. Kies vanuit het hoofd menu Weergave → Mixer of druk op F10 (Mac: fn+F10) om de mixer
zichtbaar te maken.

Dempen en Solo

Gebruik de Demp optie om snel een aantal partijen stil te maken. Als alternatief kun je ook de Solo optie gebruiken om alle
partijen stil te laten zijn behalve die als "Solo" is aangemerkt.

Knoppen

Om een knop met de klok mee te draaien, klik en sleep naar boven. Om een knop tegen de klok in te draaien, klik en
sleep naar beneden.

Geluid

De lijst met geluiden bestaat uit alle instrumenten die door je huidige SoundFont  worden ondersteund. Indien je
meerdere SoundFonts hebt geladen in de Synthesizer dan worden de geluiden van alle SoundFonts in de lijst
weergegeven—de beschikbare geluiden worden in volgorde van de geladen SoundFonts weergegeven. Eerst de geluiden
van het eerste SoundFont, daarna die van de tweede, etc.

Wijzig instrument

Je kunt een notenbalk aanpassen in een ander instrument. De volgende methode wijzigt in één keer het instrument
geluid, de notenbalknaam en de notenbalk transpositie.

1. Klik met rechts op een leeg gedeelte van een maat of op de instrument naam en kies Notenbalk-eigenschappen...

2. Klik op Verander instrument... (knop aan de rechterkant)
3. Kies het nieuwe instrument en klik OK om terug te gaan naar het Notenbalk-eigenschappen dialoog
4. Klik nogmaals op OK om terug te gaan naar de partituur

Niet te verwarren met Instrument wijzigen in notenbalk.

Geluid wijzigen in notenbalk (pizz., gedempt, etc.)

Sommige instrument kunnen ook van geluid wijzigen in het midden van een partituur. Als voorbeeld, strijkers kunnen
pizzicato of tremolo spelen, terwijl een trompet kan veranderen in gedempte trompet.
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De volgende instructie stelt het gebruik van pizzicato strijkers in als voorbeeld, maar hetzelfde principe geldt voor tremolo
violen of een gedempte trompet.

1. Selecteer de eerste noot van de sectie die je als pizzicato wilt laten horen
2. Vanuit het hoofd menu, kies Voeg toe → Tekst → Notenbalktekst

3. Type Pizz. Op dit moment is deze tekst alleen een visuele weergave en wordt niet gebruikt tijdens het afspelen
4. Klik met rechts op de notenbalktekst en kies Notenbalktekst-eigenschappen

5. In het 'Notenbalktekst-eigenschappen' dialoog, selecteer één of meerdere stemmen aan de linkerkant (in de Wijzig
kanaal tab)

6. Selecteer pizzicato in de lijst

7. Klik OK om terug te gaan naar de partituur

Iedere noot die volgt na de notenbalktekst die je hebt toegevoegd klinkt nu pizzicato. Om later terug te keren naar het
normale strijkers geluid volg dezelfde instructie als hierboven echter type Arco in stap 3 en selecteer normaal in stap 6.

Zie ook

SoundFont
Synthesizer
Hoe wijzig je het instrument geluid (bv. pizz., gedempt) halverwege een partituur

Instrumentwijziging in notenbalk

Instrumentwijziging tekst (beschikbaar als "Instrument" in het tekst palet) kan worden gebruikt om aan te geven dat het
instrument dat wordt gespeeld wordt gewijzigd in een specifieke notenbalk en deze wijziging is ook hoorbaar tijdens het
afspelen. Er is echter wel een beperking, de transpositie wordt hierbij niet veranderd.

Toevoegen van een instrumentwijziging

1. Selecteer het startpunt voor de wijziging

2. Pas "Instrument" toe vanuit het tekst palet

3. Dubbelklik op de nieuw ingevoegde tekst om deze te bewerken

Merk op dat je ook de opmaak van de tekst kunt aanpassen
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of pas de Tekst-eigenschappen aan door met rechts te klikken op de tekst na het verlaten van de bewerkingsmodus (de
tekst moet zwart zijn en niet helder blauw) of pas een Tekst Stijl toe (dat dezelfde wijziging zal toepassen op alle tekst
voor instrumentwijzigingen).

4. Klik met rechts op de tekst en kies "Wijzig instrument..."

5. Kies het instrument en klik OK

Zie ook

Wijzig instrument
Geluid wijzigen in notenbalk

SoundFont

Overzicht

Een SoundFont is een speciaal bestand dat samples bevat van verschillende instrumenten die verschillende noten
spelen, dit maakt het mogelijk voor MuseScore om ieder instrument geluid te spelen. Sommige SoundFonts zijn speciaal
gemaakt voor klassieke muziek, andere voor jazz, pop, etc.
Er zijn veel SoundFonts beschikbaar op het internet. Zoek er naar één die de 128 geluiden van General MIDI  (GM)
omvat. Als je een SoundFont gebruikt dat niet voldoet aan de General MIDI standaard, dan horen anderen mogelijk niet
de juiste instrumenten als je de partituur deelt of exporteer naar een MIDI bestand. MuseScore 0.9.6 tot 1.3 bevatte een
relatief licht-gewicht, algemeen SoundFont genaamd TimGM6mb.sf2, terwijl 2.0 met het veel betere FluidR3Mono_GM.sf3 komt.

De bestandsgrootte en geluid kwaliteit van de SoundFonts op het internet variëren. Grotere SoundFonts hebben vaak een
betere geluidskwaliteit maar kunnen te groot zijn om op je computer te gebruiken. Als je merkt dat MuseScore traag wordt
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na het installeren van een groot SoundFont, of als je computer het niet kan bijhouden tijdens het afspelen, ga dan opzoek
naar een kleiner SoundFont.

Zodra een SoundFont geïnstalleerd  is dan kan het door MuseScore worden gebruikt voor het afspelen (en andere
aspecten van het geluid) met de Synthesizer. Om de Synthesizer weer te geven ga je naar Weergave → Synthesizer.

Een SoundFont installeren

Na het vinden en uitpakken van een SoundFont (zie →hieronder), dubbelklik er op om deze te openen. In de meeste
gevallen zal het SoundFont type gekoppeld zijn aan MuseScore en dus zal MuseScore worden opgestart en een dialoog
wordt zichtbaar waarin wordt gevraagd of je het SoundFont wilt installeren. Soms is er een andere applicatie dan
MuseScore gekoppeld aan het SoundFont bestands type; in dit geval klik je met rechts op het bestand zodat je kunt
kiezen dat je het bestand met MuseScore wilt openen. In beide gevallen, zodra het dialoog wordt getoond met de vraag of
je het SoundFont wilt installeren, klik je op "Ja" om een kopie van het SoundFont op te slaan in de MuseScore SoundFont
map. Deze map is specifiek voor iedere aangemelde gebruiker en kan worden gezien of gewijzigd in MuseScore
Voorkeuren; de standaard map is:

Windows: %HOMEPATH%\Documents\MuseScore2\Soundfonts

Mac OS X and Linux: ~/Documents/MuseScore2/Soundfonts

In tegenstelling tot door de gebruiker toegevoegde SoundFonts, is het initiële standaard SoundFont dat wordt
geïnstalleerd door MuseScore opgeslagen in een systeem map die alleen hiervoor is bedoeld. Deze map en het
standaard SoundFont bestand is:

Windows (32-bit): %ProgramFiles%\MuseScore 2\sound\FluidR3Mono_GM.sf3

Windows (64-bit): %ProgramFiles(x86)%\MuseScore 2\sound\FluidR3Mono_GM.sf3

Mac OS X: /Applications/MuseScore 2.app/Contents/Resources/sound/FluidR3Mono_GM.sf3

Linux (Ubuntu): usr/share/sounds/sf2/FluidR3Mono_GM.sf3

De-installeren

Om een SoundFont te de-installeren open je de map waarin het SoundFont is geplaatst en verwijder je deze.

Synthesizer

De Synthesizer is MuseScore's centrale controle paneel voor het maken geluid.
Nadat een SoundFont geïnstalleerd  is, moet het met de Synthesizer worden geladen zodat het door MuseScore kan
worden gebruikt voor het afspelen. Om de Synthesizer weer te geven ga je naar Weergave → Synthesizer.
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Lijst met SoundFonts

Hieronder een aantal populaire GM SoundFonts van verschillende omvang.

Fluid R3 GM  (141 MB niet gecomprimeerd)
Licentie: beschikbaar gesteld onder MIT licentie (bijgevoegd in het archief)
GeneralUser GS  (29.8 MB niet gecomprimeerd)
Met dank aan S. Christian Collins
Magic Sound Font, version 2.0  (67.8 MB niet gecomprimeerd)
Arachno SoundFont, version 1.0  (148MB niet gecomprimeerd)
Met dank aan Maxime Abbey
MuseScore versie 1.x kwam met TimGM6mb  (5.7 MB niet gecomprimeerd)
Licentie: GNU GPL, versie 2
Met dank aan Tim Brechbill
MuseScore versie 2.0 komt met het SoundFont FluidR3Mono_GM.sf3  (13.8 MB).
Licentie: beschikbaar gesteld onder MIT licentie
Timbres of Heaven, version 3.1  (369 MB niet gecomprimeerd)
Met dank aan Don Allen

Naast SoundFont bestanden ondersteund MuseScore ook het SFZ formaat, dankzij de nieuwe synthesizer Zerberus .
Hier zijn een aantal SFZ geluid banken:

Sonatina Symphonic Orchestra (503 MB niet gecomprimeerd)
Downloads: SoundFont  | SFZ formaat
Licentie: Creative Commons Sampling Plus 1.0
Salamander Grand Piano, version 3  (tussen 80 MB en 1.9 GB niet gecomprimeerd)
Licentie: Creative Commons Attribution 3.0
Salamander Grand Piano, version 2  (tussen 80 MB en 1.9 GB niet gecomprimeerd)
Licentie: Creative Commons Attribution 3.0
Detuned Piano  (244 MB niet gecomprimeerd)
Licentie: Creative Commons Attribution-ShareAlike 3.0
Plucked Piano Strings  (168 MB niet gecomprimeerd)
Licentie: Creative Commons Attribution-ShareAlike 3.0

Gespecialiseerde SoundFonts

Acoustic grand piano, release 2008-09-10  (132 MB niet gecomprimeerd)
Beschrijving: Yamaha Disklavier Pro piano, sf2 formaat, 116 samples, 44100Hz, 16bit
Meer informatie: http://zenvoid.org/audio/
Licentie: Creative Commons Attribution 3.0
Met dank aan Roberto Gordo Saez
Acoustic grand piano, old version  (37.5 MB niet gecomprimeerd)
Beschrijving: Steinway & Sons, sf2 formaat, 13 samples, stereo, 44100Hz, 16bit (gebaseerd op University of Iowa
Musical Instrument Samples )
Meer informatie: http://zenvoid.org/audio/
Licentie: Public domain
Met dank aan Roberto Gordo Saez

Opmerking: Omdat SoundFont bestanden erg groot zijn worden ze vaak gecomprimeerd in verschillende formaten
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inclusief .zip, .sfArk en .tar.gz. Deze bestanden moeten worden uitgepakt voordat ze gebruikt kunnen worden.

ZIP is standaard compressie formaat dat wordt ondersteund door de meeste besturing systemen.

sfArk is een compressie formaat dat speciaal is bedoeld voor het comprimeren van SoundFont bestanden. Gebruik
de speciale sfArk software  om het uit te pakken.

.tar.gz is een populair compressie formaat voor Linux. Windows gebruikers kunnen hiervoor 7-Zip  gebruiken; Mac
gebruikers kunnen gebruik maken van The Unarchiver , of de in Mac OS X's ingebouwde Archiveer toepassing.
Merk op dat wanneer je 7-Zip gebruikt, je het bestand twee keer moet uitpakken, één keer voor GZip en één keer
voor TAR.

Probleemoplossing

Indien de werkbalk afspeel knop grijs is, of niet zichtbaar, volg dan de instructies hieronder om het geluid weer werkend te
krijgen:

Klik met rechts op de menu balk en zorg dat er een vinkje staat bij de Afspeelknoppen menu optie. Je kunt het vinkje
toevoegen of verwijderen door op de menu optie te klikken. Als met deze stap het probleem niet is verholpen, ga
dan verder met de volgende stap.
Indien het afspeelpaneel verdwijnt na het installeren van het SoundFont, ga dan naar Bewerken → Voorkeuren... → I/O tab

en klik OK zonder iets aan te passen. Na het herstarten van MuseScore moet het afspeelpaneel weer zichtbaar zijn.

Als je voor de eerste keer een SoundFont gaat instellen, maak dan gebruik van één van de bovenstaande aanbevolen
SoundFonts.

Als het afspelen stottert, dan is je computer niet instaat om het gebruikte SoundFont om te gaan. Er zijn hiervoor twee
oplossingen:

1. Reduceer de hoeveelheid gebruikte geheugen (RAM) door MuseScore door gebruik te maken van een kleiner
SoundFont. Zie bovenstaande lijst voor suggesties.

2. Verhoog de hoeveelheid beschikbare geheugen (RAM) voor MuseScore door alle applicaties, behalve MuseScore,
af te sluiten. Als je nu nog steeds problemen hebt en een groot SoundFont is erg belangrijk voor je, overweeg dan
de hoeveelheid RAM in je computer uit te breiden.

Zie ook

Synthesizer
Geluid wijzigen en aanpassen

Externe links

Hoe wijzig ik het SoundFont

Swing

MuseScore kan een partituur afspelen met gebruikmaking van swingende achtste of zestiende noten.

Swing Inschakelen

De aanbevolen manier om MuseScore (en de mensen die jouw muziek gebruiken) te laten weten dat een swing ritme
benodigd is, gaat met het gebruik van het Swing Systeem tekst element.

1. Klik op de eerste noot

2. Dubbelklik Swing in het tekst palet

De Swing tekst kan worden aangepast zoals ieder ander tekst element door er op te dubbelklikken (zie Tekstbewerken)
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en het kan verborgen worden door gebruik te maken van de Instellingenoverzicht.

Terug naar gewoon ritme

Als je een partituur hebt waarin zowel "swing" als "gewone" secties voorkomen en je wilt dit laten horen tijdens het
afspelen dan doe je het volgende:

1. Voeg een Swing tekst element toe zoals hierboven, verbonden aan de eerste noot of rust waar de "gewone" sectie
begint.

2. Wijzig de tekst zoals gewenst - dubbelklik op het element dat je hebt toegevoegd en wijzig dit in "Straight" (zie
Tekstbewerken).

3. Zet de swing uit middels rechts-klik → Systeemtekst-eigenschappen → Swing-instellingen → Uit

Swing-instellingen

Swing tekst instellingen

Swing-instellingen voor een individuele Swing tekst markering zijn beschikbaar via rechts-klik → Systeemtekst-eigenschappen

→ Swing-instellingen. Hiermee kun je instellen hoe "zwaar" de swing (de ratio van de downbeat ten opzichte van de upbeat)
en of het de achtste of zestiende noot is die in swing moet.

Globale swing-instellingen

Standaard is, bij afwezigheid van een Swing tekst element, het afspelen in swing uitgeschakeld. Om het swing ritme
tijdens het afspelen aan te zetten zonder het tekst element toe te voegen kunnen de algemene (voor de gehele partituur)
swing-instellingen worden aangepast via Stijl → Algemeen... → Partituur.

Synthesizer

Overzicht

De Synthesizer is MuseScore's centrale controle paneel voor het maken geluid. Hiermee stel je onder meer in welke
SoundFonts er wordt gebruikt bij het afspelen en stel je de equalizer in en de volume niveaus.

Om de Synthesizer zichtbaar te maken, ga naar Weergave → Synthesizer.

Er kan slechts één set van Synthesizer instellingen tegelijk actief zijn - bv. indien je meerdere partituren geopend hebt dan
is het niet mogelijk wijzigingen aan te brengen in de Synthesizer in één partituur en daarbij de overige onaangepast te
laten. Ook zullen de wijzigingen die zijn aangebracht in de Synthesizer alleen in de huidige sessie worden gebruikt. De
volgende keer dat MuseScore wordt gestart worden de standaard instellingen weer gebruikt. Die standaard instellingen
kunnen op ieder moment worden gewijzigd door op de Stel in als standaard  knop te drukken in de Synthesizer waardoor de
huidige instellingen de nieuwe standaard instelling wordt voor de volgende sessies.

Het is ook mogelijk om de instellingen op te slaan in een individuele partituur en deze later op te roepen met de Sla op in

partituur and Laad van partituur  knoppen. De opgeslagen instellingen worden niet automatisch geladen bij het openen van een
partituur, het is noodzakelijk om de instellingen handmatig te laden.

Wijzigingen die worden gemaakt in de Synthesizer zijn niet hoorbaar in geëxporteerde audio bestanden tenzij de
Synthesizer instellingen zijn opgeslagen in de partituur met de Sla op in partituur knop.

Een verdere uitleg van deze opties is te vinden bij het voorbeeld voor de Stemming (hieronder).

SoundFont

Een SoundFont is een speciaal bestand dat samples bevat die MuseScore kan gebruiken bji het afspelen. MuseScore
komt met het SoundFont FluidR3Mono_GM.sf3, andere SoundFonts kunnen worden gedownload van internet (zie ook Lijst
met SoundFonts). Zodra een SoundFont geïnstalleerd is dan kan het door MuseScore worden gebruikt voor het afspelen
(en andere aspecten van het geluid) met de Synthesizer.

Standaard wordt het SoundFont FluidR3Mono_GM.sf3 geladen in de Synthesizer:
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Klik op de Voeg toe knop om een ander SoundFont uit de SoundFont map aan de lijst toe te voegen.

Opmerking: Indien er geen andere SoundFonts zijn geïnstalleerd, dan zijn er geen andere SoundFonts beschikbaar om
te laden. Om een SoundFont te gebruiken voor het afspelen, moet het eerst zijn geïnstalleerd (dat is een éénmalige actie)
en dan worden geladen in de Synthesizer (dit kan worden gedaan wanneer nodig of permanent worden ingesteld).

Een geladen SoundFont kan worden verwijderd uit de Synthesizer (maar niet worden gede-installeerd) door het te
selecteren in de lijst en dan te klikken op Verwijder. Als er meerdere SoundFonts zijn geladen dan kan de volgorde worden
aangepast met de Omhoog en Omlaag knoppen.

Indien je geen geluiden hebt aangepast in de Mixer, dan wordt het SoundFont dat bovenaan de lijst staat gebruikt voor
het afspelen. Indien je echter de Mixer gebruikt om verschillende instrumenten met geluiden uit verschillende SoundFonts
te laten spelen dan werkt dit alleen correct als je dezelfde SoundFonts hebt geladen in dezelfde volgorde in de
Synthesizer. Het is daarom aan te raden dat, indien je meerdere SoundFonts gebruikt, je klikt op de Sla op in partituur knop
in de Synthesizer, zodat je de volgende keer dat je de partituur opent je de lijst van geladen SoundFonts (en andere
Synthesizer instellingen) kunt oproepen met de Laad van partituur  knop.

Optioneel kun je de Stel in als standaard  knop gebruiken om de standaard Synthesizer instellingen te wijzigen zodat je deze
de volgende keer niet vanuit de partituur hoeft te laden. Anders zal de Synthesizer terug gaan naar de originele standaard
instelling in de volgende sessie dat je met MuseScore werkt.

Volume

Aan de rechterkant in de Synthesizer bevinden zich twee schuifbalken. De één bepaalt het afspeel volume, de andere
bepaalt het volume van de optioneel ingebouwde metronoom. Net als met de overige instellingen van de Synthesizer zijn
alle wijzigingen die hier worden gemaakt tijdelijk tenzij ze worden opgeslagen in de partituur of worden ingesteld als de
nieuwe standaard.
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Effecten

In de Master Effecten tab van de Synthesizer is het mogelijk geavanceerde afspeel opties zoals vertraging en equalizer
instellingen. Standaard is het effect genaamd "Zita1" ingeschakeld, dat probeert om het hoorbare geluid zo echt als
mogelijk te laten klinken. Het kan worden uitgeschakeld door "Effect A" op "NoEffect" te zetten. Om dit effect permanent
uit te zetten (en permanent alle andere Synthesizer instelling toe te passen) klik Stel in als standaard .

Stemming

Voor instrumenten op werkelijke toonhoogte gebruikt MuseScore A4 = 440Hz toonhoogte als standaard. Dit kan worden
aangepast door een nieuwe waarde in te voeren in de via de Stemming tab van de Synthesizer.
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Zoals met alle andere Synthesizer instellingen is de stemming van toepassing op het afspelen in MuseScore maar heeft
het geen effect op de geëxporteerde audio bestanden (WAV, OGG, MP3, MIDI) tenzij de Sla op in partituur optie is gekozen.

Aanpassen van de Stemming

Opmerking: Dit is van toepassing op alle partituren. Alleen voor de huidige sessie (de stemming wordt hersteld naar
standaard bij het afsluiten van MuseScore). Is van toepassing op afspelen maar niet op geëxporteerde audio bestanden
(WAV, OGG, MP3 en MIDI).

1. Weergave → Synthesizer.
2. Klik op de Stemming tab.
3. Voer een nieuwe Basisstemming waarde in (Standaard 440Hz).
4. Klik Wijzig Stemming.

Standaard stemming instellen

Opmerking: Dit is van toepassing op alle partituren. Voor de huidige sessie en volgende sessies (totdat je het weer
aanpast). Is van toepassing op afspelen maar niet op geëxporteerde audio bestanden (WAV, OGG, MP3 en MIDI).

1. Wijzig de Basisstemming zoals hierboven voor de huidige sessie.
2. Klik op Zet als standaard .

Stemming instellen voor een individuele partituur

Opmerking: Dit is van toepassing op de huidige partituur in de huidige sessie en alle volgende sessies. Het is van
toepassing op afspelen en op geëxporteerde audio bestanden (WAV, OGG, MP3 en MIDI).

1. Wijzig de Basisstemming zoals hierboven voor de huidige sessie.
2. Klik op Sla op in partituur.
3. De nieuwe stemming wordt nu gebruikt bij het exporteren van audio bestanden van de huidige partituur maar de

overige partituren worden geëxporteerd met de standaard stemming zoals verwacht. Echter, door een beperking in
MuseScore, moet je op Laad van partituur  of Laad de standaardwaarde klikken zoals van toepassing om de juiste stemming
te krijgen tijdens het afspelen.

Zie ook
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SoundFont
Mixer

Tempo

Tempo aanduidingen kunnen worden toegevoegd aan een partituur in de vorm van Tempotekst. Het afspeel tempo kan
tijdelijk (handmatig) worden aangepast in het Afspeelpaneel.

Tempotekst

Tempo aanduidingen worden gebruikt om de snelheid van de muziek aan te geven aan de persoon die de partituur leest
en worden ook gebruikt tijdens het afspelen. Het is mogelijk om meerdere tempo aanduidingen te hebben op
verschillende plaatsen in de hele partituur.

Een tempo aanduiding toevoegen:

1. Selecteer de noot of rust waar het tempo moet worden toegevoegd.
2. Open het Tempo palet en dubbelklik de gewenste tempo aanduing stijl om het toe te voegen aan de noot of rust.

Als alternatief kun je een tempo element ook door te slepen vanuit het palet en het te plaatsen op een noot of rust.
Je kunt een tempo ook toevoegen vanuit het hoofd menu Voeg toe → Tekst → Tempo aanduiding maar je kunt dan niet
bepalen met welke noot waarde het tempo wordt gemaakt.

Bestaande tempo aanduidingen kunnen worden aangepast door te dubbelklikken op de tekst in de tekstbewerkingsmodus.

Het aantal tellen per minuut van een tempo aanduiding kan direct worden aangepast door de tekst te bewerken indien
"Volg Tekst" is gekozen in Instellingenoverzicht en de tempotekst is uitgedrukt in de vorm van "noot duur = nummer",
zoals in dit voorbeeld dat de informatie bevat "kwartnoot = 75":

Als een tempo aanduiding is aangepast en niet langer deze informatie bevat (bijvoorbeeld door alleen het woord
"Andante" zonder nummer), klik dan één keer op de aanduiding om deze te selecteren. Verwijder het vinkje bij "Volg
Tekst" in het Instellingenoverzicht en nu kan handmatig het aantal kwart noten per minuut dat hoort bij de tempo
aanduiding worden ingesteld.

Opmerking: Het afspelen is mogelijk sneller of langzamer indien de tempo instelling in het afspeelpaneel op een andere
waarde is ingesteld dan 100%.

Geleidelijke tempo wijzigingen zoals ritardando ("rit.") en accelerando ("accel.") kunnen worden toegevoegd als
systeemtekst, maar hebben momenteel geen effect op het afspelen.

Afspeelpaneel

Weergeven afspeelpaneel: Weergave → Afspeelpaneel of F11 (Mac: fn+F11)
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Wijzig het werkelijk tempo van de partituur door het percentage aan te passen met de Tempo schuifbalk

Deze instelling wordt niet opgeslagen in de partituur en zal proportioneel worden toegepast op alle tempo aanduidingen in
de partituur. Indien je meerdere tempo aanduidingen hebt in de partituur, dan is het BPM (Beats per Minute/Tellen per
Minuut) getal dat boven de schuifbalk staat afhankelijk van de plaats waar je bent in de partituur. Als voorbeeld, indien het
tempo van het afspelen is ingesteld op 80 BPM en het Afspeelpaneel is ingesteld op 120% van het tempo, dan is het
werkelijke tempo van het afspelen 96 BPM. Dit is zichtbaar door het nummer dat wordt weergegeven boven het
percentage in het Afspeelpaneel.

Dynamiek

Het afspeel volume voor het hele stuk kan worden aangepast in het afspeelpaneel of lokaal door gebruik van dynamische
tekens in de partituur.

Dynamische tekens

Vanuit het Dynamische tekens palet, sleep een dynamiek naar een noot in de partituur. Als alternatief kun je ook
een noot selecteren in de partituur en dan dubbelklikken op de dynamiek in het palet.

Om een crescendo en decrescendo te maken, zie Haarspelden.

Voor additionele dynamiek gebruik het Hoofdpalet (Shift+F9). Je kunt ook een eigen palet  maken voor regelmatig
gebruik.

Aanpassen van het afspeel volume voor een dynamiek teken

Klik op het dynamiek teken om hem te selecteren en pas het "Geluidssterkte" getal aan in het Instellingenoverzicht -
hoger voor harder, lager voor zachter. Als het Instellingenoverzicht niet zichtbaar is, ga dan naar Weergave->
Instellingenoverzicht of druk op F8 (Mac: fn+F8).

Afspeelpaneel

Weergeven Afspeelpaneel: Weergave → Afspeelpaneel
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Wijzig het Volume met de schuifbalk

Externe links

Video zelfstudie: Les 10 - Articulatie, Dynamiek en Tekst

Tekst

Veel elementen in de partituur zijn gebaseerd op tekst. Tekst op zichzelf (zoals notenbalk-tekst, dynamische tekens,
tempo, vingerzetting, liedtekst, etc.) of in combinatie met lijnen (zoals volta's, octaaf lijnen, gitaar barré lijnen etc.).

Dit hoofdstuk beschrijft de verschillende groepen van tekst die MuseScore bevat en de opmaak mogelijkheden. Andere
varianten van tekst worden behandeld in verschillende hoofdstukken:

Tempo (→Geluid en afspelen)
Dynamische tekens —p, mf, etc. (→Geluid en afspelen)
Swing (→Geluid en afspelen)
Instrument wijzigen (→Geluid en afspelen)
Herhalingen en sprongen —DC, Fine, Coda, etc. (→Notatie)
Basso continuo (becijferde bas) (→Geavanceerde onderwerpen)
Kaders tekst —in verticale, horizontale of tekst kaders (→Opmaak)
Kop- en voetteksten —anders dan standaerd tekst objecten (→Opmaak)
Lijnen (→Notatie)

Tekst algemeen

Tekst toevoegen

Afhankelijk van het type tekst dat je wilt toevoegen zijn er één of meer van de volgende drie mogelijkheden beschikbaar:

Vanuit het hoofdmenu via Voeg toe → Tekst (bv. titel) of
Vanuit een palet (bv. swing tekst) of
Middels een toetsenbord sneltoets (bv. liedtekst)

Specifieke instructies voor ieder type tekst object is beschikbaar in de relevante pagina's van het handboek (zie Tekst).
Voor algemene tekst, zie Notenbalk- en systeemtekst hieronder.

Tekst opmaak

MuseScore heeft drie niveaus voor de tekst opmaak:

Tekststijlen: Deze zijn van invloed op de stijl voor een groep tekst elementen (bv. alle notenbalktekst, alle tempo's,
alle liedtekst). Om de tekst stijl aan te passen ga je naar Stijl → Tekst… of klik je met rechts op de tekst en kies je
Tekststijl….
Opmerking: Het aanpassen van een tekststijl heeft invloed op alle tekst objecten in de partituur die de stijl
gebruiken. Voor de volledige details, zie Tekststijlen.
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Tekst-eigenschappen: Dit heeft invloed op één specifiek tekst object in de partituur. Om de tekst-eigenschappen
van het object aan te passen klik je er met rechts op en kies je Tekst-eigenschappen…. Voor de volledige details, zie
Tekst-eigenschappen.

Tekst bewerken: Hiermee kunt u de stijl van individuele karakters binnen een tekst object aanpassen door gebruik
te maken van de basis opmaak mogelijkheden zoals Vet, Cursief, lettertype, lettertype grootte, subscript en
superscript. Om de inhoud van een tekst object aan te passen:

Dubbelklik op de tekst of

Klik met rechts op de tekst en kies "Bewerk element" of

Klik op de tekst en druk op Ctrl + E (Mac: Cmd + E).

Voor volledige details, zie Tekst bewerken.

Notenbalk- en systeemtekst

Voor algemene tekst: gebruik Notenbalktekst of Systeemtekst. Het verschil tussen deze twee soorten tekst is dat je de
ene kunt toepassen op een enkele notenbalk, en de andere op het hele systeem. Dit is van belang bij "Partijen maken".
Notenbalktekst zal alleen verschijnen in de partij van het specifieke instrument waaraan de tekst bevestigd is, terwijl
systeemtekst verschijnt in alle partijen. Bovendien, als je ervoor kiest om lege notenbalken te verbergen, zal de tekst die
behoort tot een lege notenbalk ook worden verborgen. Systeemtekst wordt niet verborgen door de functie "Verberg lege
notenbalken".

Notenbalktekst

Notenbalktekst is tekst voor algemeen gebruik op een bepaalde notenbalk en op een bepaalde plaats in de partituur. Om
notenbalktekst toe te voegen bepaal je eerst de plaats door een noot of een rust te selecteren en gebruik je daarna de
menu optie Voeg toe → Tekst → Notenbalktekst of gebruik je de sneltoets Ctrl+T (Mac: ⌘+T). Er verschijnt een klein tekstvak en
je kunt onmiddellijk beginnen met het invoeren van de tekst. Je kunt het tekstvak verlaten (zelfs zonder tekst), door op Esc

te drukken.

Notenbalktekst kan bijvoorbeeld gebruikt worden om aanduidingen toe te voegen zoals "Solo" of "Pizzicato" aan een
notenbalk in de partituur. Afhankelijk van deze instructies, kan het MIDI afspelen op de plaats van de tekst op de
notenbalk aangepast worden door rechts te klikken op de tekst en te kiezen voor: Notenbalktekst-eigenschappen…. Zie: Hoe het
geluid van een instrument wijzigen (bijvoorbeeld pizzicato, con sordino) halverwege de partituur .

Systeemtekst

Systeemtekst gebruik je wanneer je indicaties wilt toevoegen aan het hele systeem in plaats van alleen aan een
notenbalk. Dit zorgt voor een verschil bij "Partijen maken" of indien je ervoor kiest om lege notenbalken te verbergen. Om
systeemtekst toe te voegen bepaal je eerst de plaats door een noot of een rust te selecteren en kies je vervolgens in het
menu voor Voeg toe → Tekst → Systeemtekst of gebruik de sneltoets Ctrl+Shift+T (Mac: ⌘+Shift+T). Er verschijnt een klein
tekstvak en je kunt meteen beginnen met typen. Je kunt het tekstvak verlaten (zelfs zonder tekst) door op Esc te drukken.

Tekst bewerken

Tekst bewerken

Om in de tekst bewerkingsmodus te komen zijn en verschillende mogelijkheden:

Dubbelklik op de tekst
Klik met rechts op de tekst en kies "Bewerk element"
Klik op de tekst en druk op Ctrl+E (Mac: Cmd+E)

Opmaak en invoer opties zijn beschikbaar in de tekstwerkbalk onderaan het venster.
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Bewerkingscommando's en toetsenbord sneltoetsen

In de tekstbewerkingsmodus zijn de volgende commando's beschikbaar:

Ctrl+B (Mac: ⌘+B) vet
Ctrl+I (Mac: ⌘+I) cursief
Ctrl+U (Mac: ⌘+U) onderstrepen
Home End ← → ↑ ↓ verplaatst de cursor
Backspace (Mac: Delete) verwijder het karakter links van de cursor
Delete (Mac: → Delete or fn+Delete) verwijder het karakter rechts van de cursor
Return start nieuwe regel
F2 (Mac: fn+F2) voeg speciale karakters in (zie hieronder)

Sneltoetsen voor speciale karakters

In de tekstbewerkingsmodus zijn de volgende sneltoetsen beschikbaar om een aantal speciale karaketers in te voeren:

Ctrl+Shift+B: Mol
Ctrl+Shift+F: Forte
Ctrl+Shift+H: Herstellingsteken
Ctrl+Shift+M: Mezzo
Ctrl+Shift+N: Niente
Ctrl+Shift+R: Rinforzando
Ctrl+Shift+S: Sforzando
Ctrl+Shift+Z: Z

Symbolen en speciale karakters

Je kunt Speciale karakters dialoog gebruiken om kwartnoten, breuken en vele andere speciale symbolen of karakters in

de tekst in te voegen. Klik op het toetsenbord icoon in de tekstwerkbalk  of druk op F2 (Mac: fn+F2) om het Speciale
karakters dialoog te openen.

Dubbelklik op een item in het Speciale karakters dialoog om het toe te voegen aan de tekst op de positie van de cursor.

Merk op dat het niet mogelijk is om het Speciale karakters dialoog weer te geven als je niet in tekstbewerkingsmodus bent
en dit moet niet verward worden met het menu item met dezelfde naam in de Mac OS X versie van MuseScore.

Zie ook

Akkoordsymbolen
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Liedtekst
Kaders
Bewerkingsmodus

Tekststijl

Tekststijlen en tekst-eigenschappen

Ieder tekst element heeft een basis stijl. Als voorbeeld, Titel tekst is gecentreerd en gebruikt een groter lettertype;
Componist tekst is kleiner en rechts uitgelijnd in het bovenste verticale kader. Om de tekststijl te bewerken, ga naar Stijl →

Tekst..., of rechts-klik op de tekst en kies Tekststijl...

Wijzigingen in een tekst stijl hebben effect op alle tekst in de partituur die deze stijl gebruiken.

Je kunt dezelfde parameters aanpassen die beschikbaar zijn voor een tekststijl door met rechts te klikken op de tekst en
te kiezen voor Tekst-eigenschappen...

In tegenstelling tot wijzigingen in een tekst stijl, worden wijzigingen in tekst eigenschappen alleen toegepast op
de tekst waarop je met rechts hebt geklikt. De tekst stijl voor de rest van de partituur blijft hierbij ongewijzigd en
andere tekst die dezelfde stijl gebruiken worden niet aangepast.

Tijdens het tekst bewerken kun je wijzigingen maken die afwijken van de basis stijl en die ook anders zijn dan de
specifieke tekst-eigenschappen voor de tekst. Je kunt de wijzigingen gemaakt door het bewerk van de tekst (zoals
lettertype grootte en cursief) met de tekst opnieuw instellen naar stijl optie.
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De beschikbare opties zijn verdeeld in categorieën:

Tekst
Lettertype: naam van het lettertype zoals "Times New Roman" of "Arial"
Grootte: formaat van het lettertype in punten
Stijl: stijl van het lettertype vet, cursief, onderstreept
Kleur: klik op de getoonde kleur om deze aan te passen
Grootte volgt 'Notenbalkafstand'-instelling: of de maat de afstand tussen twee lijnen in een standaard 5-
lijns notenbalk moet volgen
Systeemvlag: tekst wordt toegepast alle notenbalken van een systeem

Correctie instelling
Horizontaal
Verticaal
Eenheid: in mm of notenbalkafstand eenheden

Uitlijning
Horizontaal: links, rechts of gecentreerd
Verticaal: lijn bovenkant van de tekst uit naar referentiepunt, centreer tekst verticaal naar referentiepunt, lijn
basislijn van de tekst uit naar referentiepunt of lijn onderkant van de tekst uit naar referentiepunt

Kader
Kader: voeg een kader toe rondom de tekst
Kader vorm: Cirkel of Rechthoek
Randdikte: dikte van de kaderlijn in (notenbalk) ruimte eenheden
Randkrommingsradius: voor een rechthoek kader, radius van de afgeronde hoek
Tekstmarge : binnen marge kader in ruimte eenheden
Kleur: van het kader (Voorgrond) en van de tekst achtergrond (Achtergrond)

Tekst soorten

Titel, Ondertitel, Componist, Tekstschrijver: Verankerd aan de pagina.
Vingerzetting: Vingerzetting is verankerd aan noten.
Liedtekst: Liedtekst is verankerd aan een positie in tijd (een noot/akkoord, maar niet aan een rust).
Akkoordsymbool: Akkoordsymbolen zijn verankerd aan een positie in tijd.
Systeemtekst: Is van toepassing op alle notenbalken in een systeem. Verankerd aan een positie in tijd.
Notenbalktekst: Is van toepassing op een enkele notenbalk in een systeem. Verankerd aan een positie in tijd.

Het verschil tussen systeemtekst en notenbalktekst is belangrijk voor het partijen maken in een partituur voor ensembles.
Systeemtekst wordt meegenomen in alle partijen. Notenbalktekst wordt alleen meegenomen in de partij waaraan deze is
verankerd. Voor details, zie Tekst.

Een nieuwe tekst stijl maken
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1. Ga naar Stijl → Tekst... of klik met rechts op de tekst en kies Tekststijl...

2. Klik op Nieuw

3. Geef een naam op en klik OK

4. Stel alle eigenschappen in

Dit wordt opgeslagen in de partituur, dit betekent dat het dus niet beschikbaar is in andere partituren.

Toepassen opties

Je kunt de opties toepassen op de partituur of partij die je ziet door de klikken op Toepassen en dan op OK.
Als je in één van de partijen van de partituur bezig bent, dan heb je ook de optie om de Pas toepassen op alle partijen knop
voor het drukken op OK, dit zodat je de wijziging niet alle partijen individueel hoeft aan te passen.

Tekst opnieuw instellen naar stijl

Indien je aanpassingen hebt gemaakt aan een stuk tekst en je wilt dat deze wordt teruggezet naar de stijl zoals ingesteld
voor deze tekst in de partituur, of indien de stijl hebt aangepast met een oudere versie van MuseScore en je wilt dat deze
overeenkomt met de standaard tekst stijl in MuseScore 2, dan kun je de Tekst opnieuw instellen naar stijl optie
gebruiken.

Selecteer de tekst de je wilt terugzetten naar de stijl en klik op Stel tekst opnieuw in naar instellen 'stijl'  in de Instellingenoverzicht.
Als je alle tekst voor een bepaalde stijl wilt terugzetten, klik dan met rechts op één van deze teksten en kies dan Selecteer

→ Alle soortgelijke elementen .

Zie ook

Tekstbewerken
Koptekst/Voettekst

Staff and system text

For general-purpose text, use Staff Text or System Text. The difference between these two types of text is whether you
want it to apply to a single staff, or the whole system. This matters when extracting parts: staff text will only appear in a
part that contains the specific instrument the text is attached to, while system text will appear in all parts. Additionally, if
you choose to hide empty staves, any staff text belonging to an empty staff will also be hidden. System text is never
hidden by the "hide empty staves" feature.

Staff text

Staff text is general purpose text associated with a particular staff at a particular location in the score. To create staff text,
choose a location by selecting a note or rest and then use the menu option Add → Text → Staff Text, or use the shortcut
Ctrl+T (Mac: ⌘+T). A small text box appears and you can immediately start typing. You can exit the text box at any time
(even without typing anything) by pressing Esc.

Staff text can, for example, be used to apply indications such as "Solo" or "Pizzicato" to one staff in a score. Depending on
what the instructions of the staff text are, MIDI playback of that staff at the text location can be altered to match the
instructions by right-clicking on the staff text and selecting Staff Text Properties…. See Mid-staff sound change.

System text

System text is used when you wish to apply text indications to a whole system rather than just to one staff line. This
makes a difference when extracting parts, or if you choose to hide empty staves. To create system text, chose a location
by selecting a note or rest and then use the menu option Add → Text → System Text, or use the shortcut Ctrl+Shift+T (Mac:
⌘+Shift+T). A small text box appears and you can immediately start typing. You can exit the text box at any time (even
without typing anything) by pressing Esc.

See also

Mid-staff sound change

External links

How to change instrument sound (e.g. pizz., con sordino) midway through score
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Akkoordsymbolen

Akkoordsymbolen kunnen worden ingevoerd door de eerste noot te selecteren en dan drukken op Ctrl+K (Mac: ⌘+K). Dit
maakt een akkoorsymbool tekst object voor het gekozen akkoord/noot.

Spatie verplaatst naar de volgende noot of tel.
Shift+Spatie verplaatst naar de vorige noot of tel.
Ctrl+Spatie (Mac: ⌘+Spatie) voegt een spatie toe aan de akkoordnaam.
; verplaatst naar de volgende tel.
Shift+; verplaatst naar de vorige tel.
Tab verplaatst naar de volgende maat.
Shift+Tab verplaatst naar de vorige maat.
Esc verlaat de akkoordsymbool bewerk mode.

Akkoordsymbolen kunnen worden bewerkt worden net zoals normale tekst. Om een kruis toe te voegen, type #. Om een
mol toe te voegen, type b. Om een dubbelkruis toe te voegen, x of ## en om een dubbele mol toe te voegen type bb. Deze
karakters worden automatisch omgezet in kruizen en mollen zodra je klaar bent met de invoer. Maak geen gebruik van de
werkelijk kruis- en moltekens, MuseScore zal dit niet juist begrijpen.

Akkoordsymbolen syntax

MuseScore begrijpt de meeste afkortingen die worden gebruikt in akkoordsymbolen:

majeur: M, Ma, Maj, ma, maj, Δ (type t of ̂ )
mineur: m, mi, min, -
verminderd: dim, o (de kleine letter)
half-verminderd: ø (type 0, nul)
overmatig: aug, +

Merk op dat voor de half-verminderde akkoorden je ook gebruik kunt maken van de afkortingen zoals my7b5 en ze
worden dan op die manier weergegeven in plaats van gebruik te maken van de ø.

Je kunt ook de toevoegingen en veranderingen zoals b9 of #5, sus, alt, en no3 gebruiken. Je kunt de omkering en schuine
streep akkoord weergeven met de notatie zoals C7/E. Je kunt ook haakjes en komma's gebruiken binnen het
akkoordsymbool en je kunt het gehele akkoord tussen haakjes zetten.

Akkoordsymbool stijl

De akkoordsymbolen maken gebruik van de Akkoordsymbool tekst stijl, dus je kunt het lettertype aanpassen met de
mogelijkheden zoals beschreven in Tekststijl. Er zijn ook stijl instellingen te vinden in Stijl → Algemeen... → Akkoordsymbool,

fretborddiagram. Deze opties worden beschreven in deze sectie.

Verschijning

MuseScore kent twee primaire stijlen van akkoordsymbolen: Normaal en Jazz. Je kunt deze selecteren met de
keuzerondjes.

In de Normale stijl worden akkoord eenvoudig weergegeven, het lettertype wordt bepaald door de akkoordsymbool tekst
stijl.

In de Jazz stijl wordt het MuseJazz lettertype gebruikt voor een handgeschreven uiterlijk en wordt ook gebruikt van
superscript en andere opmaak technieken.
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De Jazz stijl wordt standaard gekozen indien je gebruik maakt van een Jazz template.

De derde keuze is voor compatibiliteit met oudere partituren. Je kunt het ook gebruiken om je eigen akkoordsymbool
beschrijvingsbestanden te gebruiken. Deze kunnen worden gemaakt door het kopiëren van één van de standaard
bestanden en door het lezen van de documentatie in deze bestanden die de structuur beschrijft. Echter dit is alleen voor
gevorderde gebruikers en er is geen garantie dat deze bestanden in de toekomst ondersteund blijven.

Noot spelling

Standaard gebruikt MuseScore letters voor de namen van de akkoordsymbolen. Voor gebruikers in regio's waar andere
noot benaming schema's worden gebruikt biedt MuseScore de volgende mogelijkheden:

Normaal: A, Bb, B, C, C#,...
Duits: A, Bb, H, C, C#,...
Volledig Duits: A, B, H, C, Cis,...
Solfeggio: Do, Do#, Reb, Re,...
Frans: Do, Do#, Réb, Ré,...

Daarnaast zijn er opties beschikbaar om het hoofdletter gebruik aan te passen. Standaard zal MuseSocre automatisch
alle noot namen zoals hierboven met hoofdletters schrijven, het maakt hierbij niet uit hoe deze zijn ingevoerd. Echter kun
je ook gebruik maken van andere automatische opties:

Mineurakkoord in kleine letters: c, cm, cm7,...
Basnoten in kleine letters: C/e,...
Nootnamen in hoofdletters: DO, RE, MI,...

Je kunt het automatische hoofletter gebruik ook in zijn geheel uitschakelen, in dat geval worden de nootnamen
weergegeven zoals deze zijn ingevoerd.

Positionering

Normaal gesproken wordt de tekst stijl gevolgd voor de positionering, dus kun je de tekst uitlijnen en horizontale/verticale
verschuiving daar in bepalen indien gewenst. Er zijn echter ook positioneringsmogelijkheden in dit dialoog:

Standaard verticale positie: hoogte boven de notenbalk (gebruik negatieve waarden)
Afstand naar fretborddiagram: indien fretborddiagram aanwezig, de hoogte boven het diagram
Minimale ruimte tussen akkoord: ruimte te houden tussen akkoordsymbolen
Maximum maatstreepafstand: ruimte toegestaan voor de maatstreep
Capo: specificeer capo instelling; overeenkomstige akkoorden worden automatisch tussen haakjes weergegeven

Zie ook

Hoe maak je gestapelde akkoordsymbolen

Vingerzetting

Vingerzetting kan worden toegevoegd een de noten door een vingerzetting karakter uit het vingerzetting palet naar een
noot in de partituur te slepen. Indien eerst de noot is geselecteerd, dan kan het vingerzetting karakter worden toegevoegd
door te dubbelklikken op het symbool. Vingerzetting is normale tekst, die kan worden bewerkt zoals iedere andere tekst.
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Zie ook

Hoe positioneer ik de vingerzetting

Liedtekst

1. Voer eerst de noten in
2. Selecteer de eerste noot
3. Vanuit het hoofd menu, kies Voeg toe → Tekst → Liedtekst of type Ctrl+L (Mac: ⌘+L) en type de lettergreep voor de eerste

noot
4. Verder gaan met invoeren liedtekst:

Type Spatie aan het eind van het woord om verder te gaan naar de volgende noot
Type een koppelteken - aan het eind van een lettergreep om verder te gaan naar de volgende noot. De
lettergrepen zijn verbonden met een streepje
Shift+Spatie verplaatst naar de voorgaande lettergreep
↵ gaat naar de volgende liedtekst regel (Opmerking: gebruik niet de Enter toets van het numerieke
toetsenbord!)
Druk op Omhoog om terug te gaan naar de bovenste liedtekst regel

5. Druk op Esc om de liedtekst invoer te verlaten
6. Herhaal de stappen 2 en 3 hierboven om een tweede of volgende liedtekst regel in te voeren of dubbelklik op de

lettergreep van de eerst noot en ga verder bij stap 4.

Een aantal voorbeelden:

De laatste lettergreep van een woord kan worden verlengd met een onderliggende lijn Shift+_ om een melisme aan te
geven:

Ingevoerd met: soul, Shift+___ To Esc.

Om de niet laatste lettergrepen te verlengen kunnen gewoon extra koppeltekens - worden ingevoerd. Er zal er slechts één
zichtbaar zijn en de lettergreep zal rechts worden uitgelijnd op de eerste noot, gelijk aan hoe de laatste lettergreep wordt
genoteerd bij een melisme, zie hierboven.

Twee lettergrepen onder één noot kunnen worden samengevoegd met een elisie karakter, ook bekend als "liedtekst
boog" of "synalephe".
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In de tekstwerkbalk, klik op het toetsenbord icoon  of druk op F2 om het Speciale Karakters palet te openen. De
synalephe wordt evenredig gecentreerd en daarbij worden de lettergrepen met twee spaties gescheiden bij het invoeren
na de eerste lettergreep. Zie de "e ͜ A" tekst in het voorbeeld hierboven:

1. Type e
2. Voeg de synalephe met het F2 palet
3. Type Ctrl+Spatie (Mac: ⌥+Spatie)
4. Type A

Niet alle lettertype bevatten het synalephe karakter. Om er achter te komen welke lettertype op jouw computer de
synalephe ondersteuning, kijk naar "lettertype lijst " (zoek naar een lettertype dat een boog laat zien tussen de "e" en
"A" in plaats van een lege rechthoek). De uitlijning van het karakter varieert ook afhankelijk van het lettertype.

Speciale karakters

Liedtekst kan worden net zo worden bewerkt als normale tekst met uitzondering van een paar karakters: Als je een spatie,
koppelteken of liggend streepje aan een enkele lettergreep wil toevoegen gebruik dan de volgende snelkoppeling:

Ctrl+Spatie (Mac: ⌥+Space) voert een spatie ( ) in de liedtekst in
Ctrl+- (Mac: ⌥+-) of AltGr+- voert een koppelteken (-) in de liedtekst in
Ctrl+Shift+_ (Mac: ⌥+_) voert een liggend streepje (_) in de liedtekst in
Ctrl+↵ (Mac: ⌥+Return) of Enter (in het numerieke toetsenbord) voert een regel einde toe in de liedtekst

Individuele liedtekst regels aanpassen

De boven marge en lijnhoogte van alle liedtekst regels kan algemeen(globaal) worden aangepast vanuit het menu, Stijl →

Algemeen... → Pagina.

Echter de horizontale (en verticale) correctie instelling van individuele liedtekst regels kan als laatste nog worden
afgesteld door de met rechts te klikken op een woord in de gewenste regel en de beschikbare opties te gebruiken om alle
woorden die je wilt aanpassen te selecteren. En dan de correctie instelling aan te passen in het Instellingenoverzicht.

Als voorbeeld, om de horizontale positie van de liedtekst in één notenbalk van een bepaald systeem te wijzigen: rechts-
klik op een woord in die regel, kies Selecteer → Meer..., en selecteer de opties "Zelfde notenbalk" en "Zelfde systeem".
Gebruik nu de "horizontale correctie instelling" in het Instellingenoverzicht om de positie van de lijn af te regelen.

Zie ook

Tekst
Akkoordsymbool
Hoe Liedtekst toevoegen
Hoe Liedtekst verplaatsen
Hoe een blok tekst toevoegen aan een partituur

Externe links

Video zelfstudie: MuseScore in Minuten: Les 6 - Tekst, Liedtekst en Akkoorden

Repetitietekens

Repetitietekens worden tegenwoordig vaak gebruikt in partituren. Ze stellen de muzikanten in staat op hetzelfde punt te
beginnen zonder het aantal maten te tellen (repetitietekens kunnen ook naar maatnummer verwijzen) en zijn doorgaans
beter zichtbaar. Ze bestaan over het algemeen uit een aantal opeenvolgende letters of cijfers: A, B, C, of 1, 2, 3...

Hoe maak je ze

1. Klik op de eerste noot of rust aan het begin van een repetitie sectie, normaal gesproken in de bovenste notenbalk
2. Voeg toe → Tekst → Repetitieteken of Ctrl+M of Palet → Tekst → Repetitieteken
3. Type de tekst voor het Repetitieteken
4. Klik ergens anders

Eigenschappen
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Repetitietekens zijn standaard systeem tekst. Ze worden weergegeven in iedere partij en in de partituur.
Ze splitsen automatisch meermaatsrusten voor en na het repetitietekens.
Tekst stijl is specifiek en standaard (Repetitieteken) en ze staan standaard in een frame.

Automatisch opvolgend repetitieteken

Een repetitieteken dat wordt toegevoegd vanuit het tekst palet krijgt automatisch de eerst volgende letter of het eerst
volgende cijfer (afhankelijk van de gebruikt tekst).

Zoek naar een repetitieteken

Je kunt naar een bepaald repetitieteken verplaatsen door middel van Ctrl+F en de naam van het repetitieteken.

Zie ook

Tekst-eigenschappen

Opmaak

Opmaak en Lay-out

Je bent klaar met de partituur en nu wil je hem afdrukken. Echter je wilt het uiterlijk van het afdrukken verbeteren. Deze
pagina beschrijft de vele verschillende mogelijkheden hiervoor en hoe deze samenwerken.

Mogelijkheden om de lay-out te beïnvloeden

Opmaak → Pagina-instellingen...: Wijzig algemene instellingen zoals pagina-afmetingen, hoe groot de "Notenbalkafstand"
is (onder "Schaalfactor"), en hoe groot de pagina marges zijn. Notenbalkafstand wordt gebruikt in andere
instellingen (bijvoorbeeld: "5,0sp"), dus het aanpassen van de "Notenbalkafstand" zal de meeste andere instellingen
ook veranderen.
Opmaak → Vergroot uitrekking, Verminder uitrekking : Pas de ruimte aan - uitrekken of inkrimpen van de maten die je hebt
geselecteerd.
Stijl → Algemeen... → Pagina: Wijzig algemene instellingen die bepalen hoe dicht notenbalken en systemen op elkaar
staan, hoeveel marge er is voor de liedtekst en nog meer.
Stijl → Algemeen... → Systeem: Wijzig de Systeemhaakdikte en -afstand of de Accoladedikte en -afstand.
Bewerken → Gereedschappen → Voeg toe/verwijder regelafbrekingen... : Bepaal het aantal maten per systeem.
Stijl → Algemeen... → Partituur: Wijzig partituur details, zoals het gebruik van meermaatsrusten of verbergen van lege
notenbalken.
Stijl → Algemeen... → Maat: Stel de maat ruimte in, de muzieksleutel/toonsoort om het aantal maten per regel te
beïnvloeden.
Palet → Afbrekingen & afstandshouders: Breek een regel af bij een bepaalde maat, een pagina bij een bepaalde
regel of voeg ruimte toe tussen twee maten.
Stijl → Algemeen... → Groottes: Stel de proportionele maat in voor "kleine" en siernoten. Het is niet gebruikelijk om dit aan
te passen.

Opmerking: De meeste opties hier worden altijd toegepast op alle objecten waaraan gerefereerd wordt in de partituur.
Sommige opties kunnen ook individueel worden gedaan met Instellingenoverzicht en andere object eigenschappen voor
één of een selectie van meerdere objecten...

Opmaak → Pagina-instellingen...
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Je kunt eenheid voor het schalen en de marge instellen. Dit is de hoofdzakelijk manier om de opmaak te beïnvloeden
omdat veel dingen worden bepaald met die eenheid.
Het kan in mm of inch(es) worden opgeven.

Schaalfactor → Notenbalkafstand
De grootte van de afstand tussen 2 lijnen van een notenbalk. Omdat de noten in deze ruimte worden geplaatst, beïnvloed
dit ook de grootte van de noten. Omdat muziek proportioneel is afhankelijk van de noten, heeft dit ook effect op de
nootstokken, voortekens, muzieksleutels en nog veel meer. Het komt ook voor als sp in veel andere instellingen
(voorbeeld: systeem afstand "9,2sp"). Dus, als je de "Notenbalkafstand" parameter aanpast, worden veel andere
instellingen proportioneel gewijzigd. Vanwege deze reden wordt dit ook wel de "schaalfactor" genoemd.

Het is mogelijk dat het aanpassen van de schaal niet het aantal systemen per pagina veranderd vanwege de systeem
afstand instellingen. Om het effect te zien van het schalen zonder interferentie, zet de "max. systeem afstand" op een
hoge waarde.

Bedrukbaar gebied → Marges
Hier kunnen de paginamarges worden ingesteld. Om de pagina marge in de partituur op het scherm zichtbaar te maken
ga naar Weergave → Laat paginamarges zien en selecteer dit.
Opmerking: Je kunt verschillende marges hebben voor oneven en even pagina's. En je kunt een voorbeeld zien in de
navigator aan de rechterkant in het scherm.

Pagina-afmetingen
Je kunt het papier formaat dat gebruikt wordt selecteren met de naam (Letter, A4...) of door het invoeren van de hoogte
en breedte in mm of inch(es). De standaard is afhankelijk van je land.
Er zijn ook twee keuze opties beschikbaar: Liggend (indien niet gekozen dan wordt Staand gebruikt) en ook Dubbelzijdig
(zoals even en oneven). Merk op dat indien Dubbelzijdig niet is geselecteerd, dat je alleen de oneven paginamarges kunt
instellen maar die zijn dan van toepassing op alle pagina's.

Nummer van eerste pagina
Stelt het nummer in voor de eerste pagina van de partituur.
Pagina nummer lager dan 1 worden niet afgedrukt, dus een waarde van -1 zorgt dat de eerste en tweede pagina geen
pagina nummer hebben en dat de derde pagina begint met pagina nummer 1.

Pas toe op alle partijen
Tijdens het aanpassen van één partij uit de partituur (dat betekent dat je in een partij tab bent wanneer je dit dialoog opent
en niet in de partituur tab, dat de meeste linkse is) stelt deze knop je instaat de wijziging in één keer door te voeren in alle
partijen.

Opmaak → Vergroot uitrekking, Verminder uitrekking
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Om de horizontale ruimte tussen de noten in één of meerdere maten te vergroten of te verminderen kan je maten
selecteren die je wilt aanpassen en daarna het "Vergroot uitrekking" commando (}) gebruiken om deze breder te maken
zodat er minder op één regel staan of het "Verminder uitrekking" commando ({) om deze te verkleinen zodat er meer op
één regel passen. Je kunt deze eigenschap ook bereiken via Maat-eigenschappen, waar je het percentage voor de extra
of minder ruimte precies kunt instellen. Stel deze waarde in op 1 of gebruik het "Herstel afstanden" menu commando om
de maat grootte terug te zetten naar de standaard ruimte.

Stijl → Algemeen... → Partituur
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Hier kan je instellen dat rusten over meermaatrusten moeten worden gemaakt en dat lege notenbalken moeten worden
verborgen. Dit kan een lengte van een partituur enorm beïnvloeden. Je kunt ook het formaat en de minimale duur voor de
meermaatsrusten instellen.
"Verberg de instrumentnaam als er maar 1 instrument is" kan ook helpen om ruimte te besparen in de partijen (of solo
partituur), omdat de naam van het instrument dan niet aan het begin van de regel wordt geschreven.

Je kunt ook het gebruikte lettertype voor de muziektekst en -symbolen aanpassen. Er zijn 3 muziek lettertype beschikbaar
(voor de symbolen gebruikt in de notenbalken): Emmentaler, Gonville en Bravura. Er zijn 4 muziektekst lettertype
beschikbaar (voor gebruik als tekst zoals, dynamiek, tempo markering, etc.): Emmentaler, Gonville, Bravura en MuseJazz.
Emmentaler is de standaard waarde en Bravura is de meest complete.

(Om het lettertype en eigenschappen voor tekst aan te passen, zie Tekststijl)

Een aantal opties zijn specifiek voor oude muziek en swing afspelen.

Stijl → Algemeen... → Pagina
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Hier zijn veel opties zie van toepassing zijn op de lay-out. Selectie opties die mogelijk effect hebben op de lay-out zijn er
om het wel of niet weergeven van extra elementen (toonsoort , maatsoort en sleutels). Je kunt de aanwezigheid van deze
drie elementen bepalen voor ieder systeem.

Muziek interactie met Paginamarges

Bovenmarge muziek / Benedenmarge muziek: Marge tussen de muziek (respectievelijk de bovenste lijn van de
bovenste notenbalk van het bovenste systeem en de onderste lijn van de onderste notenbalk van het onderste
systeem) en de overeenkomstige marges ingesteld in →Lay-out → Pagina-instellingen.

Overige muziek afstand

Notenbalkafstand: Ruimte tussen notenbalken in een systeem.
Afstand dubbele notenbalk: Ruimte tussen de notenbalken van een instrument met meerdere notenbalken zoals een
piano of orgel.
Min. en Max. systeemafstand: Stelt je instaat de minimale en maximale afstand tussen de systemen in te stellen.
Indien beide gelijk zijn, dan wordt de systeemafstand daarop ingesteld.
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Liedtekst Marges

Boven- en Benedenmarge liedtekst: Afstand tussen de notenbalk en de liedtekst en tussen de liedtekst en de
volgende notenbalk.
Liedtekst regel hoogte: dit is een percentage van de liedtekst stijl.

Verticaal kader marge

Boven- en Benedenmarge verticaal kader: Ruimte boven en onder verticale kaders.

Drempelwaarde voor opvullen laatste systeem

Indien het laatste systeem langer is dan dit percentage van de pagina breedte, dan wordt deze opgerekt om die
ruimte op te vullen.

Stijl → Algemeen... → Koptekst, voettekst, nummers

126



Je kunt de details van de partituur meta label (zie Partituur informatie) of pagina nummers in de kopteskt of voettekst van
de partituur laten zijn. Om de koptekst of voettekst voor een partituur met gekoppelde partijen te maken, zorg dat de hoofd
partituur de actieve tab is. Om een kop- of voettekst te maken voor een individuele partij moet je zorgen dat deze partij de
actieve tab is.

Indien je met de muis over het koptekst of voettekst gebied gaat, dan wordt een lijst van macro's zichtbaar. Hiermee wordt
hun betekenis zichtbaar en ook worden de meta labels met hun informatie zichtbaar.

Er kunnen verschillende kop- en voetteksten worden gemaakt voor even en oneven pagina's, zo kun je bijvoorbeeld het
pagina nummer aan de rechterkant hebben voor oneven pagina's en aan de linkerkant voor even pagina's.

Je kunt ook instellen of maat nummers zichtbaar zijn en hoe vaak deze moet worden weergegeven.

Stijl → Algemeen... → Systeem

Systeemhaak en Accolade
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Zie Haken

Afstand
Je kunt de afstand tussen het systeem en de Haken en Accolade instellen
Dikte
Je kunt de dikte van de Haken en Accolade instellen

Stijl → Algemeen... → Maat

Hiermee stel je de ruimte en de marges in voor een maat. De ruimte die nodig is voor een maat en de minimum breedte
voor een maat zijn bepalend voor hoeveel maten er op een regel komen. Het wijziging van de overige instellingen is niet
gebruikelijk.

Stijl → Algemeen... → Maatstrepen
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Bepaal of er een maatstreep aan het begin van een notenbalk of meerdere notenbalk moet zijn.
Maatstreepgrootte aan notenbalk aanpassen beïnvloed alleen "kleine" notenbalken. Zie Maatstreep
aanpassingsmogelijkheden  (externe link) voor details.
Bepaal de proportionele dikte en afstand voor dubbele maatstrepen, inclusief herhalingstekens.

Palet → Afbrekingen & afstandshouders

Met het gebruik van de elementen in dit palet kun je bepalen waar een nieuwe pagina, regel of sectie begint en de afstand
vergroten tussen 2 individuele notenbalken of systemen met de tussenruimte. Sommige mensen doen dit eerst en andere
doen dit als laatste, na het aanpassen van de algemene instellingen.
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Om een nieuwe pagina te laten beginnen, sleep je het element naar de maat waar deze moet beginnen.
Om een nieuwe regel te beginnen, sleep je het element naar de laatste maat die je in de regel wilt hebben.
Indien je hetzelfde aantal maten wilt hebben voor meerdere systemen, selecteer deze dan eerst en gebruik Bewerken →

Gereedschappen → Voeg toe/verwijder regelafbrekingen... .
Indien er slechts een paar maten overblijven in een regel of pagina, reduceer dan de schaal of gebruik Opmaak → Vergroot

uitrekking, Verminder uitrekking.

Zie ook Afbrekingen en afstandshouders.

Stijl → Algemeen... → Noten

De afstand en dikte van objecten ten opzicht van noten (stok, hulplijn, voorteken, punt). Het aanpassen van deze
instellingen is niet gebruikelijk.

Stijl → Algemeen... → Muziekleutels
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Je kunt kiezen tussen een standaard TAB-sleutel en een Serif TAB-sleutel

Stijl → Algemeen... → Gebroken Akkoorden
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Afstand tot de noot, lijndikte en haaklengte kunnen hier worden ingesteld. Het is niet gebruikelijk deze aan te passen.

Stijl → Algemeen... → Waardestrepen
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Stijl → Algemeen... → Legatobogen/Overbindingen
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Stijl → Algemeen... → Groottes
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Stelt de proportionele grootte in voor "kleine" en siernoten en ook voor kleine notenbalken en muzieksleutels. Het is niet
gebruikelijk om dit aan te passen.

Stijl → Algemeen... → (De)Crescendo, Volta, Ottava
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De  knop zet de waarden terug naar de oorspronkelijk waarde.

Stijl → Algemeen... → Pedaal, trillen
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Stijl → Algemeen... → Akkoordsymbolen, fretborddiagrammen
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Stelt je instaat het uiterlijk en andere kenmerken aan te passen.
Zie ook Fretborddiagrammen

Stijl → Algemeen... → Basso continuo
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Opties voor basso continuo lettertype, stijl en uitlijning.
Zie ook Basso continuo

Stijl → Algemeen... → Articulaties, versieringen
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De positie van de articulaties in relatie tot de noten en notenbalk kan hier worden ingesteld.

Stijl → Algemeen... → Voortekens
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De optie voor de voortekens bij het wijzigen van de voortekens.

Stijl → Algemeen... → Antimetrische figuren
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Ruimte bewerken tussen individuele noten

Je kunt de ruimte tussen de noten in de partituur op de volgende manier aanpassen:

1. Dubbelklik op de nootkop van de noot die je wilt verplaatsen
2. Gebruik de pijltjes toetsen voor de richting (links of rechts) waar je de noot heen wilt plaatsen
3. Druk op de Esc toets om de bewerking af te ronden (dit zal de stok van de noot opnieuw tekenen)

Opmerking: het is mogelijk dat je de bogen moet verwijderen en opnieuw moet invoeren omdat deze soms niet correct
opnieuw worden aangemaakt.

Toepassen en OK knoppen

Met de Toepassen knop kun je de wijziging zien die je gemaakt heb zijn dat je het venster hoeft te sluiten. OK slaat de
wijzigingen die je gemaakt hebt op en sluit het venster.
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Pas toe op alle partijen

Indien je aanpassingen in de opmaak en lay-out aan het doen bent terwijl je in een partij tab bent, dan kun je de knop Pas

toe op alle partijen gebruiken om alle wijzigingen (zowel in Opmaak → Paginainstellingen... als in Stijl → Algemeen...) met één klik op
alle partijen toe te passen.

Opslaan en Laden Stijl

Je kunt een eigen stijl opslaan, zodat je deze gemakkelijk kunt gebruiken voor al je partituren.

1. Ga naar Stijl / Sla stijl op...
2. Selecteer een map en geeft het bestand een naam (de standaard map is de map die ingesteld is in jouw

voorkeuren)
Stijlen worden opgeslagen in *.mss formaat.

Opmerking: je kunt ook een voorkeur stijl instellen voor partituren en partijen in Voorkeuren partituur sectie

Zie ook

Een zelfstudie door Nicolas Froment
Een artikel door Marc Sabatella
Bijwerken vanaf MuseScore 1.x, lokale her-opmaak

Externe links

Een video zelfstudie, deel 1
Een video zelfstudie, deel 2

General style: Measure
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Style → General → Measure  allows you to adjust the distance between various items within measures.

Introduction

If you change a measure style property (see image above), MuseScore automatically adjusts the score to maintain the
correct spacing between notes and rests according to best music engraving practice. It will also correctly reposition any
elements attached to notes or rests, such as fingerings, dynamics, lines etc.

All settings related to measure width and note spacing are minimum values. Measures are automatically stretched, if
necessary, to maintain existing page margins.

All the properties listed below use the staff space (abbreviated to "sp") as the basic unit of measurement. See Page
settings: Scaling for more details.

Options

Minimum measure width
Sets the minimum horizontal length of measures. In measures containing very little content (e.g., a single whole note
or whole measure rest), the measure will only shrink as far as this minimum.

Spacing (1=tight)
Condenses or expands the space after notes or rests. This setting thus affects not only space between notes but
also between the last note and the ending barline. For the space between the beginning of the measure and the first
note or rest, see Barline to note distance (below).

Note: Changes to an individual measure's Stretch (under Layout → Increase Stretch, Decrease Stretch ) are calculated after,
and proportional to, the global Spacing setting.

Barline to note distance
Sets the distance between the barline which begins a measure and the first note or rest in that measure. For the
initial measures of systems, which start with clefs instead of barlines, use Clef/key right margin (below).

Barline to grace note distance
Sets the distance between a barline and a grace note that occurs before the first actual note in a measure
(independently of the "Barline to note distance" setting).

Barline to accidental distance
Sets the distance between a barline and an accidental placed before the first note in a measure (independently of
the "Barline to note distance" setting).
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Note to barline distance
(To be added).

Minimum note distance
Specifies the smallest amount of space MuseScore will allow after each note (depending on other factors, more
space may be allowed).

Clef left margin
Sets the distance between the very beginning of each line and the clef. (This option is rarely needed.)

Key signature left margin
Sets the distance between the key signature and the clef preceding it.

Time signature left margin
Sets the distance between the time signature and the key signature or clef preceding it.

Clef/key right margin
Sets the distance between the material at the beginning of each line (such as the clef and key signature) and the
first note or rest of the first measure on the line. (Note that, although not named in the option, if a time signature is
present, it is the element from which the spacing begins.)

Clef to barline distance
Sets the distance between a barline and a clef change preceding it.

Multi-measure rest margin
Sets the distance between a multi-measure rest and the barlines on either side.

Staff line thickness
Sets the thickness of the lines of the staff, which allows you to make the staff thicker and darker, if you need greater
visibility on your printouts.

Pagina-instellingen

Met Opmaak → Pagina-instellingen... (net zoals Stijl → Algemeen...) kun je de opmaak en afmetingen van de partituur aanpassen.
In het pagina-instellingen dialoog kunnen de algemene opmaak mogelijkheden worden aangepast, inclusief pagina-
afmetingen, bedrukbaar gebied en hoe groot de notenbalkafstand is (onder Schaalfactor). Pagina-instellingen is de
eerste optie die je gebruikt om de afmetingen van de bladmuziek te vergroten of te verkleinen. 

Pagina-afmetingen

Hier kun je het papier formaat selecteren, door de naam de te kiezen (bv. A4 of Letter) of door de hoogte en breedte in
mm of inches op te geven (gebruik de keuze mogelijk om te bepalen welke maateenheid er wordt gebruikt). De initiële
standaard pagina-afmeting is afhankelijk van de regio instellingen — in Amerika is Letter formaat papier de standaard.
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Je kunt ook bepalen om de muziek Liggend weer te geven (de-selecteer de optie om Rechtop te kiezen) en je kunt
gebruik maken van de Dubbelzijdig optie (bv. in boek formaat waarbij de linker- en rechtermarges worden gespiegeld in
even en oneven pagina's —zie hieronder).

Pagina marges

Met de Even pagina marges en Oneven pagina marges is het mogelijk om het bedrukbaar gebied voor de pagina's in te
stellen. Naast het wijzigen van de marges rondom de muziek op de pagina, worden andere instellingen (zoals de positie
van kop- en voettekst) relatief bepaald ten opzichte van deze marges.

Indien de "Dubbelzijdig" optie bij "Pagina-afmetingen" is geselecteerd, dan kun je de marges verschillend instellen voor
oneven en even pagina's zodat deze gespiegeld worden. Anders kan er alleen één set van marges worden aangepast en
zijn deze van toepassing op alle pagina's.

Om de pagina marges in de partituur op het scherm weer te geven, ga naar

To display page margins in your score on screen (though not in print), go to Weergave → Laat paginamarges zien.

Notenbalkafstand/schalen

Notenbalkafstand (sp) is de afstand tussen twee lijnen in een notenbalk (ofwel een kwart van een volledige vijf-lijnen
notenbalk). Omdat de noten in deze ruimte worden geplaatst, bepaalt dit ook de grootte van de nootkoppen en, daar uit
volgend, ook de grootte van de nootstokken, voortekens, sleutels, etc. Daarnaast zijn veel opmaak mogelijkheden
vastgelegd in sp als maateenheid (bv. 5,0sp). Omdat het wijzigen van de notenbalkafstand een proportioneel effect heeft
op bijna alles, wordt die ook wel schalen genoemd.

Opmerking: Het aanpassen van de schaal zal niet altijd het aantal systemen per pagina veranderen, omdat de
systeemafstand verschillend kan zijn door de instellingen "Minimum systeemafstand" en "Maximum systeemafstand" (zie
Stijl → Algemeen... → Pagina).

Overige

Eerste pagina nummer stel het nummer van de eerste pagina in voor de partituur. Paginanummer onder 1 worden niet
afgedrukt—bv. door het instellen van het eerste pagina nummer op -1 wordt op de eerste en tweede pagina geen
paginanummer weergegeven en zal paginanummer 1 beginnen op de derde pagina.

De Toepassen op alle partijen knop is beschikbaar indien je de instellingen voor een partij in plaats van de partituur (zie
Partijen maken) aanpast. Indien je de pagina-instelling voor één partij aanpast en wilt dat de overige partijen dezelfde
instellingen gebruiken dan kan deze knop de wijziging in alle partijen in één keer uitvoeren.

Afbrekingen en afstandshouders

Pagina-einde, regelafbreking (systeem afbreking) of sectie-einde worden toegepast door het overeenkomstige symbool
vanuit het afbrekingen palet te slepen naar een lege ruimte van een maat of op een horizontaal kader in de partituur. De
onderbreking wordt gemaakt na de gemarkeerde maat of kader. De blauwe onderbreking symbolen zijn zichtbaar op het
scherm maar worden niet afgedrukt.

Systeem onderbreking in een maat zijn soms nodig (met name in strofische gezangen of liederen). Als voorbeeld, de
maat is verdeeld in 4 tellen en nu wil je 3 tellen in één system en 1 tel opmaat in het volgende systeem. In dat geval moet
je twee maten maken met een verkorte duur. Voor details zie Maat bewerkingen: Splitsen en samenvoegen.

Afstandshouders worden gebruikt om de ruimte tussen twee aangrenzende notenbalken of systemen te vergroten.
Sleep een afstandshouder symbool naar een maat boven de ruimte die meer verticale ruimte nodig heeft. Dubbelklik op
het symbool en verplaats de handgrepen met de muis om de hoogte van de ruimte aan te passen.

Indien de in de gehele partituur de ruimte tussen de notenbalken wilt aanpassen dan gebruik je de stijl instellingen.
Tussenruimte elementen zijn bedoeld voor lokale aanpassingen.

Toevoegen van een afbrekingen of afstandshouders
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Om een afbreking of afstandshouder toe te voegen:

1. Gebruik het Afbrekingen & afstandshouders palet (zie hierboven)
2. Sleep hier vandaan de gewenste afbreking of tussenruimte
3. Plaats de afbreking of afstandshouder op de maat die je wilt beïnvloeden

Verwijder een afbreking of afstandshouder

Er zijn momenten dat je een afbreking of afstandshouder wilt verwijderen. Dit doe je als volgt:

1. Klik één keer op de afbreking of afstandshouder (het wordt hierbij donkerder blauw om aan te geven dat het
geselecteerd is)

2. Druk op de Delete toets

Sectie-einde

Een sectie-einde kan bijvoorbeeld worden gebruikt om twee delen in de partituur van elkaar te scheiden.
Het kan worden gebruikt samen met een regelafbreking of pagina-einde. Het stelt ook het maatnummer op 1 in. Dus, net
zoals bij de eerste maat van de partituur, zal er geen nummer verschijnen bij de eerste maat na de onderbreking, indien zo
geconfigureerd (zie Maat-eigenschappen).

Als je de maat- of toonsoort wijzigt aan het begin van een nieuwe sectie dan worden er geen hulp tekens aan het einde
van de laatste maat voor de wijziging geplaats. Zie onderstaand voorbeeld:

Zie ook

Voeg toe/Verwijder Regelafbrekingen gereedschap

Kaders

Kaders geven je de mogelijkheid lege ruimte te maken buiten de gewone maten. Ze kunnen ook tekst of afbeeldingen
bevatten. MuseScore kent drie type kaders: Horizontaal, Verticaal en Tekst.

Horizontaal kader

Horizontale kaders worden gebruikt om een onderbreking te maken in een systeem. De breedte is instelbaar en de hoogte
is gelijk aan de hoogte van een systeem. Voorbeelden van het gebruik zijn:

Het maken van een coda, met een aanpasbare open ruimte voor het te scheiden van de rest van de partituur (zoals
in bovenstaande voorbeeld).
Het maken van een verschuiving aan het begin van de partituur waarbij er geen notenbalk naam is die hetzelfde
doet.
Het maken van een aanpasbare rechter marge aan het eind van de partituur.
Het maken van ruimte voor tekst of een afbeelding.
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Een horizontaal kader kan ook worden ingevoegd in een Verticaal kader of Tekstkader door met rechts te klikken op het
kader en te kiezen voor Voeg toe → Voeg horizontaal kader in. Het wordt automatisch links uitgelijnd en vult het gehele verticale
kader. Door te dubbelklikken op het kader kan de breedte worden aangepast met de bewerk handgreep. Om het rechts uit
te lijnen maak je het kader eerste kleiner en daarna kan het met de muis worden versleept in het verticale kader. Met een
enkele klik op het kader kun je verschillende parameters aanpassen in het Instellingenoverzicht:

Vrije ruimte links: ?
Vrije ruimte rechts: ?
Breedte: Hiermee wordt de breedte van het kader ingesteld.

Verticaal kader

Met een verticaal kader kan ruimte tussen, voor of na systemen worden gemaakt. De hoogte kan worden aangepast en
de breedte is gelijk aan die van een systeem. Een verticaal kader wordt automatisch gemaakt aan het begin van de
partituur - hierin worden de titel, ondertitel, componist, liedtekstschrijver, etc. weergegeven - wanneer je deze informatie
invult in de velden die worden getoond in de wizard Maak een nieuwe partituur.

Selecteer het kader om verschillende parameters in de Instellingen te bewerken:

Vrije ruimte boven: Past de ruimte aan tussen het kader en de elementen er boven (negatieve waarden worden
momenteel niet ondersteund).
Vrije ruimte beneden: Past de ruimte aan tussen het kader en de elementen er onder (negatieve waarden kunnen
worden gebruikt).
Hoogte: Hiermee stel je de hoogte van het kader in.
Linkermarge: Verplaatst links uitgelijnde tekst objecten naar rechts.
Rechtermarge: Verplaatst rechts uitgelijnde tekst objecten naar links.
Bovenmarge: Verplaatst boven uitgelijnde tekst objecten naar beneden.
Benedenmarge: Verplaatst onder uitgelijnde tekst objecten naar boven.

Door te dubbelklikken op het verticale kader kun je de hoogte aanpassen met de bewerk handgreep.
Dit is handig bij het aanpassen van de hoogte tussen speciale systemen.

Door met rechts te klikken op het kader komt er een menu te voorschijn dat je kunt gebruiken om een object in het kader
te maken; dit kan tekst (Tekst, Titel, Ondertitel, Componist, Liedtekstschrijver en Partijnaam), een afbeelding of een
horizontaal kader. Je kunt zoveel objecten in een kader maken als je wilt. Ieder object kan worden verplaatst en
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vormgegeven onafhankelijk van de andere. Tekst objecten kunnen binnen of buiten de kader grenzen worden geplaatst.

Ieder tekst object dat in een kader wordt gemaakt kan worden verplaatst door er met links op te klikken en dan het object
te slepen (gebruik de Ctrl of Shift toetsen om de beweging in alleen een horizontale of een verticale richting te beperken).
Je kunt ook klikken op een tekst object en aanpassingen maken aan de kleur, zichtbaarheid, horizontale verschuiving en
verticale correctie instelling in het Instellingenoverzicht. Door met rechts te klikken op een tekst object verschijnt er een
menu waarmee een unieke stijl kan worden toegepast op de tekst ("Tekst-eigenschappen") of de algemene stijl voor
gelijksoortige objecten ("Tekststijl") kan worden aangepast.

Tekstkader

Een tekstkader lijkt op een verticaal kader en gebruikt sommige van die functies maar is speciaal bedoeld voor de gebruik
om snel en eenvoudig tekst te kunnen invoeren: zodra het kader is gemaakt kan de gebruiker meteen beginnen met het
typen van de tekst. In tegenstelling tot een verticaal kader is er slechts één tekst object toegestaan in het kader, de hoogte
wijzigt automatisch op basis van de inhoud en er is geen handgreep om de hoogte aan te passen. Door het selecteren
van het kader (niet het tekst object) kun je de verschillende parameters in de Instellingen aanpassen:

Vrije ruijmte boven: Past de ruimte aan tussen het kader en de elementen er boven (negatieve waarden worden
momenteel niet ondersteund).
Vrije ruimte beneden: Past de ruimte aan tussen het kader en de elementen er onder (negatieve waarden kunnen
worden gebruikt).
Linkermarge: Verplaatst links uitgelijnde tekst objecten naar rechts.
Rechtermarge: Verplaatst rechts uitgelijnde tekst objecten naar links.
Bovenmarge: Verplaatst boven uitgelijnde tekst objecten naar beneden.
Benedenmarge: Verplaatst onder uitgelijnde tekst objecten naar boven.

Je kunt ook op het tekst object klikken een aanpassingen maken aan de kleur, zichtbaarheid, horizontale correctie
instelling en verticale correctie instelling in het Instellingenoverzicht.

Een kader maken

Kaders worden ingevoegd of toegevoegd aan een partituur vanuit het Voeg toe menu.

Om een kader in te voegen, selecteer een maat en maak je keuze uit Voeg toe → Kaders menu.
Om een kader toe te voegen aan het einde van de partituur hoeft er geen maat te worden geselecteerd. Kies het
gewenste kader om toe te voegen uit het Voeg toe → Kaders menu.

Een kader verwijderen

Selecteer het kader en druk op Del.

Zie ook

Hoe voeg ik een blok tekst toe aan een partituur
Tekst-eigenschappen—plaats een zichtbaar kader (rand) om de tekst

Externe links

Pagina Opmaak in MuseScore 1.1 - 1. Kaders, Tekst & Regeleinden  [video]

Afbeeldingen

Je kunt gebruik maken van Afbeeldingen om je partituur te illustreren of om symbolen toe te voegen die niet in de
standaard paletten beschikbaar zijn.

Om een afbeelding toe te voegen sleep je de afbeelding naar een kader of op een noot of rust in de partituur. Als
alternatief kun je met rechts klikken op het kader en kiezen voor Voeg toe → Afbeelding, hierna selecteer je naar het bestand
dat je wilt gebruiken.

MuseScore ondersteund de volgende afbeeldingsbestandsformaten:

PNG (*.png)
JPEG files (*.jpg en *.jpeg)
SVG files (*.svg) (MuseScore ondersteund geen SVG schaduw, vervaging, uitknippen of masker.)
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Zie ook

Afbeeldingsopname
Maak een Ossia door het maken van een afbeelding

Afbeeldingsopname

Met het maken van een opname kunnen je delen van de partituur als afbeelding opslaan. Dit kan worden aan/uit gezet

met de Afbeeldingsopname knop .

In de afbeeldingsopnamemodus kun je een rechthoek maken door het indrukken van de Shift en dan met de muis over het
gebied te slepen dat je wilt selecteren waarbij je de linker muistoets ingedrukt houdt.

De selectie rechthoek kan worden verplaatst met de muis of worden aangepast door het verplaatst van de handgrepen.

Zodra je de rechthoek hebt gemaakt om het deel van de partituur waarvan je een afbeelding wilt maken, dan klik je met
rechts op de rechthoek om het menu weer te geven:

Na het opslaan als PNG bestand krijg je het volgende:

Indien je het gedeelte in "Afdrukmodus" opslaat, ziet het eruit zoals het gedeelte uit de partituur zou worden afgedrukt. In
"Schermafbeeldingmodus" dan ziet het er uit zoals op het scherm (inclusief regel einden, etc.) die niet worden afgedrukt
(100dpi voorbeeld):
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Zie ook

Afbeeldingen
Maak een Ossia door het maken van een afbeelding

Elementen uitlijnen

Wanneer een element wordt geselecteerd en versleept dan kan door het indrukken van Shift of Ctrl het element in één
richting worden verplaatst. Het indrukken van Ctrl zorgt dat het element alleen horizontaal kan worden verplaatst, terwijl
Shift het verticaal verplaatst.

In het Instellingenoverzicht kun je met de 'Uitlijnen op het raster' knoppen het uitlijnen uit- en aanzetten. Dit zorgt dat de
verplaatsing volgens een bepaalde ruimte afstand gaat (dezelfde stappen als je de scrol knop zou gebruiken in de
Instellingen) of juist niet.

Geavanceerde onderwerpen

Album

Met Album-beheer kun je een lijst maken van meerdere partituren en deze opslaan als een album bestand ("*.album"), je
kunt alle partituren met één afdruktaak afdrukken met consistente pagina nummers of zelfs de partituren samenvoegen in
een enkele partituur. Dit is ideaal bij het maken van een lesboek of voor het combineren van meerdere delen van een
muziekstuk.

Om Album-beheer te openen ga je naar Bestand → Album…

Een Album Maken

1. Om een nieuw album te maken klik je op knop Nieuw. Vul de titel voor het album in bij "Albumnaam" dat bovenaan
staat.

2. Om de partituren toe te voegen aan het album klik je op Voeg partituur toe. Een bestand selectie dialoog komt nu te
voorschijn en je kunt één of meerdere partituren vanuit je bestandssysteem kiezen. Klik vervolgens op Openen.

3. De partituren worden weergegeven in een lijst in Album-beheer. Je kunt de volgorde veranderen door de partituur te
selecteren in de lijst en dan gebruik te maken van de Omhoog of Omlaag knop.
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Laad Album

Indien je reeds eerder een album hebt aangemaakt dan kun je deze openen via Album-beheer door te klikken op de Laad

knop. Een bestand selectie dialoog wordt getoond waarmee je het .album bestand kunt selecteren vanuit je
bestandssysteem.

Album afdrukken

Om een album af te drukken alsof het één document is klik je op Druk album af. De partituren die geladen zijn in Album-
beheer worden afgedrukt in de volgorde zoals ze in de lijst staan met de juiste pagina nummers, hierbij wordt de pagina
nummer aanpassing zoals ingesteld in Opmaak → Pagina-instellingen... → Nummer van eerste pagina  voor alle partituren
genegeerd behalve voor de eerste. Omdat het album wordt afgedrukt in één afdruktaak werkt ook het dubbelzijdig
afdrukken zoals verwacht.

Partituren Samenvoegen

Om meerdere partituren samen te voegen in een enkel .mscz bestand klik je op Voeg partituren samen. De partituren worden
in de gekozen volgorde samengevoegd tot één partituur. Een regelafbreking en sectie-einde wordt toegevoegd een de
laatste maat of kader van een partituur in het samengevoegde bestand.

Alle partituren moeten het zelfde aantal partijen en notenbalken hebben om dit correct te laten werken, bij voorkeur met
dezelfde instrumenten in dezelfde volgorde. Indien de partituren hetzelfde aantal instrumenten heeft maar niet dezelfde of
niet in dezelfde volgorde, dan worden de instrument namen van de eerste partituur gebruikt om deze in de overige
partituren te overschrijven. Indien sommige partijen minder instrumenten hebben dan de eerste partituur dan worden er
lege systemen toegevoegd aan deze partijen. Iedere partij of notenbalk die niet beschikbaar is in de eerste partituur
gaat verloren bij het samenvoegen.

Album Opslaan

Bij het klikken op de Sluiten knop wordt je gevraagd om het album als een .album bestand op te slaan. Dit bestand is niet
hetzelfde als een samengevoegd bestand. Het bestaat enkel uit een lijst van partituren in gewenste volgorde. Album
bestanden kunnen worden geladen met Album-beheer zoals eerder beschreven.

Basso continuo (becijferde bas)

Basso continuo is een geïmproviseerd en aanvullend spel inclusief basis van de harmonie en de uitgeschreven baslijn.
Harmonieën worden weergegeven door middel van een cijfersysteem onder de basnoten. Dit wordt ook wel becijferde bas
genoemd.

Toevoegen van een nieuwe basso continuo indicatie

1. Selecteer de noot waarop de basso continuo van toepassing is
2. Druk op de Basso continuo sneltoets (standaard Ctrl+G; dit kan worden aangepast in Voorkeuren)
3. Voer de tekst in de 'blauwe bewerkingsrechthoek' in (zie hieronder)
4. Druk op Spatie om verder te gaan naar de volgende noot voor het invoeren van de volgende basso continuo indicatie

(of klik buiten de bewerkingsrechthoek om het te verlaten).

Met de Spatie gaat de bewerker verder naar de volgende noot of rust in de notenbalk waaraan de basso continuo tekst
wordt toegevoegd. Om naar een plaatst hier tussen te gaan of om de duur van de basso continuo groep te verlengen, zie
hier Groep lengte.
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Tab verplaatst de bewerkingsrechthoek naar het begin van de volgende maat.

Shift+Spatie verplaatst de bewerkingsrechthoek naar de vorige noot of rust in de notenbalk.

Shift+Tab verplaatst de bewerkingsrechthoek naar het begin van de vorige maat.

Tekst opmaak

Getallen

Getallen worden direct ingevoerd. Een groep van getallen boven elkaar gestapeld worden ook als enkele tekst ingevoerd
en met Enter op elkaar gestapeld:

Voortekens

Voortekens kunnen worden ingevoerd met de toetsen:

Invoeren: Type:

dubbele mol bb

mol b

hersteld h

kruis #

dubbel kruis ##

Deze karakters worden automatisch omgezet in de juiste tekens zodra je de bewerker verlaat. Voortekens kunnen voor of
na een getal (en natuurlijk, in plaats van een getal, voor een aangepast terts), in overeenstemming met de gewenste stijl.
Beide stijlen worden netjes uitgelijnd met het voorteken 'hangend' aan de linker- of rechterzijde.

Gecombineerde figuren

Gestreepte getallen of getallen met een kruis kunnen worden ingevoerd door het toevoegen van een \, / of + na het getal
(gecombineerde toevoegingen). De juiste gecombineerde vorm wordt vervangen bij het verlaten van de bewerker:

Het ingebouwde lettertype kan overweg met de equivalente combinaties, waarbij de meest gebruikelijk vervangen wordt
toegepast:

1+, 2+, 3+, 4+ wordt  (of )
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en 5\, 6\, 7\, 8\, 9\ wordt  (of )

Onthoud dat een / alleen gecombineerd kan worden met een 5, andere 'gestreepte' figuren worden weergegeven met een
vraagteken.

+ kan ook worden gebruikt voor een getal. In dit geval wordt het niet gecombineerd maar wordt het netjes uitgelijnd ('+'
hangt aan de linkerzijde).

Haakjes

Haakjes om te openen en om te sluiten, zowel ronde '(', ')' als rechte '[', ']' kunnen worden ingevoegd voor en na de
voortekens, voor en na een getal en voor en na een voortzettingslijn. De toegevoegde haakjes zullen de juiste uitlijnen
van het hoofd karakter niet verstoren.

Opmerkingen:

De bewerker controleert niet of de haakjes (open en sluit, rond of recht) in 'balans' zijn.
Meerdere haakjes in een regel zijn syntactisch niet juist en voorkomen correcte herkenning van de ingevoerde tekst.
Een haakje tussen een getal en een gecombineerde toevoeging ('+', '\', '/') wordt geaccepteerd maar voorkomt het
combineren van de vormen.

Voortzettingslijnen

Voortzettingslijnen worden ingevoerd door het toevoegen van een '_' (liggend streepje) aan het eind van de lijn. Ieder
getal in een groep kan zijn eigen voortzettingslijn hebben:

Voortzettingslijnen worden getekend voor de gehele duur van de basso continuo groep (maar gaan niet verder in de
volgende systemen, hetzelfde als bij liedtekst voorzettingslijnen).

'Verlengde' voortzettingslijnen

In sommige gevallen is het nodig dat een voortzettingslijn wordt verbonden met een voortzettingslijn in een volgende
groep, wanneer een deel van een akkoord bewaard moet blijven over de twee groepen. Een voorbeeld (beide door J.
Boismortier, Pièces de viole, op. 31, Paris 1730):

In het eerste geval heeft iedere groep zijn eigen voorzettingslijn, in het tweede geval zijn de voorzettingslijnen van de
eerste groep door gezet in de tweede groep.

Dit kan worden bereikt door het invoeren van meerdere (twee of meer) liggende streepjes "__" aan het eind van de tekst
regel van de eerste groep.

Duur

Iedere basso continuo groep heeft een bepaalde duur welke wordt aangegeven met een licht grijze lijn boven de groep.
Deze lijn is natuurlijk alleen ter informatie en wordt niet afgedrukt of geëxporteerd naar PDF.

In beginsel heeft een groep dezelfde duur als de noot waar deze aan gekoppeld is. Een afwijkende duur kan nodig zijn
voor verschillende groepen onder een enkele noot of om een groep te verlengen over een aantal noten heen.

Om dit te bereiken kunnen de volgende toets combinaties worden gebruikt, waarbij iedere combinatie

vooruit gaat in de bewerkingsrechthoek met de aangegeven duur
EN
stelt de duur van de vorige groep in tot aan de nieuwe positie in de bewerkingsrechthoek.
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Het herhaaldelijk indrukken van deze combinaties zonder dat daar bij basso continuo tekst wordt ingevoerd verlengt de
duur van de vorige groep.

Type: Je krijgt:

Ctrl+1 1/64

Ctrl+2 1/32

Ctrl+3 1/16

Ctrl+4 1/8 Ctrl+5 | 1/4

Ctrl+6
halve noot Ctrl+7 | hele noot Ctrl+8 | 2 hele
noten

(De getallen zijn dezelfde als die worden gebruikt bij het instellen van de duur van de noten)

Het exact instellen van de duur van de basso continuo groep is alleen in twee gevallen verplicht:

1. Wanneer meerdere groepen onder een enkele notenbalk staan (er is geen andere manier).
2. Wanneer voortzettingslijnen worden gebruikt, omdat de lengte van de lijn afhankelijk is van de duur van de groep.

Echter het is een goed gebruik om altijd de duur van de gewenste waarde in te stellen voor het mogelijk gebruik van plug-
ins en MusicXML.

Bewerken bestaande basso continuo figuren

Om een basso continuo figuur te bewerken dat reeds is ingevoerd kun je het volgende doen:

Selecteer het of de noot waar deze aan toebehoort en toets dezelfde Basso continuo sneltoets in die wordt gebruikt
om een nieuwe te maken
of
Dubbelklik op de basso continuo

De gebruikelijke tekst bewerkingsrechthoek komt dan te voorschijn en de tekst wordt omgezet in normale tekens (('b', '#'
en 'h' voor de voortekens, gescheiden combinatie vormen, liggende streepkes, etc.) om het bewerken te vereenvoudigen.

Zodra je klaar bent druk je op Spatie om naar de volgende noot te gaan of klik je buiten de tekstbewerkingsrechthoek, net
zoals bij het maken van nieuwe symbolen.

Stijl

Met het Stijl → Algemeen... menu commando kan de configuratie van de basso continuo symbolen worden ingesteld. Kies
"Basso continuo" in de lijst aan de linkerzijde om het volgende dialoog zichtbaar te maken:
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Het Lettertype bevat alle lettertype die beschikbaar zijn voor de basso continuo symbolen. Een standaard installatie
bevat alleen het lettertype "MuseScore Figured Bass". Dit is ook het standaard lettertype.

De Grootte is de grootte van het lettertype (in punten). Dit is gekoppeld aan de notenbalkafstand ruimte. Voor de
standaard spatie wordt de ingevoerde waarde gebruikt. Voor hogere of lagere spatie waarden wordt de grootte
proportioneel vergroot of verkleind.

Verticale positie is de afstand (in spaties) van de bovenkant van de notenbalk tot aan de bovenmarge van de basso
continuo tekst. Negatieve waarde gaan omhoog (basso continuo tekst boven de notenbalk) en positieve waar gaan
omlaag (basso continuo tekst onder de notenbalk, een waarde groter dan 4 is nodig om 'over' de notenbalk heen te
stappen).

Regelhoogte is de afstand tussen de basis lijn van iedere basso continuo regel, het is uitgedrukt in een percentage van
de lettertype grootte.

De volgende afbeelding laat ieder parameter zien:
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De Bovenaan / Beneden keuze rondjes bepalen de verticale uitlijning. Met Bovenaan wordt de bovenste lijn van iedere
groep uitgelijnd met de verticale hoofd positie en de groep 'hangt' daar aan (dit is de normaal gebruikt notatie voor basso
en is ook de standaard). Met Beneden wordt de onderste lijn van iedere groep uitgelijnd met de verticale hoofd positie en
de groep 'zit' hier op (dit wordt weleens gebruikt bij sommige harmonische analyse notaties):

De Modern / Historisch keuze rondjes selecteren de typografische stijl van de gecombineerde vormen. Het verschil
tussen de twee stijlen is hieronder zichtbaar:

Juiste syntaxis

Om de relevante vervangen en combinatie van vormen te laten plaats vinden en voor het juist uitlijnen verwacht het basso
continuo element dat de tekst wordt ingevoerd aan de hand van een aantal regels (die in ieder geval de regels zijn voor
een syntactisch juiste basso continuo indicatie):

Er kan maar één voorteken (voor of na) of één combinatie toevoeging per figuur zijn.
Een voorteken en een combinatie figuur kunnen niet tegelijk worden gebruikt.
Er kan een voorteken worden gebruikt zonder getal, maar geen combinatie figuur zonder getal.
Ieder andere karakters dat hierboven niet is vermeld wordt niet verwacht.

Als de ingevoerde tekst niet voldoet aan deze regels, dan wordt hij niet verwerkt. Het wordt opgeslagen en weergegeven
zoals het is, zonder enige opmaak.

Overzicht van toetsen

Type: Je krijgt:

Ctrl+G Voegt een nieuwe basso continuo groep toe aan de geselecteerde noot.

Spatie Gaat verder naar de volgende noot.

Shift+Spatie Gaat terug naar de vorige noot.

Tab Gaat naar de volgende maat.

Shift+Tab Gaat naar de vorige maat.

Ctrl+1 Gaat 1/64 vooruit, stelt de duur van de vorige groep in.

Ctrl+2 Gaat1/32 vooruit, stelt de duur van de vorige groep in.

Ctrl+3 Gaat 1/16 vooruit, stelt de duur van de vorige groep in.

Ctrl+4 Gaat 1/8 vooruit, stelt de duur van de vorige groep in.

Ctrl+5 Gaat 1/4 vooruit, stelt de duur van de vorige groep in.

Ctrl+6 Gaat een halve noot vooruit, stelt de duur van de vorige groep in.

Ctrl+7 Gaat een hele noot vooruit, stelt de duur van de vorige groep in.

Ctrl+8 Gaat twee hele noten vooruit, stelt de duur van de vorige groep in.

Voert een spatie in, handig wanneer de basso op de tweede lijn staat (bv. 5 4 ->
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Ctrl+Spatie 3).

B B Voert een dubbele mol in.

B Voert een mol in.

H Voert een herstellingsteken in.

# Voert een kruis in.

# # Voert een dubbel kruis in.

_ Voert een voortzettingslijn in.

_ _ Verlengt een voortzettingslijn.

Type: Je krijgt:

Bestandsformaten

MuseScore ondersteunt een breed scala aan bestandsformaten waardoor je de partituren kunt delen en publiceren in het
formaat dat het beste aan de behoeften voldoet.
Je kunt bestanden importeren via Bestand → Open... en exporteren via Bestand → Exporteer....
Aanvullend op de formaten hieronder beschreven, kunt je de partituren opslaan en delen op de website:
MuseScore.com  via Bestand → Sla online op.... (Zie Partituren online delen).

MuseScore eigen formaten

Dit zijn de formaten die gebruikt worden in het dialoogvenster als je kiest voor:
Bestand → Sla op en Bestand → Sla op als...

of als je de knop  gebruikt of de Sneltoets (Ctrl+S)

MuseScore formaat (*.mscz)

MSCZ is het standaard MuseScore bestandsformaat en is aanbevolen voor de meeste toepassingen.

Een partituur opgeslagen in deze indeling neemt maar weinig schijfruimte in beslag met behoud van de noodzakelijke
informatie.
Deze indeling is een ZIP-gecomprimeerde versie van .mscx bestanden en bevat alle afbeeldingen.

Ongecomprimeerd MuseScore formaat (*.mscx)

MSCX is de ongecomprimeerde versie van het MuseScore bestandsformaat.

Een partituur opgeslagen in deze indeling behoudt alle informatie behalve afbeeldingen.
Deze indeling wordt aanbevolen voor het handmatig kunnen bewerken (met behulp van een teksteditor) van het bestands.
Vorige versies van MuseScore gebruikten de extensie *.msc

Deze kwam echter in conflict met een bestandsextensie van Microsoft Windows en werd door sommige email providers
geblokkeerd. Het is daarom vervangen door de nieuwere MSCX bestandsextensie.

De MSCZ en MSCX formaten van MuseScore 2.0 kunnen niet gelezen worden door MuseScore 1.3 of ouder. Gebruik
hiervoor →XML of →MXL

Opmerking in verband met lettertypen: MuseScore slaat de lettertypes niet op in het bestand, behalve de FreeSerif,
FreeSerifBold, FreeSerifItalic, FreeSerifBoldItalic en FreeSans families.

Als je een MuseScore bestand wilt delen, kies dan één van de genoemde lettertypes of een lettertype dat bij de andere
personen eveneens geïnstalleerd is. Als een systeem een bepaald lettertype niet bezit dan wordt teruggevallen op een
vervangend lettertype , maar dat kan het uiterlijk van de partituur beschadigen.

MuseScore back-up bestanden

MuseScore back-up bestand(*.mscz, of *.mscx,)

Back-up bestanden worden automatisch gecreëerd en opgeslagen in dezelfde map als het gewone bestand.
Dezelfde naam als het gewone bestand, wordt voorafgegaan door een punt (.) en eindigt met een komma (,).
Bijvoorbeeld: het gewone bestand heeft de naam "Titel.mscz", het backup bestand zal de naam ".Titel.mscz," krijgen.

De back-up kopie bevat de laatst opgeslagen versie van het MuseScore bestand en kan belangrijk zijn als het originele
bestand corrupt is (geworden) of als je zoekt naar een eerdere versie van het bestand.
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Om een MuseScore back-up bestand te openen, moet je de punt vooraan en de komma achteraan in de naam
verwijderen. Omdat het in dezelfde map is opgeslagen als het origineel, kan het zijn dat je de naam moet aanpassen,
bijvoorbeeld "Titel-backup1.mscz"

Om de MuseScore back-up bestanden te kunnen zien op het scherm moet je waarschijnlijk de systeem-instellingen
aanpassen: "Toon verborgen bestanden"
Zie ook Hoe een back-up bestand terugzetten? (MuseScore 2.x) .

Bekijken en afdrukken (alleen exporteren)

PDF (*.pdf)

Portable Document Format (PDF) is ideaal om de muziek te delen met anderen die niets aan de inhoud hoeven te
wijzigen. De meeste gebruikers hebben een "PDF lezer" op hun computer. Het is dus niet nodig om extra software te
installeren om een PDF-document te kunnen lezen.

PNG (*.png)

Portable Network Graphics (PNG) is een bitmap-afbeelding formaat, het wordt goed ondersteund door de software op
Windows, Mac OS en Linux.
Dit formaat van afbeeldingen is populair op het web.
Als de partituur meer dan een pagina bevat, wordt een bestand gemaakt voor elke pagina.

MuseScore maakt afbeeldingen zoals ze worden afgedrukt.
Om de resolutie in te stellen en eventueel te kiezen voor een Transparante achtergrond, kies: Bewerken → Voorkeuren... de
tab: exporteer. (Mac: MuseScore → Voorkeuren...)

Als je afbeeldingen wilt maken van onderdelen van de partituur (met of zonder de niet-afdrukbare objecten, zoals kaders,
onzichtbare noten en de kleur van de noten, buiten het bereik van het instrument), zie: Afbeelding maken

SVG (*.svg)

Scalable Vector Graphics  (SVG) kan geopend worden door de meeste browsers (behalve Internet Explorer, ouder dan
versie 9) en de meeste vector-gebaseerde grafische software.
De meeste SVG software ondersteunt evenwel geen opgeslagen lettertypen met als gevolg dat, voor een correcte
weergave, de gebruikte MuseScore lettertypen eerst moeten worden geïnstalleerd .

Beluisteren (Alleen exporteren)

WAV audio (*.wav)

WAV (Waveform Audio Format) is een ongecomprimeerd geluid formaat.

Het werd ontwikkeld door Microsoft en IBM en wordt breed ondersteund voor Windows, Mac OS en Linux.
Het is een ideaal formaat om te gebruiken bij het maken van cd's waarbij de geluidskwaliteit behouden blijft. Echter, deze
grote bestanden maken het moeilijk om te delen via e-mail of het web.

FLAC audio (*.flac)

Free Lossless Audio Codec  (FLAC) is een gecomprimeerd geluid formaat.

FLAC-bestanden zijn maar ongeveer half zo groot met vergelijkbare kwaliteit. Windows en Mac OS hebben geen
ingebouwde ondersteuning voor FLAC, maar software zoals VLC media player  kan FLAC bestanden lezen op de deze
besturingssystemen.

Ogg Vorbis (*.ogg)

Ogg Vorbis  is bedoeld als een patent-vrije vervanging voor het populaire MP3 audio-formaat. Net zoals MP3
bestanden, zijn Ogg Vorbis bestanden relatief klein (soms maar 10% van de ongecomprimeerde audio) maar enige
geluidskwaliteit gaat verloren.

Windows en Mac OS hebben geen ingebouwde ondersteuning voor Ogg Vorbis, maar software zoals VLC media
player  enFirefox  kunnen Ogg bestanden lezen op deze besturingssystemen.
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MP3 (*.mp3)

MP3 bestanden zijn relatief klein (soms maar 10% van de ongecomprimeerde audio), maar een deel van de kwaliteit gaat
verloren.

Om MP3 bestanden te kunnen maken moet een bibliotheek op de computer worden geïnstalleerd: lame_enc.dll
(Windows) of libmp3lame.dylib (Mac). MuseScore zal je naar de locatie van deze bibliotheken vragen. Op deze website
kun je ze vinden: http://lame.buanzo.org/ .

Sommige Mac-gebruikers krijgen een foutmelding bij het laden van de MP3 bibliotheken.
Dit probleem kan worden veroorzaakt doordat je een "32-bit bibliotheek" gebruikt. Een "64-bit bibliotheek" die kan
samenwerken met MuseScore is beschikbaar op: http://www.thalictrum.com/en/products/lame.html  (het is noodzakelijk
om het bestand te hernoemen naar: libmp3lame.dylib zodat MuseScore het kan herkennen).

Delen met andere muziek software

MusicXML (*.xml)

MusicXML  is de universele standaard voor bladmuziek.

Dit is het aanbevolen formaat om bladmuziek te delen tussen uiteenlopende software, met inbegrip van Sibelius, Finale,
en meer dan vele andere.

Gecomprimeerde MusicXML (*.mxl)

Gecomprimeerde MusicXML maakt kleinere bestanden dan de gewone MusicXML.

Het is een recentere standaard en wordt niet altijd ondersteund door andere software.

MIDI (*.mid, *.midi, *.kar)

Musical Instrument Digital Interface  (MIDI) is een formaat dat ruim ondersteund wordt door "sequencers" en muziek
notatie software.

MIDI-bestanden zijn gemaakt voor afspeel doeleinden en bevatten geen informatie over formatteren, voortekens,
stemmen, versieringen, articulaties, herhalingen en andere zaken zoals deze.
Om bestanden tussen verschillende muziek notatie software te delen, is het eerder aanbevolen om MusicXML te
gebruiken. Bent je alleen geïnteresseerd in afspelen, gebruik dan MIDI.

MuseData (*.md) (Alleen importeren)

MuseData  is een formaat ontwikkeld door Walter B. Hewlett. Hij begint in 1983 aan de voorbode van het delen onder
verschillende muziek notatie software.

Het is sindsdien overschaduwd door MusicXML, maar enkele duizenden partituren in dit formaat zijn nog steeds online
beschikbaar.

Capella (*.cap, *.capx) (Alleen importeren)

CAP en CAPX bestanden zijn gemaakt door het muziek notatieprogramma, "Capella" .
MuseScore importeert versie 2000 (3.0) of later vrij nauwkeurig (2.x werkt niet en het *.all formaat van de versie 1.x wordt
helemaal niet ondersteund.

Bagpipe Music Writer ( *.bww) (Alleen importeren)

BWW bestanden worden aangemaakt met specifieke muziek notatie software, "Bagpipe Music Writer" .

BB (*.mgu, *.sgu) (Alleen importeren)

BB bestanden worden gemaakt door de muziek software, "Band-in-a-Box" .

De ondersteuning van MuseScore zit momenteel nog in een experimentele fase.

Overture (*.ove) (Alleen importeren)
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OVE bestanden worden gemaakt door de muziek software "Overture" .

Dit formaat is voornamelijk populair in Chinees-talige gebieden zoals China, Hong Kong en Taiwan.

De ondersteuning van MuseScore zit momenteel nog in een experimentele fase.

Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (Alleen importeren)

Zie ook

Sla op/Exporteer/Druk af

Fretborddiagram

Toevoegen van een Fretborddiagram, barré en positie nummer

1. Sleep het fretborddiagram uit het symbolen palet (in de geavanceerde werkruimte) naar de partituur
2. Klik met rechts op het diagram → Fretborddiagram-eigenschappen...

3. Als voorbeeld gaan we een F akkoord maken, stel eerst deze configuratie in door te klikken op de gewenste
plaatsen (zorg ook dat het aantal snaren op 6 staat ingesteld onderaan in het venster)

4. Druk op de Shift en dan klik op de eerste fret van de 6e snaar zoals hier te zien is:

Eerste resultaat:

Uiteindelijk resultaat in de partituur voor het F akkoord:
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Je kunt de dikte van de barrélijn naar wens instellen door te gaan naar Stijl → Algemeen... → Akkoordsymbolen,

fretborddiagrammen → Barrélijndikte.

Merk op dat het principe is hetzelfde als je een vier snaren barré (of andere) wilt hebben. In het geval van een A7
akkoord: Druk op Shift en klik dan op de 4e snaar, tweede fret. Dit resulteert in:

5. Om een positie/fretnummer aan het fretbord toe te voegen gebruik je de schuifbalk aan de rechterkant van het
venster.

Gedeelde nootkoppen

In klassieke en vingerstijl gitaar muziek is het gebruikelijk dat de noten in verschillende stemmen die op dezelfde tel vallen
de nootkop delen. MuseScore staat het delen van nootkoppen standaard toe indien beide of geen van beide noten een
kwartnoot of korter is en indien beide of geen van beide gepunteerd is—er is dan geen verdere aanpassen nodig:

In de gevallen dat één van de noten en de ander niet gepunteerd is en/of langer is dan een kwartnoot (bv. gepunteerde
achtste noot, gepunteerde kwartnoot, halve noot, gepunteerde halve noot, etc), dan verschuift MuseScore de twee noten:

Dit verschuiven kan eenvoudig worden voorkomen door de kleinste-waarde nootkop onzichtbaar te maken door deze te
selecteren en dan de toetsenbord snelkoppeling V te gebruiken of door de "Zichtbaar" optie in het Instellingenoverzicht uit
te zetten of door het nootkop type gelijk te maken aan die van de langste noot (in het "Noot" gedeelte van het
Instellingenoverzicht wijzig "Koptype" van "Auto" in "Halve").
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Gedeelde nootkoppen in een gewone notenbalk worden omgezet naar twee gescheiden noten in een gekoppelde
tablatuur notenbalk. Om dit te corrigeren verberg je één van de noten in de tablatuur notenbalk met de toetsenbord
snelkoppeling V of met de "Zichtbaar" optie in het Instellingenoverzicht.

Gereedschappen

Er zijn een aantal gereedschappen ontwikkelt. Deze kunnen worden gevonden in het menu Bewerken → Gereedschappen

Voeg toe/verwijder regelafbrekingen

Dit gereedschap voegt automatisch regelafbrekingen toe of verwijdert deze:

Toevoegen regelafbrekingen
iedere X maten
expliciet aan het eind van elk huidig systeem

Verwijderen
alle huidige regelafbrekingen

Dit commando werkt op een selectie van maten of, indien er geen maten zijn geselecteerd, op de gehele partituur.

Optioneel kies de maten die je wilt aanpassen

Bewerken → Gereedschappen → Voeg toe/verwijderen regelafbrekingen

Druk op OK om het commando uit te voeren.

Verdeel / Voeg samen

Met deze commando's kun je de inhoud van een notenbalk met een serie van akkoord omzetten in individuele melodie
lijnen op verschillende notenbalken of kun je meerdere notenbalken die individuele melodie lijnen bevatten samenvoegen
tot een serie van akkoord in een enkele notenbalk.

Verdeel

Selecteer een bereik. De bovenste (of enige) notenbalk, hier genoemd de "bron notenbalk" dat de akkoorden bevat met
meerdere noten. Voer nu Bewerken → Gereedschappen → Verdeel uit. De bovenste noot van ieder akkoord in de bron notenbalk
blijft waar deze is en de andere stemmen worden verdeeld over de notenbalken onder de bron notenbalk, één noot per
notenbalk.

Indien je selectie uit één enkele notenbalk bestaat, dan zal MuseScore zoveel notenbalken toevoegen als het nodig heeft
voor het grootste akkoord. Als voorbeeld, indien het grootste akkoord uit vier noten bestaat, dan zal het verdelen vier
notenbalken gebruiken. De bron notenbalk plus drie notenbalken eronder.

Echter, indien je selectie uit meerdere notenbalken bestaat, dan wordt de selectie zelf beschouwt als het
bestemmingsgebied en de bovenste notenbalk wordt hierbij beschouwt als de bron notenbalk. MuseScore zal de laagste
noot/noten negeren van ieder akkoord dat meer noten bevat dan het aantal notenbalken dat is in de selectie zit.

In beide gevallen zullen, als een akkoord minder noten bevat dan het aantal bestemmingsnotenbalken, de noten, waar
nodig, worden gedupliceerd zodat iedere notenbalk een noot bevat.

Opmerking: indien het geselecteerde bereik een deel van een maat bevat, dan wordt deze stil verlengt tot de
dichtstbijzijnde maat in beide richtingen. Het is momenteel niet mogelijk om een deel van een maat te verdelen.
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Voeg samen

Selecteer een bereik van maten over meerdere notenbalken die een gelijksoortig ritme bevat en voer dan Bewerken →

Gereedschappen → Voeg samen uit. MuseScore zal de inhoud van de notenbalken samenvoegen in akkoorden in de bovenste
notenbalk - het tegenovergestelde van verdelen. Er is een speciaal geval waarbij MuseScore, indien je een enkele
notenbalk selecteert, in essentie hetzelfde doet maar dan wordt de inhoud van meerdere stemmen in die notenbalk
omgezet naar akkoorden in stem één.

Vul met schuine strepen

Dit commando vult de selectie met schuine strepen, één per tel. Voor iedere maat (of deel daarvan) in de selectie worden
de schuine strepen toegevoegd aan de eerste lege stem die beschikbaar is. Indien alle vier de stemmen noten bevatten in
een maat, dan wordt stem één gevuld met schuine strepen waarbij de bestaande noten worden overschreven. In stem
één en twee worden de schuine strepen gecentreerd op de middelste lijn van de notenbalk. In stem drie en vier worden ze
klein en boven of onder de notenbalk geplaatst. Alle schuine strepen zijn ingesteld om niet te transponeren of af te
spelen.

Schakel 'Ritmische schuine streep-notatie' om

Dit commando schakelt de geselecteerde noten om tussen normale noten en de ritmische schuine streep-notatie. Noten
met schuine streep koppen, ingesteld om niet te transponeren of af te spelen. De noten in stem één en twee worden
gefixeerd op de middelste lijn van de notenbalk.

De noten in stem drie en vier worden gefixeerd boven of onder de notenbalk en zijn ook klein gemarkeerd (ook bekent als
"accent" notatie). Je kunt hierbij handig gebruik maken van het selectie filter om de stemmen één en twee uit te sluiten van
je selectie voordat je dit commando uitvoert, zodat alleen de noten in de stemmen drie en vier worden veranderd.

In een percussie notenbalken worden de noten in stem drie en vier niet omgezet in kleine schuine strepen maar worden
dit kleine noten boven of onder de notenbalk.

Herbepaal opeenvolgende repetitietekens

Dit commando herbepaalt de repetitietekens in het geselecteerde bereik:

1. Voeg repetitietekens toe
2. Selecteer een bereik
3. Bewerken → Gereedschappen → Herbepaal opeenvolgende repetitietekens

MuseScore detecteert automatisch de reeks gebasseerd op het eerste repetitieteken in de selectie - alle markeringen in
de selectie worden dan hierop aangepast.

De reeks kan zijn:

a, b, c,
A, B, C,
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eenvoudige numerieke reeks - 1, 2, 3, etc.
numeriek overeenkomstig met de maatnummers

Zie ook

Repetitietekens
Plugins

Hoofdpalet

Het Hoofdpalet geeft je toegang tot alle mogelijk elementen die kunnen worden toegevoegd aan eigen paletten en, in het
geval van Maatsoorten en Toonsoorten, kun je je eigen elementen maken.

Ga naar Weergave → Hoofdpalet of gebruik de snelkoppeling Shift+F9 (Mac: fn+Shift+F9).

Ga met de muis over een element en er wordt een tool tip weergegeven (een korte definitie in zwart op een gele
achtergrond).

Symbolen

De Symbolen sectie is een uitgebreide collectie van honderen muziek symbolen en andere tekst naast die reeds
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gevonden kunnen worden in de standaard paletten. Je kunt door de collectie heen scrollen of zoeken naar een symbool
door het invoeren van een (engelse) tekst in het zoek veld.

De beschikbare symbolen worden weergegeven voor de verschillende lettertype. Gebruik de Lettertype keuze lijst rechts
onderaan in het venster om het gewenste lettertype te selecteren: Emmentaler, Gonville of Bravura.

Symbolen kunnen worden gebruikt door ze naar de partituur te slepen of door eerst een noot of rust te selecteren en dan
te dubbelklikken op het symbool. De positie kan worden aangepast door het symbool te verslepen of door de
horizontale/verticale correctie instelling aan te passen in het Instellingenoverzicht. De kleur en zichtbaarheid kan ook in
het instellingenoverzicht worden aangepast.

Zie ook

Paletten
Eigen palet
Nonexistant node nid: 39841

MIDI importeren

MIDI import kan worden aangepast via het MIDI importeerpaneel dat verschijnt zodra .mid/.midi/.kar bestanden worden
geopend in MuseScore. Met dit paneel krijg je meer controle over hoe de verschillende tracks moeten worden verwerkt en
kunnen hier bewerkingen op worden uitgevoerd (zoals kwantisatie, punt/boog gebruik, etc.). De "Pas toe" knop
(bovenaan) past de eventuele wijzigingen direct toe. De "Annuleer" knop annuleert de nog niet opgeslagen wijzigingen.

Gebruik Shift+scrollwiel of Ctrl+scrollwiel om horizontaal te scrollen door de track opties; scrol verticaal zonder deze toetsen te
gebruiken.

Het resultaat zal een partituur op leveren van betere kwaliteit van het bestand.

Het MIDI importeerpaneel laat een lijst met tracks zien (alleen tracks met noten worden weergegeven) en de beschikbare
opties voor iedere track.

Indien er meerdere tracks zijn, dan wordt er een extra track toegevoegd bovenaan de lijst om alle tracks in één keer te
kunnen selecteren.

In het paneel kun je de track selecteren die je wilt importeren en de volgorde aanpassen. Ook wordt hier de algemene
informatie weergegeven (geluid, notenbalknaam, en liedtekst - indien beschikbaar). De aanwezigheid van de liedtekst
kolom wijst erop dat het bestand een liedtekst track bevat - deze is toewijsbaar aan verschillende tracks middels de
beschikbare lijst door hierop te klikken.

Bewerkingen (aan de rechterkant) zijn beschikbaar als een paar: "naam" - "waarde". Iedere waarde kan worden
aangepast en er kan op worden geklikt. Het kan een combo of checkbox (lijst met beschikbare keuzes) zijn. De
beschikbare opties kunnen van track tot track verschillen, afhankelijk van het type track (gestemd of drum track).

Het MIDI importeerpaneel werkt de relevante informatie bij van het bestand dat wordt bekeken, indien je er meer dan één
open hebt staan. Als het MIDI importeerpaneel niet langer nodig is, dan kan het worden gesloten door op de sluit knop te
klikken in de hoek links boven. Het paneel kan weer zichtbaar worden gemaakt door op de knop "Laat MIDI-
importeerpaneel zien" te klikken die te voorschijn komt zodra het paneel is gesloten.

Beschikbare bewerkingen

MuseScore instrument
Wijs een MuseScore instrument toe (opgenomen in instruments.xml of in een eigen xml bestand gespecificeerd in
Voorkeuren) dat de notenbalknaam, muzieksleutel, transpositie, articulatie, etc. instelt.
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Max. Kwantisatie

Kwantificeert MIDI noten volgens een vast raster. De MAX resolutie voor het raster kan worden ingesteld via de
beschikbare lijst:

Waarde uit voorkeuren (standaard) - kwantisatie waarde wordt gebruik zoals ingesteld in het Voorkeuren
dialoog van MuseScore (in de "Importeren" tab)
Kwart, Achtste, 16de, 32ste, 64ste, 128ste - door de gebruiker gekozen waarde
Het werkelijke raster is aanpasbaar en wordt gereduceerd indien de noot waarde te kort is.

Max. aantal stemmen
Stelt het maximum aantal toegestane stemmen in.

Antimetrische figuren
Indien actief, dan probeert deze optie antimetrische figuren te detecteren en past het overeenkomstige raster toe op
de antimetrische figuren.

Is menselijke uitvoering
Indien actief, dan wordt de MIDI-naar-partituur conversie uitgevoerd ten gunste van de leesbaarheid in plaats van de
nauwkeurigheid. Dit is bruikbaar bij niet uitgelijnde MIDI bestanden, waarvoor geen regulier kwantisatie patroon
beschikbaar is. Voor zulke bestanden wordt het automatische tel detectie algoritme gebruikt dat probeert om de
maat posities door het gehele stuk te detecteren.

2x minder maten telling
Deze optie is actief voor niet uitgelijnde MIDI bestanden (wanneer "Is menselijke uitvoering" is aangezet). Het
halveert de maat telling verkregen van de interne tel detectie. Dit kan handig zijn wanneer de tel detectie een 2x zo
snel als nodig maat verdeling oplevert dan gewenst.

Maatsoort
Deze optie is actief voor niet uitgelijnde MIDI bestanden. De gebruiker kan de gewenste maatsoort aangeven voor
het hele stuk indien de gedetecteerde maatsoort niet juist is. Deze optie is handig omdat het de geïmporteerde
antimetrische figuren correct behandeld in plaats van het direct instellen van de maatsoort vanuit het palet.

Splits notenbalk
Deze optie wordt met name gebruikt voor piano tracks - om noten toe te wijzen aan de linker- of rechterhand. Het
gebruikt een vaste toon voor de splitsing (je kunt deze instellen via een sub-optie) of een meegaande toon
(afhankelijk van de breedte van de hand - een gok vanuit het programmeer oogpunt wordt hierbij gebruikt).
Voor drum tracks ("Percussie" geluid in de track lijst) wordt dit gesplitst in meerdere notenbalken waarbij iedere balk
zijn eigen drum geluid krijgt. Er is ook een sub-optie om een vierkante haak voor de nieuwe gemaakte drum tracks
set toe te staan of niet.

Muzieksleutel wijzigingen
Muzieksleutels kunnen worden ingevoegd in een notenbalk zodat de akkoord dichter op de 5 lijnen notenbalk liggen.
Sleutel wijzigingen zijn afhankelijk van de gemiddelde toon van het akkoord. Gebonden groepen van noten worden
niet onderbroken door het invoegen van een sleutel (als dit voorkomt, dan kun je bug rapporteren voor het algoritme
in importmidi_clef.cpp). Deze optie is alleen beschikbaar voor niet-drum tracks.

Vereenvoudigde duur
Reduceert het aantal rusten om een meer "eenvoudig" noten duur te verkrijgen. Voor drum tracks kan deze optie
zowel rusten verwijderen als noten langer maken.

Laat staccato zien
Optie om staccato markeringen te laten zien of niet in de partituur.

Gepunteerde noten
Zorgt dat MuseScore gepunteerde noten of bogen gebruikt.

Laat tempo-tekst zien
Laat tempo tekst markeringen zien in de partituur of niet.

Laat akkoordsymbolen zien
Laat akkoordsymbolen zien in de partituur, indien beschikbaar, voor XF MIDI bestanden.

Herken opmaat
Indien actief, dan wordt de maatsoort van de eerste maat niet gewijzigd indien deze korten is dan de tweede maat.
Deze optie is alleen beschikbaar voor alle tracks tegelijk.

Detecteer swing
MuseScore probeert swing te detecteren - door het triool [4e en 8ste] door twee gewone 8ste (voor normale swing,
2:1) of gepunteerde 8ste + 16de door twee gewone 8ste (voor shuffle, 3:1). Het plaatst ook de tekst "Swing" of
"Shuffle" aan het begin van de notenbalk met swing noten.

Note input modes

From version 2.1, you can enter notation using one of several new note input modes—in addition to the pre-existing Step-
time and Re-pitch modes. These are accessed by clicking a small dropdown arrow next to the note entry button on the
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note input toolbar.

Step-time

This is the method of note entry that MuseScore has had from the beginning. You enter notes in Step-time mode by
choosing a duration using the mouse or keyboard, and then choosing a pitch using the mouse, keyboard, MIDI keyboard
or virtual piano.

For details see Basic note entry.

Re-pitch

Re-pitch mode allows you to correct the pitches of a sequence of notes while leaving their durations unchanged (not to
be confused with Accidental: Respell pitches).

1. Select a note as your starting point;
2. If you are using a pre-2.1 version of the program press N to enter note-input mode. This step is optional from 2.1

onwards.
3. Select the Re-Pitch option from the Note input drop-down menu (or, for pre-2.1 versions, from the note input

toolbar); or use the keyboard shortcut, Ctrl+Shift+I (Mac: Cmd+Shift+I).
4. Now enter pitches using the keyboard, MIDI keyboard or virtual piano keyboard.

You can also use the Re-pitch function to create a new passage from an existing one of the same sequence of durations
—by copying and pasting the latter, then applying Re-pitch.

Rhythm

Rhythm mode allows you to enter durations with a single keypress. Combining Rhythm and Re-pitch modes makes for a
very efficient method of note entry.

1. Select your starting point in the score and enter Rhythm mode.
2. Select a duration from the note input toolbar, or press a duration shortcut (numbers 1-9) on your computer keyboard.

A note will be added to the score with the selected duration. In contrast to Basic note entry, pressing the . key will
toggle dotting or not dotting all subsequent durations. All following rhythms will be dotted until the . key is pressed
again. Unlike Basic note entry, the dot is to be pressed prior to entering the rhythm.

3. Entering rests is similar to adding dotted notes. Press the 0 key to toggle entering rests. All rhythms entered will be
rests until the 0 key is pressed again. This can be used concurrently with dotted notes.

4. Continue pressing duration keys to enter notes with the chosen durations.
5. Now use Re-pitch mode to set the pitches of the notes you just added.

Real-time (automatic)

The Real-time modes basically allow you to perform the piece on a MIDI keyboard (or MuseScore's virtual piano
keyboard) and have the notation added for you. However, you should be aware of the following limitations which currently
apply:

It is not possible to use a computer keyboard for Real-time input
You cannot enter tuplets or notes shorter than the selected duration
You cannot enter notes into more than one voice at a time
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However, these restrictions mean that MuseScore has very little guessing to do when working out how your input should
be notated, which helps to keep the Real-time modes accurate.

In the automatic version of Real-time input, you play at a fixed tempo indicated by a metronome click. You can adjust the
tempo by changing the delay between clicks from the menu: Edit → Preferences... → Note Input (Mac: MuseScore → Preferences...

→ Note Input).

1. Select your starting position in the score and enter Real-time (automatic) mode.
2. Select a duration from the note input toolbar.
3. Press and hold a MIDI key or virtual piano key (a note will be added to the score).
4. Listen for the metronome clicks. With each click the note grows by the selected duration.
5. Release the key when the note has reached the desired length.

The score stops advancing as soon as you release the key. If you want the score to continue advancing (e.g. to allow you
to enter rests) then you can use the Real-time Advance shortcut to start the metronome.

Real-time (manual)

In the manual version of Real-time input, you have to indicate your input tempo by tapping on a key or pedal, but you can
play at any speed you like and it doesn't have to be constant. The default key for setting the tempo (called "Real-time
Advance") is Enter on the numeric keypad (Mac: fn+Return), but it is highly recommended that you change this to a MIDI key
or MIDI pedal (see below).

1. Select your starting position in the score and enter Real-time (manual) mode.
2. Select a duration from the note input toolbar.
3. Press and hold a MIDI key or virtual piano key (a note will be added to the score).
4. Press the Real-time Advance key. With each press the note grows by the selected duration.
5. Release the note when it has reached the desired length.

Real-time Advance shortcut

The Real-time Advance shortcut is used to tap beats in manual Real-time mode, or to start the metronome clicks in
automatic Real-time mode. It is called "Real-time Advance" because it causes the input position to more forward, or
"advance", through the score.

The default key for Real-time Advance is Enter on the numeric keypad (Mac: fn+Return), but it is highly recommended that
you assign this to a MIDI key or MIDI pedal via MuseScore's MIDI remote control. The MIDI remote control is available
from the menu: Edit → Preferences... → Note Input (Mac: MuseScore → Preferences... → Note Input).

Alternatively, if you have a USB footswitch or computer pedal which can simulate keyboard keys, you could set it to
simulate Enter on the numeric keypad.

See also

Note input
Copy and paste

External links

Video: Semi-Realtime MIDI Demo Part 1: New note entry modes  (available as of MuseScore 2.1)
Introduction to the new Repitch Mode  (YouTube)

Notenbalk-eigenschappen

Overzicht

Iedere instrument notenbalk in MuseScore heeft een aantal eigenschappen die kunnen worden aangepast. Iedere
notenbalk behoort in één van deze drie groepen:

Standaard
Tablatuur
Percussie

Een aantal eigenschappen zijn afhankelijk van de groep waar toe de notenbalk behoort. Met het Bewerk notenbalk-
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/partij-eigenschappen dialoog kun je de eigenschappen van de groep specifieke notenbalk zien en bewerken.

De notenbalk groep waartoe een notenbalk behoort is afhankelijk van het instrument. Iedere notenbalk kan een standaard
notenbalk zijn maar alleen een notenbalk voor een percussie instrument kan een percussie notenbalk zijn (of worden) en
alleen notenbalken van snaar instrumenten kunnen tablatuur notenbalken zijn (of worden).

Iedere partituur wordt initieel gemaakt met 17 voorgedefinieerde "sjablonen" (niet te verwarren met Sjablonen), één
standaard, drie percussie en 13 tablatuur templates. Ieder sjabloon is bedoeld voor een specifiek gebruik dat algemeen of
standaard genoeg is om er een sjabloon voor te maken. Ieder sjabloon kan worden aangepast (onafhankelijk voor iedere
notenbalk in de partituur) en nieuwe sjablonen kunnen worden aangemaakt voor speciale wensen.

Bewerk notenbalk-eigenschappen

Het Bewerk notenbalk-/partij-eigenschappen dialoog kan worden geopend door met rechts te klikken op de naam van het
instrument of op een leeg gedeelte in de notenbalk en dan te kiezen voor Notenbalk-eigenschappen...

Er zijn verschillende opties beschikbaar afhankelijk van de groep van de geselecteerde notenbalk: standaard, tablatuur of
percussie. Een aantal opties zijn gemeenschappelijk voor alle notenbalken:

Naam
De naam van de notenbalk/partij.

Lijnen
Het aantal lijnen in de notenbalk.

Lijnafstand
De afstand tussen twee lijnen van de notenbalk, uitgedrukt in spaties (afgekort: sp). De standaard ruimte tussen
twee lijnen is 1,00. Een hogere waarde zorgt dat de lijnen meer van elkaar af staan en een lagere waarde zorgt dat
de lijnen dichter op elkaar staan. Het is niet aanbevolen om de waarde aan te passen voor de normale groep
(alhoewel het mogelijk is), andere groepen kunnen een andere standaard waarde hebben zo heeft tablatuur
bijvoorbeeld een standaard waarde van 1,5 sp.

Extra afstand boven de notenbalk
Gebruik dit om de afstand te vergroten tussen de geselecteerde notenbalk en die erboven.

Laat muzieksleutel zien
Bepaal of de muzieksleutel moet worden weergegeven of niet.

Laat maatsoort zien
Bepaal of de maatsoort moet worden weergegeven of niet.

Laat maatstrepen zien
Bepaal of maatstrepen moet worden weergegeven of niet.

Geavanceerde stijl-eigenschappen
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Door te klikken op de knop Geavanceerde stijl-eigenschappen... wordt een nieuw dialoog geopend met geavanceerde opties.
Voor een standaard notenbalk ziet dit er als volgt uit:

Voor een percussie notenbalk ziet het er uit zoals dit:
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En voor een tablatuur notenbalk ziet het er uit zoals dit:
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en dit:
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Er zijn ook een aantal knoppen beschikbaar:

Sjabloon

Laat de lijst met beschikbare sjablonen zien in de partituur die kunnen worden toegepast op de huidige
notenbalk.

< Herstel naar het sjabloon

Herstel alle notenbalk eigenschappen naar de eigenschappen van het gekozen sjabloon.

Voeg aan sjablonen toe

Voeg de huidige eigenschap instellingen toe aan een nieuw sjabloon (nog niet geïmplementeerd).

OK

Sluit het dialoog en pas de wijzigingen toe.

Annuleren

Sluit het dialoog zonder de wijzigingen toe te passen.

Standaard en Percussie notenbalk specifieke eigenschappen

Laat toonsoort zien
Bepaal of de toonsoort moet worden weergegeven of niet.

Laat hulplijnen zien
Bepaal of de hulplijnen moet worden weergegeven of niet.

Zonder stok
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Indien geselecteerd, dan hebben de noten geen stok, vlag of waardestreep.

Tablatuur notenbalk specifieke eigenschappen

Ondersteboven
Indien niet geselecteerd, dan komt de bovenste tablatuur lijn overeen met de hoogste snaar en de onderste tablatuur
lijn met de laagste snaar (het meest gebruikelijk). Indien geselecteerd, dan komt de bovenste tablatuur lijn overeen
met de laagste snaar en de onderste tablatuur lijn met de hoogste snaar (dit wordt wel gebruikt in Italiaanse stijl luit
tablatuur).

Fret markeringen

Deze groep eigenschappen definiëren het uiterlijk van de fret markeringen.

Lettertype
Het lettertype dat wordt gebruikt om de markering weer te geven. Er worden momenteel 4 lettertype meegeleverd
die alle benodigde symbolen ondersteunen in 4 verschillende stijlen (modern serif, modern sand, Renaissance, Late
Renaissance). Meer lettertype (of de mogelijkheid om eigen lettertype te gebruiken) komen mogelijk in de toekomst
beschikbaar.

Grootte
De grootte van het lettertype, in typografische punten. De ingebouwde lettertype zien er goed uit bij het gebruik van
9 of 10 pt.

Verticale correctie instelling
MuseScore probeert de symbolen op een logische manier te plaatsen en deze waarde hoeft normaal gesproken niet
te worden veranderd (ingesteld op 0) voor ingebouwde lettertype. Indien het lettertype de symbolen niet juist uitlijnt
op de basis lijn (of MuseScore doet niet wat je verwacht) dan kun je met deze waarde de symbolen naar boven
(negatieve correctie) of naar beneden (positieve correctie) voor betere verticale positionering. De waarde is in sp.

Nummers / Letters
Bepaal of er cijfers (‘1’, ‘2’...) of letters (‘a’, ‘b’...) worden gebruikt als fret markering. Wanneer er letters worden
gebruikt dan wordt ‘j’ overgeslagen en wordt ‘k’ gebruikt voor de 9e fret.

Op de lijnen / Boven de lijnen
Bepaal of de fret markeringen op de snaar lijnen of boven de snaar lijnen moeten worden geplaatst.

Doorgetrokken / Onderbroken

Bepaal of snaar lijnen 'door' de fret markering lopen of daar moet worden onderbroken.
Voorbeeld met cijfers op onderbroken lijnen:

Voorbeeld met letters boven doorlopende lijnen:

Voorbeeld van een 'ondersteboven' tablatuur (zelfde inhoud als het cijfer voorbeeld hierboven):

Notenwaarden

Deze groep eigenschappen definiëren het uiterlijk van de nootwaarden.
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Lettertype
Het lettertype dat wordt gebruikt om de markering weer te geven. Er worden momenteel 3 lettertype meegeleverd
die alle benodigde symbolen ondersteunen in 3 verschillende stijlen (modern, Italiaanse tablatuur, Franse tablatuur).
Meer lettertype (of de mogelijkheid om eigen lettertype te gebruiken) komen mogelijk in de toekomst beschikbaar.
Alleen te gebruiken met de Nootsymbolen optie.

Grootte
De grootte van het lettertype, in typografische punten. De ingebouwde lettertype zien er goed uit bij het gebruik van
15 pt. Alleen gebruikt met de Nootsymbolen optie.

Verticale correctie instelling
Zoals bij de fret markering hiervoor maar dan voor de waarde symbolen. Alleen gebruikt met de Nootsymbolen optie.

Getoond als: Geen
Er worden geen nootwaarden weergegeven (zoals in de voorbeelden hierboven).

Getoond als: Nootsymbolen

Er worden symbolen in de vorm van noten weergegeven boven de notenbalk. Wanneer deze optie wordt gekozen,
dan worden de symbolen alleen weergegeven wanneer de nootwaarde veranderd, zonder deze te herhalen (als
standaard) voor de reeks van noten met dezelfde waarde.
Voorbeeld van waarden met nootsymbolen:

Getoond als: Stokken en waardestrepen

Noot stokken en waardestrepen (of vlaggen) worden weergegeven. De waarde wordt weergegeven voor iedere noot
waarbij dezelfde typografische vormen worden gebruikt als bij een normale notenbalk. Alle commando's in het
standaard Waardestreep Palet kunnen hierop ook worden toegepast.
Voorbeeld met waarde aangegeven door stokken:

Herhaal: Nooit / Bij elk nieuw systeem / Bij elke nieuwe maat / Altijd
Bepaal hoe en wanneer hetzelfde nootsymbool moet worden herhaald indien meerdere noten in een reeks dezelfde
waarde hebben (alleen beschikbaar met de Nootsymbolen optie).

Naast de notenbalk / Door de notenbalk
Bepaal of de stokken worden weergegeven met een vast hoogte boven/onder de notenbalk of dat deze door de
notenbalk heen lopen naar de fret markering (alleen beschikbaar met de Stokken en waardestrepen optie).

Boven / Onder notenbalk
Bepaal of de stokken en waardestrepen boven of onder de notenbalk komen (alleen beschikbaar met de Stokken en
waardestrepen optie / Naast notenbalk sub-optie).

Geen / Met een korte stok / Met een schuine stok
Om de drie verschillende stijlen te kiezen hoe de stokken voor halve noten worden weergegeven (alleen
beschikbaar met de Stokken en waardestrepen optie / Naast notenbalk sub-optie).

Laat rusten zien
Bepaal of er nootsymbolen moeten gebruikt om rusten aan te geven. Bij het gebruik voor een rust zal een
nootsymbool een iets lagere positie krijgen. Alleen gebruikt met de Nootsymbolen optie.

Voorbeeld

Toont een kort stukje partituur in tablatuur formaat waarin alle huidige parameters zijn toegepast.

Oude muziek mogelijkheden

MuseScore 2.0 heeft verschillende nieuwe functies om de schrijfwijze van oude muziek (vooral middeleeuws en uit de
renaissance) verwant aan commerciële edities uit de 20e eeuw mogelijk te maken.
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Notatie zonder onderverdeling in maten

Omdat de meeste muziek uit de renaissance geen maatstrepen gebruikt (danwel niet in maten verdeeld is), wordt met het
verdelen van lange noten en het binden over de maatstrepen daarvan het uiterlijk van de partituur sterk veranderd. Het
herkennen van de lange melodie lijnen en herhaalde motieven word daarmee lastig. Daarom bevat MuseScore een
experimentele weergave mogelijkheid waarbij de nootwaarde in tact blijven. Deze methode kan worden geactiveerd door
het aanzetten van deze optie in Partituur sectie van het Stijl dialoog, te vinden onder Stijl → Algemeen...

Na het toepassen zal de weergave direct worden aangepast.
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Originele notatie (De Profundis Clamavi voor 4 stemmen door Nicolas Champion)

Voor de stijl aanpassing

Na de stijl aanpassing

Merk op dat deze mogelijkheid nog experimenteel is en daarom fouten kan bevatten. De langste noot waarde die word
ondersteund is de longa (een longa met een punt word onderverdeeld en verbonden).
Om de maatstrepen te verwijderen kan de optie "Laat maatstrepen zien" in het notenbalk-eigenschappen dialoog worden
uitgezet maar er is ook een andere mogelijkheid.

Mensurstrich

Omdat de afwezigheid van maatstrepen het uitvoeren van de muziek meer ingewikkeld maakt voor de huidige muzikanten
hebben veel moderne muziekschrijvers een compromis gemaakt genaamd Mensurstrich. Hierbij worden maatstrepen
tussen maar niet door de notenbalken geplaatst. Dit is nu ook mogelijk: dubbelklik op een maatstreep en sleep de
onderkant naar de notenbalk onder de maatstreep, sleep nu de bovenkant naar de onderkant van de huidige notenbalk.
Voer dit uit in de precisie mode (hou de Shift ingedrukt). De-selecteer de maatstreep en de wijziging wordt nu gedaan in de
hele notenbalk.

Het is wellicht handiger om de Instellingen handmatig aan te passen. Open het Instellingen venster, druk op F8 en
selecteer een maatstreep. De juiste waarden zijn:

 Standaard Mensurstrich

Omspannen
notenbalken

1 2

Omspan vanaf 0 8

Omspan tot 8 0
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Indien je aan het einde van de partituur of sectie de maatstrepen weer terug wilt zetten naar de standaard waarden, denk
er dan aan om dit te doen terwijl je de Ctrl toets indrukt anders zal de gehele notenbalk worden aangepast.

Ambitus

Voordat het concept bestond van een absoluut gehoor moesten de uitvoerende artiesten de vocale muziek transponeren
naar een zingbaar bereik voor het ensemble tijdens het uitvoeren. Om hen te helpen was er soms een ambitus
opgenomen in de partituur die daarbij het gehele bereik van een stem aangaf aan het begin van een stuk. De ambitus is
opgenomen in het lijnen palet en kan onderaan worden gevonden, sleep het van hier uit naar de sleutel. Het bereik wordt
hierbij automatisch gedetecteerd.

De ambitus neemt alle maten van muziek in ogenschouw tot aan het eerst volgende sectie-einde, hierna kan een nieuwe
ambitus worden toegevoegd. Het kan handmatig of automatisch worden aangepast in het Instellingenoverzicht. Selecteer
eerst de ambitus die moet worden aangepast. Gebruik de bovenste en onderste noot waarden om het bereik in te stellen.
Voor automatisch aanpassen klik je op de Bereik bijwerken knop in het Instellingenoverzicht.

Mensurale maatsoort

In het mensurale notatie systeem geeft de maatsoort niet de lengte (duur) van een maat aan maar de lengte (duur) van
brevis en semibrevis. MuseScore ondersteund de mensurale maatsoort symbolen als een weergave optie in het
maatsoort-eigenschappen dialoog in plaats van symbolen maar deze zijn slechts voor de weergave van de verhouding
van bijvoorbeeld het aantal halve noten per hele noot kan niet worden aangepast.
Deze symbolen kunnen worden gebruikt bij het repliceren van muziek waarbij de componisten uit de renaissance
meerdere stemmen gelijktijdig in verschillende maatsoorten hebben geschreven zonder gebruik te maken van
antimetrische figuren. Bewerk hiervoor de maatsoort per notenbalk, zolang het begin en het einde van een maat in alle
notenbalken maar overeenkomen. Als dit niet lukt, overweeg dan om de grootte van de maat te vergroten naar de laagste
gemeenschappelijke deler.

De Profundis Clamavi voor 5 stemmen door Josquin Des Prez

Zie ook

Maatbewerkingen: Splitsen en samenvoegen

Partijen maken

Als je een partituur hebt geschreven voor een ensemble, dan kan MuseScore de bladmuziek maken die alleen de
individuele partij voor iedere muzikant in het ensemble bevat.

Instellen van de partijen

Je kunt de partijen op ieder gewenst moment definiëren na het maken van een nieuwe partituur. Je hoeft de partijen
slechts één te definiëren voor iedere partituur, maar je kunt nog wel aanpassing maken indien nodig. De volgende
instructies gebruiken een strijkkwartet als voorbeeld, maar het principe is van toepassing op alle ensembles.

1. Vanuit het hoofd menu kies je Bestand → Partijen...
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2. In het Partijen venster klik je dan op Nieuw om een "partij definitie" te maken.

3. In het rechter deel voer je de tekst in die je wilt gebruiken als "Titel van de partij" (deze naam wordt ook gebruikt als
bestandsnaam bij het exporteren van de partij).

4. Kies het instrument dat in deze partij moet worden weergegeven door het te markeren in het rechter deel van het
venster onder Instrument. Meestal wil je dat er maar één instrument in een partij komt te staan maar soms wil je er
meer dan één instrument in hebben (als er bijvoorbeeld meerdere percussie notenbalken zijn). In MuseScore kun je
zoveel instrumenten markeren als je wilt.

5. Herhaal de stappen 2 tot en met 4 hierboven voor iedere partij die nodig is.

6. Zodra je klaar bent druk je op OK om het Partijen venster te verlaten.
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Je bent nu klaar met het instellen van de partijen. Je hoeft dit niet nog een keer te doen, tenzij je een instrument wilt
toevoegen of verwijderen uit de partituur. In de huidige versie van MuseScore is het niet mogelijk om een enkele
notenbalk (die twee of meer stemmen bevat) te splitsen in losse partijen. Dus ieder instrument dat je wilt afdrukken in een
aparte partij moet ook zijn eigen notenbalk hebben in de partituur.

Alle partijen in één keer instellen

Als je een orkest partituur hebt waarin voor ieder instrument een partij gemaakt moet worden dan kun je dit op een
makkelijker manier doen:

1. Ga naar Bestand → Partijen...

2. Druk op de Allemaal nieuw knop (partijen krijgen de naam van het instrument en deze wordt, indien nodig, aangevuld "-
<number>").

3. Druk op OK.

Nu is er een tabblad aangemaakt voor iedere partij in je partituur.

Partijen exporteren

1. Ga naar Bestand → Exporteer partijen....

2. Navigeer naar de locatie waar je de partijen wilt opslaan en kies het bestandsformaat (standaard is dit PDF).

3. Als bestandsnaam kun je ieder gewenste voorvoegsel gebruiken dat wenselijk is voor alle partijen of je laat de
standaard staan (de naam van je partituur).

4. Klik Opslaan.

Nu worden de bestanden aangemaakt met de naam "<titel>" + "-" + "<partij naam>.<extensie>". Als extra, bij het exporten
naar PDF, wordt ook het bestand "<titel>" + "-Partituur_en_partijen.pdf" aangemaakt.

Opslaan

De partijen en de partituur zijn "gekoppeld". Dit betekent dat iedere aanpassing in de inhoud in beide wordt uitgevoerd.
Alleen voor aanpassingen in de opmaak geldt dit niet. Zodra je de partijen hebt gemaakt worden ze opgeslagen samen
met de partituur (zodra de partituur opent zijn er tabbladen beschikbaar voor de partituur en iedere partij die je hebt
gemaakt).
Je kunt iedere partij afzonderlijk opslaan door de betreffende tabblad te selecteren en dan gebruik te maken van Bestand →

Sla op als...

Partituur informatie

Verschillende meta labels worden automatisch gegenereerd bij het maken van een partituur en er kunnen er later meer
worden toegevoegd. Deze kunnen worden gebruikt in de Kop-/voettekst van de partituur.

Bestand → Info... laat de waarde van de bestaande meta labels zien (sommige kunnen leeg zijn).

181



Reeds bestaande meta labels

Iedere partituur heeft de volgende meta labels. Sommige worden automatisch gevuld bij het maken van een partituur met
de volgende details:

MuseScore-versie: De versie van MuseScore waarmee de partituur het laatst is opgeslagen.
Revisie: De revisie van MuseScore waarmee de partituur het laatst is opgeslagen.
API-niveau: Het bestandsformaat versie.
arranger: (leeg)
composer: Zoals ingevoerd in de Nieuwe Partituur Wizard (welke ook wordt gebruikt als de componist tekst in het
bovenste verticale kader—let op dat het later maken van wijzigingen in de één niet worden overgenomen in de
ander).
copyright: Zoals ingevoerd in de Nieuwe Partituur Wizard. Copyright informatie wordt weergegeven als niet
wijzigbare tekst onderaan iedere pagina van de partituur, maar kan worden veranderd of verwijderd door de
informatie hier te veranderen.
creationDate: Datum van het maken van de partituur. Deze kan leeg zijn indien de partituur is opgeslagen in test
mode (zie Opdracht regel opties).
lyricist: Zoals ingevoerd in de Nieuwe Partituur Wizard (welke ook wordt gebruikt als de liedschrijver tekst in het
bovenste verticale kader—let op dat het later maken van wijzigingen in de één niet worden overgenomen in de
ander).
movementNumber: (leeg)
movementTitle: (leeg)
platform: Het platform waarop de partituur is gemaakt: "Microsoft Windows", "Apple Macintosh", "Linux" or
"Unknown". Dit kan leeg zijn indien de partituur is opgeslagen in test mode.
poet: (leeg)
source: (leeg)
translator: (leeg)
workNumber: (leeg)
workTitle: Zoals ingevoerd in de Nieuwe Partituur Wizard (welke ook wordt gebruikt als de titel tekst in het bovenste
verticale kader—let op dat het later maken van wijzigingen in de één niet worden overgenomen in de ander).

De eerste drie items in de bovenstaande lijst kunnen niet worden gebruikt in de koptekst of voettekst (ze zijn eigenlijk
geen meta labels).

Iedere partij heeft als extra de volgende meta label, gegenereerd en gevuld bij het maken van de partijen:

partName: Naam van de partij zoals opgegeven bij het maken van de partij (welke ook wordt gebruikt als de
partijnaam tekst in het bovenste verticale kader—let op dat het later maken van wijzigingen in de één niet
worden overgenomen in de ander).

Aanpassen van een meta label
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Om een meta label van een partituur aan te passen met gekoppelde partijen, moet je zorgen dat de partituur het actieve
tabblad is. Om een meta label voor een individuele partij aan te passen, moet deze partij het actieve tabblad zijn.
Ga naar Bestand → Info... en wijzig de huidige tekst of vul tekst in bij een leeg label.

Een nieuw meta label toevoegen

Om een meta label aan een partituur met gekoppelde partijen toe te voegen, moet je zorgen dat de partituur het actieve
tabblad is. Om een meta label aan een individuele partij toe te voegen, moet deze partij het actieve tabblad zijn.

Ga naar Bestand → Info... → Nieuw

Vul de naam in voor de nieuwe meta label en klik OK (of Annuleren). De meta label wordt toegevoegd aan de label lijst. Je
kunt daarna de inhoud bij de label invullen.

Koptekst/voettekst

Je kunt de inhoud van de meta labels in de kop- of voettekst van de partituur laten weergeven. Om een kop- of voettekst
te maken voor een partituur met gekoppelde partijen, moet je zorgen dat de partituur het actieve tabblad is. Om een kop-
of voettekst te maken voor een individuele partij moet deze partij het actieve tabblad zijn.

Ga naar Stijl → Algemeen... om het Stijl bewerken venster te openen en kies Koptekst, voettekst, nummers in de lijst aan de
linkerkant.

Als je met de muis over het koptekst of voettekst gebied beweegt dan kom een lijst met macro's te voorschijn met daarbij
de betekenis en de bestaande meta labels met hun inhoud.
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Je kunt deze labels (bv. $:workTitle:) en macro's (e.g. $M) in de betreffende vakken om ze toe te voegen aan de kop- of
voettekst.

Klik op Toepassen om te zien hoe de kop- of voettekst eruit ziet in de partituur. Klik op OK om de kop- of voettekst vast te
leggen in de huidige partituur of partij. Indien het actieve tabblad een partij is, dan kun je ook klikken op Pas toe op alle partijen

als je dat wilt en daarna op OK om het venster te verlaten. Met de knop Annuleren verlaat je het venster zonder de
wijzigingen toe te passen.

Zie ook

Opmaak en lay-out: Kop- en voettekst
Opdracht regel opties: Test mode

Plugins

Plugins zijn stukjes programmacode om een bepaalde functie aan MuseScore toe te voegen. Met het toevoegen van een
plugin komt er een nieuwe optie bij in het Plugins menu in MuseScore zodat de actie kan worden uitgevoerd op de
partituur of een deel daar van. Plugins bieden de mogelijkheid aan de gebruikers met minimale programmeer kennis
functies toe te voegen een de software.

Een aantal plugins worden met MuseScore meegeleverd, zie →hieronder . Je kunt nog veel meer plugins vinden in de
plugin bibliotheek . Sommige plugins werken met MuseScore 2 en andere werken alleen met oudere versies van
MuseScore.

Installatie

Merk op dat het voor sommige plugins noodzakelijk kan zijn dat er additionele componenten geïnstalleerd moeten worden
(zoals lettertype, e.d.) om er gebruik van te kunnen maken. Controleer de documentatie van de plugin voor meer
informatie hierover.

De meeste plugins worden geleverd als een ZIP bestand, download het zip bestand voor de plugin en pak het uit in één
van de mappen die hieronder genoemd worden.
Sommige worden geleverd als een .qml bestand, download en plaats het direct in één van deze mappen.

Windows

MuseScore zoekt naar plugins in %ProgramFiles%\MuseScore 2\Plugins (of %ProgramFiles(x86)%\MuseScore 2\Plugins voor de 64-bit
versies) en in %LOCALAPPDATA%\MuseScore\MuseScore 2\plugins voor Vista en Windows 7 of C:\Documents and

Settings\USERNAME\Local Settings\Application Data\MuseScore\MuseScore 2\plugins (aangepast aan je taal versie) bij XP.
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Mac OS X

Op Mac OX X zoekt MuseScore naar plugins in de MuseScore bundel in /Applications/MuseScore 2.app/Contents/Resources/plugins

en in ~/Library/Application Support/MuseScore/MuseScore 2/plugins. Om de bestanden in de app bundel te kunnen plaatsen klik je
met rechts (Control-klik) op de MuseScore.app en kies je "Show package contents" om de Contents map weer te geven.
Wees hierbij voorzichtig en gebruik de Contents/Resources/plugins en niet de Contents/plugins map.

Linux

In Linux zoekt MuseScore voor plugins in /usr/share/mscore-2.0/plugins en in ~/.local/share/data/MuseScore/MuseScore 2/plugins.

Aan-/uitzetten plugins

Om toegang te krijgen tot de geïnstalleerde plugins in het Plugins menu moeten ze eerst aangezet worden in Plugin-
beheer. Kies hiervoor Plugins → Plugin-beheer...:

Zet de plugin aan door het plaatsen van een vinkje voor de betreffende plugin. Een plugin kan worden uitgezet door het
vinkje weg te halen.

Maak/bewerk/uitvoeren plugins

Het is mogelijk om nieuwe plugins te maken, ze te bewerken en uit te voeren via de Plugin-maker. Kies hiervoor Plugins →

Plugin-maker...:
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Hier kan ook de documentatie worden gevonden van de beschikbare elementen.

Standaard geïnstalleerde Plugins

Een aantal plugins zijn voor-geïnstalleerd met MuseScore maar ze zijn niet aangezet. Zie →hierboven hoe ze kunnen
worden aangezet.

ABC Import

Deze plugin importeert ABC  tekst uit een bestand of van het plakbord. Een internet verbinding is hierbij nodig omdat het
gebruikt maakt van een externe web-service  voor de conversie van de informatie die gebruik maakt van abc2xml  om
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de ABC data om te zetten in MusicXML om die vervolgens in MuseScore te importeren.

Break Every X Measures (Onderbreek Iedere X Maten)

Deze plugin voegt regelafbrekingen volgens de gekozen interval in voor de geselecteerde maten of, indien er geen maten
zijn geselecteerd, voor de gehele partituur. Deze wordt niet langer met MuseScore meegeleverd want hij is vervangen
door Bewerken → Gereedschappen → Voeg toe/Verwijder regelafbrekingen.... Mocht je gebruik hebben gemaakt van een beta versie
van MuseScore 2 dan is het mogelijk dat deze plugin is achtergebleven.

Notes → Color Notes (Noten Kleuren)

Deze voorbeeld plugin kleurt de noten afhankelijk van de toonhoogte. Het kleur de nootkoppen van alle noten in iedere
notenbalk en stem volgens de BoomWhackers conventie. Iedere toonhoogte heeft een andere kleur. C en C♯ hebben een
andere kleur. C♯ en D♭ hebben dezelfde kleur.
Om alle noten zwart te maken voer je dezelfde plugin nogmaals uit (op dezelfde selectie). Je kunt hiervoor ook gebruik
maken van de 'Remove Notes Color' plugin .

Create Score (Maak partituur)

Deze voorbeeld plugin maakt een nieuwe partituur. Het maak een nieuwe piano partituur met 4 kwarten C D E F. Het is
een goed voorbeeld om te leren hoe je een nieuwe partituur maakt en noten toevoegt vanuit een plugin.

helloQml

Deze demo plugin laat een aantal basis taken zien.

Notes → Note Names (Noot Namen)

Deze plugin benoemd de noten. Het gebruikt de Engelse naam voor de noten (zoals in notenbalk tekst). Voor stem 1 en 3
boven, voor stem 2 en 4 onder de notenbalk, akkoorden in door komma's gescheiden lijst, beginnend met de bovenste
noot.
Een vertaalde versie, die de noot namen gebruikt volgens je eigen taal instellingen is beschikbaar in de plugin
bibliotheek .

panel (paneel)

Deze plugin maakt een paneel (venster).

random (willekeurig)

Dit maakt een willekeurig partituur.

random2 (willekeurig 2)

Dit maakt ook een willekeurig partituur.

run (uitvoeren)

Deze voorbeeld plugin voert een extern commando uit. Deze werkt vermoedelijk alleen in Linux.

scorelist (partituur lijst)

Deze test plugin wisselt in de partituur lijsten.

ScoreView (Partituur weergave)

Voorbeeld plugin om het gebruik van partituur weergave te laten zien.

Walk (Loop)

Deze test plugin "loopt" door alle elementen in een partituur.

Gereedschappen
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Sommige gereedschappen werken net als een plugin omdat ze handelingen "automatisch" uitvoeren, zie
Gereedschappen. Een aantal van deze zijn voorheen zelfs plugins geweest.

Recovered files

If MuseScore or your computer should crash, or if power is lost, a pop-up message upon restarting MuseScore will ask if
you wish to restore the previous session.

If you click No, any work from your previous session will be lost. If you click Yes, MuseScore will attempt to recover the files
that were open.

Behavior of saving after session recovery

When MuseScore recovers files after a crash, it renames them with the full path name added in front of the original file
name. This very long name will appear in the tab(s) above the active score window. On some operating systems, when a
user saves any of these recovered files, it will be saved in the folder in which the program itself is running. This is not
necessarily the same directory in which the scores were saved when they were created. You may not be able to
locate the revised file in the usual folder.

To avoid this, do not use "Save" the first time you save a recovered file. Use the "Save As..." menu item before making any
revisions to the score, to save each recovered file under either its original name or a new name. This will open a window
to allow you to navigate to the correct folder and directory. This is important in order to ensure that the file is saved to
the folder in which you expect to find it later.

Finding recovered files

In the event that "Save" is used instead of "Save As..." with a recovered file, you will have to find the files in your computer.
The actual location of those files will vary, depending on your operating system, and in which directory MuseScore is
installed.

For Windows 7, with a default installation of MuseScore to the x86 program files directory, recovered files are auto-saved
to C:\Program Files (x86)\MuseScore 2\bin (actually %ProgramFiles(x86)%\MuseScore 2\bin).

For Windows 10, look in C:\Users\[User Name]\AppData\Local\VirtualStore\Program Files (x86)\MuseScore 2\bin

(actually%LOCALAPPDATA%\VirtualStore\%ProgramFiles(x86):~3%\MuseScore 2\bin).

You may need to run a system-wide search in order to find files saved directly after a session recovery. Use keywords
from the original file name as well as wildcards, and specify the date modified.

See also

Save/Export/Print

External links

How to recover a backup copy of a score

Toegankelijkheid

MuseScore wordt geleverd met ondersteuning voor de gratis "open source" NVDA screen reader  voor Windows.
Momenteel worden andere "screen readers" niet ondersteund (zoals Jaws  voor Windows, of VoiceOver  voor Mac
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OS X).

Inleiding

Dit document is geschreven voor blinde en slechtziende gebruikers van MuseScore 2.0.
Het is niet bedoeld om een volledige beschrijving te bieden van alle functies van MuseScore.
Je moet dit lezen in samenhang met de reguliere MuseScore documentatie.
De functies in dit document zijn getest op Windows met NVDA. Andere scherm lezers en andere besturingssystemen
kunnen anders werken, of helemaal niet.
Tot op heden is MuseScore 2.0 voornamelijk toegankelijk als een partituur lezer, niet zozeer als een partituur bewerker.
Dit document zal zich dan ook voornamelijk richten op de functies "partituur lezen", met slechts een korte beschrijving van
de functies "partituur bewerken".

Originele instellingen

Wanneer u MuseScore voor de eerste keer uitvoert, kunt u desgewenst het venster Starthulpscherm permanent
uitschakelen:
Sluit eerst het Starthulpscherm. Kies dan in het menu Bewerken het item Voorkeuren... (Alt+E) en verwijder het vinkje
naast "Laat starthulpscherm".
Klik op Toepassen en/of OK om de wijziging op te slaan.

Wegwijs maken

De gebruikersinterface in MuseScore werkt net als in andere notatie programma's en andere document georiënteerde
programma's in het algemeen. Het heeft een enkel document venster waarin u kunt werken met een partituur. MuseScore
ondersteunt wel meerdere document-tabbladen in dit venster.
Het ondersteunt ook een weergave in deelvensters om u toe te laten met twee documenten te werken in een keer. Er
kunnen meerdere tabbladen in elk venster te voorkomen.
Daarnaast beschikt MuseScore over een menubalk die u kunt openen via de snelkoppelingen voor de individuele menu's:

Bestand: Alt+B

Bewerken: geen toets toegewezen
Weergave: Alt+W

Voeg toe: Alt+V

Noten: Alt+N

Opmaak: Alt+O

Stijl: Alt+S

Plugins: Alt+P

Help: Alt+H

Alleen het menu Bestand is van belang bij het gebruik van MuseScore als een "partituur lezer".
Als u een menu geopend hebt, moet u de pijltjestoetsen Omhoog of Omlaag gebruiken.

Er zijn ook een aantal werkbalken, paletten en deelvensters binnen MuseScore.
U kunt door de besturingselementen heen stappen met de Tab-toets (of met Shift+Tab om terug te keren).
Wanneer u MuseScore start, of een partituur laadt, moet de focus in het hoofdvenster staan. Het gebruik van de Tab-toets
brengt u naar een werkbalk met een reeks knoppen voor opdrachten zoals Nieuw, Open, Afspelen, enzovoort. De Tab-
toets zal de knoppen overslaan die momenteel niet actief zijn. De namen en sneltoetsen (indien van toepassing) voor
deze knoppen moeten worden gelezen door de schermlezer.

Indien u alle knoppen van de werkbalk hebt doorlopen, zal de Tab-toets u naar de Paletten leiden.
Die worden gebruikt om diverse elementen aan een partituur toe te voegen, maar zijn momenteel niet beschikbaar. De
Tab brengt u eerst naar een keuzelijst waarmee u tussen de verschillende werkruimten kunt kiezen (inclusief de door u
vervaardigde en opgeslagen werkruimten) en ten slotten naar een knop voor het creëren van een nieuwe werkruimte.

Als u een van de optionele vensters, zoals het venster "Instellingenoverzicht" of het selectiefilter hebt geopend, zal de
Tab-toets ook deze bezoeken.
U kunt vensters die u niet nodig hebt sluiten door te gaan naar het menu Weergave en ervoor te zorgen dat geen enkel
van de selectievakjes van de eerste reeks aangevinkt is (de reeks boven "Inzoomen").
Standaard zullen alleen de Paletten, de Navigator en "MuseScore Connect" worden geselecteerd. De laatste twee zijn
niet opgenomen in de tabvolgorde.
Om de focus terug op het partituur venster te zetten nadat u de werkbalken en de deelvensters hebt bezocht: druk Esc

Dit wist ook elke selectie die u in de partituur venster hebben gemaakt.
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Het partituur venster

Wanneer u voor het eerst MuseScore 2.0 start, wordt een lege partituur geladen met de titel "My First Score". Als u wilt
experimenteren met de verschillende bewerkingsfuncties, is dit een goede plek om te beginnen. Anders zul je
waarschijnlijk willen beginnen met het laden van een partituur.
MuseScore gebruikt de standaard sneltoetsen voor toegan tot de systeem commando's zoals:
Ctrl+O (Mac: Cmd+O) om een bestand te openen
Ctrl+S (Mac: Cmd+S) om op te slaan
Ctrl+W (Mac: Cmd+W) om te sluiten enz.

Als u Ctrl+O (Mac: Cmd+O) gebruikt om een partituur te laden, wordt u een vrij standaard dialoogvenster getoond. (eigenlijk
door Qt voorzien). MuseScore kan uiteraard partituren in zijn eigen formaat (MSCZ of MSCX) openen maar kan ook
geïmporteerde partituren openen in het standaard MusicXML formaat, in het MIDI-formaat, en nog een paar andere
programma's zoals Guitar Pro, Capella, en Band-in-a-Box.
Zodra u een partituur hebt geladen, wordt deze weergegeven in een nieuw tabblad binnen het partituur-venster. U kunt
schakelen tussen de tabbladen inhet partituur-venster met Ctrl+Tab (geldt niet voor Mac).

Er zijn een paar interessante dingen die u kunt doen met een geladen partituur naast het lezen noot voor noot. U kunt op
Spatie klikken om de partituur af te spelen. U kunt Bestand/Exporteren gebruiken om te converteren naar een ander
formaat, zoals PDF, PNG, WAV, MP3, MIDI, MusicXML, enz. En natuurlijk kunt u het afdrukken via Bestand/Druk af of
Ctrl+P (Mac: Cmd+P).

Als een partituur meerdere instrumenten bevat, kan het zijn dat gekoppelde partijen reeds zijn gecreëerd. Gekoppelde
partijen worden gepresenteerd als partij tabbladen binnen partituur tabs, maar op dit moment is er geen manier om deze
deel tabbladen met het toetsenbord navigeren. De partijen zouden normaal gesproken geen informatie bevatten welke
verschilt van de partituur; ze worden gewoon anders weergegeven (elke partij op zijn eigen pagina). Als een partituur niet
alle partijen gegenereerd, kunt u dit doen via Bestand / Partijen..., en dat dialoog is toegankelijk. Als u de partijen wilt af te
drukken, dan kunt u dat realiseren door de partijen te exporteren met behulp van de het Bestand / Exporteer Partijen...
dialoog, dat automatisch alle partijen exporteert naar PDF (of andere formaten).

Partituur lezen

Zodra een partituur word geopend dan is het partituur venster actief maar er is dan niets geselecteerd. De eerste stap om
een partituur te kunnen lezen is door iets te selecteren en de meest gebruikelijke plaatst om bij te beginnen is bij het
eerste element in de partituur. Dit doe je met Ctrl+Home (Mac: Cmd+Home). Dit kun je ook gebruiken wanneer je de selectie
annuleert door het indrukken van Esc.

Als je navigeert tussen de elementen dan zal de screen reader de naam van het element dat geselecteerd is (meest
waarschijnlijk de sleutel aan het begin van de bovenste notenbalk van de partituur) laten horen. Je hoort dat het de naam
van het element zegt (bijvoorbeeld, "G-sleutel") en het geeft je ook de informatie over de positie (bijvoorbeeld, "Maat 1;
Tel 1; Notenbalk 1"). De hoeveelheid informatie die wordt gelezen kan momenteel niet worden aangepast. We hebben
geprobeerd de meest belangrijke informatie als eerste te laten horen zodat je snel kunt verder gaan naar het volgende
element voordat alles gelezen is of je kunt gewoon weg de rest van de tekst die gelezen wordt negeren. Met het drukken
de op Shift toets kun je het lezen onderbreken, dat kan soms ook handig zijn.

De meeste navigatie in MuseScore gaat alleen om de noten en rusten - het zal muzieksleutels, toonsoorten, maatsoorten,
maatstrepen en andere elementen overslaan. Als je gebruik maakt van de standaard Rechts en Links pijltjes toetsen om
door de partituur te verplaatsen dan hoor je alleen informatie over de noten en rusten (en de elementen die daar aan
gekoppeld zijn). Er zijn echter twee speciale navigatie commando's die bruikbaar zijn om een meer compleet beeld te
geven van de partituur:

Volgend element: Ctrl+Alt+Shift+Rechts (Mac: Cmd+Option+Shift+Rechts)
Vorig element: Ctrl+Alt+Shift+Links (Mac: Cmd+Option+Shift+Links

Deze commando's omvatten ook de muzieksleutels en andere elementen die de andere navigatie commando's overslaan
en navigeren ook door alle stemmen in de huidige notenbalk, waarbij de andere commando's zoals Rechts en Links alleen
navigeren in de geselecteerde stem totdat je expliciet van stem wisselt. Als je bijvoorbeeld op een kwartnoot op de eerste
tel van de eerste maar bent en er zijn twee stemmen in die maat, dan ga je door het indrukken van het pijltje naar Rechts
naar de volgende noot van stem 1 - die op de tweede tel staat - terwijl het indrukken van Ctrl+Alt+Shift+Rechts (Mac:
Cmd+Option+Shift+Rechts) in de eerste maat zal blijven en dan doorgaat met de noot van de tweede stem. Zodra je alle noten
gehad hebt op de huidige tel in de huidige notenbalk dan gaat dit commando verder op de volgende tel. De bedoeling van
dit commando is dat het je helpt bij het navigeren door een partituur waarvan je inhoud nog niet kent.

Zodra je naar een element navigeert, dan zal de screen reader de beschikbare informatie daarover geven. Voor noten en
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rusten wordt ook de informatie gegeven van de elementen die eraan gekoppeld zijn, zoals liedtekst, articulatie,
akkoordsymbolen, etc. Op dit moment is er nog geen manier om direct naar deze elementen te navigeren.
Een belangrijke opmerking: Omhoog en Omlaag zowel los als met Shift of met Ctrl / Cmd zijn geen bruikbare toetsen voor het
navigeren! Zij verhogen of verlagen de toonhoogte van de geselecteerde noot of noten. Pas op dat je hiermee niet per
ongeluk de partituur aanpast wanneer je deze aan het lezen bent. Omhoog en Omlaag kunnen alleen worden gebruikt in
combinatie met Alt/Option voor het navigeren. Zie de lijst met navigatie commodo's hieronder.

Vooruit of achteruit in tijd verplaatsen

De volgende snelkoppeling zijn beschikbaar om "horizontaal" door de partituur te verplaatsen:

Volgend element: Ctrl+Alt+Shift+Rechts

Vorig element: Ctrl+Alt+Shift+Links

Volgend akkoord of rust: Rechts

Vorig akkoord of rust: Links

Volgende maat: Ctrl+Rechts

Vorige maat: Ctrl+Links

Ga naar maat: Ctrl+F

Eerste element: Ctrl+Home

Laatste element: Ctrl+End

Verplaatsen tussen noten op een bepaalde punt

De volgende snelkoppelingen zijn beschikbaar om "verticaal" door de partituur te verplaatsen:

Volgend element: Ctrl+Alt+Shift+Rechts

Vorig element: Ctrl+Alt+Shift+Links

Volgende hogere noot in de stem, vorige stem of notenbalk erboven: Alt+Omhoog

Volgende lagere noot in de stem, volgende stem of notenbalk eronder: Alt+Omlaag

Bovenste noot in een akkoord: Ctrl+Alt+Omhoog

Onderste noot in een akkoord: Ctrl+Alt+Omlaag

Het Alt+Omhoog and Alt+Omlaag commando zijn gelijk aan het Ctrl+Alt+Shift+Rechts en Ctrl+Alt+Shift+Links commando die
ontworpen zijn om de inhoud van een partituur te ontdekken. Je hoeft het aantal noten in een akkoord, het aantal
stemmen in een notenbalk of hoeveel notenbalken er zijn in een partituur niet te weten om verticaal door de partituur te
verplaatsen met deze commando's.

Partituur lezen filteren

Om sommige elementen zoals liedtekst of akkoordnamen uit te sluiten bij het lezen van een partituur kan gebruik worden
gemaakt van het Selectie Filter (F6). De-selecteer de elementen die je niet wilt lezen.

Partituur afspelen

Met de spatiebalk wordt het afspelen gestart en gestopt. Het afspelen start bij de geselecteerde noot, indien er één is
geselecteerd, waar het afspelen is gestopt indien er geen noot is geselecteerd, of aan het begin van de partituur bij het
voor eerste keer starten van het afspelen.

MuseScore ondersteund het afspelen in een lus zodat je een gedeelte kunt herhaling voor het oefenen. Om de "in" en
"uit" positie van de lus in te stellen gebruik je het Afspeelpaneel (F11):

1. Selecteer de noot in het partituur venster waar de lus moet beginnen
2. Ga naar het afspeelpaneel en druk op de "Zet lus in positie" knop
3. Ga terug naar het partituur venster en navigeer naar de noot waar de lus moet stoppen
4. Ga weer naar het afspeelpaneel en druk op de "Zet lus uit positie" knop
5. Om de lus aan of uit te zetten gebruik je de Lusafspelen knop

Je kunt het afpelen van de lus en andere afspeel parameters, zoals het wijzigen van het basis tempo van een partituur,
met het Weergave / Afspeelpaneel (F11) aanpassen.

Partituur bewerken

Het bewerken van een partituur is momenteel niet erg toegankelijk - er zijn teveel partituur elementen die het gebruik van
de muis vereisen om ze in de partituur te plaatsen. Visuele referentie en het handmatig aanpassen van de positie van de
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verschillende elementen is soms noodzakelijk omdat MuseScore slechts gelimiteerd rekening houd met andere
elementen.

Hier tegen over staat wel dat MuseScore een voldoende standaard platform beidt om te experimenteren met de basis van
het invoeren van noten.
Om de noot invoer mode te activeren navigeer je eerst naar de maat waar je de noten aan wilt toevoegen en dan druk je
op "N". Bijna alles met betrekking tot het invoeren van noten is ontworpen om met het toetsenbord te kunnen worden
ingevoerd en de standaard documentatie zou voldoende hulp moeten bieden bij dit proces. Bedenk wel dat MuseScore in
noot invoer mode of normale mode kan staan en het is niet altijd even duidelijk in welke mode je bent. Bij twijfel kun je Esc
in drukken. Als de noot invoer mode actief was dan wordt deze uitgezet. Als je in normale mode was, dan blijf je in deze
mode echter wordt je huidige selectie geannuleerd.

Aanpassingen

Je kunt de toegewezen toetsenbord sneltoetsen aanpassen met Bewerken / Voorkeuren / Sneltoetscombinaties. Wellicht
dat er in de toekomst een speciale set met sneltoetsen beschikbaar komt die geoptimaliseerd is voor toegankelijkheid
en/of een manier waar mee het opslaan en laden van sneltoets definities mogelijk wordt.

Voorkeuren

Kies: Bewerken → Voorkeuren... (Mac: MuseScore → Voorkeuren...):
Hier kun je bijvoorbeeld een eigen algemene stijl opzetten of voorgeselecteerde mappen instellen voor iedere keer dat je
MuseScore gebruikt.

Het venster Voorkeuren heeft volgende tabs:

Voor sommige wijzigingen is een herstart (sluiten en weer openen) van MuseScore nodig om effect te hebben. Je krijgt
hier een melding van zodra je op Toepassen of op OK klikt.

Herstel de standaardwaarden van alle voorkeuren  herstelt alle voorkeuren zoals MuseScore ze oorspronkelijk heeft ingesteld.
Met Annuleren verlaat je het venster, zonder de (eventuele) wijzigingen op te slaan.

Algemeen
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Hier kunt je het volgende instellen:

Programma startmodus
Hier kun je de partituur en de schermen (startlogo- en starthulpscherm, afspeelpaneel en navigator) instellen die
moeten worden getoond bij het opstarten
Mappen
De standaardmappen voor de partituren, stijlen, sjablonen, plug-ins, SoundFonts en afbeeldingen
Automatisch opslaan
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De frequentie van Automatisch opslaan
Taal
Je kunt een taal instellen uit een lijst en de vertalingen bijwerken
Stijl
Hier kun je de stijl instellen en de pictogramgroottes
OSC afstandsbediening
Hier kun je het poortnummer bepalen

Opmerking: Een bijgewerkte vertaling kun je ook ophalen: Help → Databronnen-beheer

Werkblad
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Hier kun je de achtergrond en het papier instellen en onder Allerlei:

Teken afronding met anti-aliasing:

Dit is een techniek waarbij het karteleffect van diagonale lijnen en hoeken van objecten minder opvalt.

Afstand voor het selecteren van elementen:

Dit is de afstand tot een object waarbij de muis het nog kan activeren.

Kleinere afstanden vergen meer precisie waardoor het moeilijker wordt om het object aan te klikken.
Grotere afstanden zijn minder precies waardoor het moeilijk wordt om een nabij gelegen object te ontwijken.
Kies een comfortabele afstand.

Noteninvoer
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Hier kun je de voorkeuren instellen voor noteninvoer en MIDI afstandsbediening.
De volgende items kunnen worden ingesteld:

Midi-ingang inschakelen
Laat noten horen tijdens bewerken ( + standaard-duur)
Laat het hele akkoord horen bij het toevoegen van noten
Kleur de noten buiten het bereik van het instrument
Midi-afstandsbediening instellingen
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Partituur

De voorkeuren bij de partituur zijn:

Standaard instrumentenlijst (u kunt er twee selecteren)
Standaardstijl voor partituren
Standaardstijl voor partijen
Standaard schaalverhouding voor de weergave
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I/O

I/O staat voor Input en Output

Import

198



Hier bepaal je hoe bestanden van andere bronnen worden geïmporteerd:

Gebruik maken van de in MuseScore ingebouwde stijl of een stijl die u zelf kiest
Gebruik maken van de tekenset van Guitar Pro en Overture
MusicXML opmaak opties
Kortste noot in MIDI bestanden

Exporteer
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Deze instellingen bepalen hoe MuseScore bestanden exporteert:

PNG/SVG resolutie (in DPI) en of je "Transparante achtergrond" wilt gebruiken
PDF resolutie (in DPI)
"Schrijf herhalingen uit" gebruiken in geëxporteerde MIDI bestanden
Samplefrequentie voor audio
Systeem- en pagina-afbrekingen en opmaak wel, gedeeltelijk of niet exporteren naar MusicXML
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Sneltoetscombinaties

Alle mogelijke bewerkingen van MuseScore zijn hier in een lijst weergegeven met de eraan verbonden
sneltoetscombinatie indien die er is.
Met de knop Bepaal… kun je zelf een sneltoets instellen voor een bepaalde actie.
Je kunt tot 4 combinaties instellen.
Je kunt ook alle oorspronkelijk sneltoetscombinaties terugzetten of een bepaalde sneltoets wissen.
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Opmerking: Sommige sneltoetscombinaties kunnen niet op ieder toetsenbord gebruikt worden. Test het eerst uit.

Werk bij

Je kunt de automatische controle voor een nieuwe versie bij het opstarten van MuseScore aan- of uitzetten.
Je kunt ook handmatig controleren op een nieuwe versie via: Help → Controleer op nieuwe versie
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Zie ook

Toetsenbord snelkoppelingen
Taalinstellingen en bijwerken van de vertalingen
Controleren op nieuwe versie

Waardestrepen door meerdere notenbalken

In piano partituren is het gebruikelijk om beide notenbalken (bas en viool sleutel) te gebruiken voor een muzikale frase.

Dit kan in MuseScore als volgt worden ingevoerd:

Voer alle noten in één notenbalk in:

Ctrl+Shift+↓ verplaatst de geselecteerde noot of akkoord naar de volgende notenbalk (Mac: ⌘+Shift+↓.)

Als je de waardestreep wilt verplaatsen, dubbelklik dan op de waardestreep om de handgrepen weer te geven. Gebruik de
handgrepen om de opmaak aan te passen.

Zie ook

Maatstrepen voor maatstrepen door meerdere notenbalken (bv. gepaarde notenbalken) .

Nieuwe mogelijkheden in MuseScore 2.x

Voor een overzicht van de nieuwe mogelijkheden, zie What's New in MuseScore 2 , MuseScore 2.0 Release Notes ,
MuseScore 2.0.1 Release Notes , MuseScore 2.0.2 is released , en Changes for MuseScore 2.0 .
Documentatie van de nieuwe mogelijkheden is beschikbaar in het hoofdstuk waar ze logischerwijs bij horen (behalve die
gaat over het bijwerken vanaf 1.x) maar voor gebruikers die vanaf versie 1.x komen is hier de lijst met links zodat je in
één keer kunt zien wat er nu mogelijk is...

Zie ook

Album (→Geavanceerde onderwerpen)
Weergave modi: Doorlopend tonen and Navigator (→Basisfuncties)
Kopiëren en plakken: Selectiefilter (→Basisfuncties)
Eigen palet  (→Geavanceerde onderwerpen)
Oude muziek mogelijkheden (→Geavanceerde onderwerpen)
Basso continuo (→Geavanceerde onderwerpen)
Raster-gebaseerde verplaatsing van symbolen en notenbalktekst (→Tekst)
Afbeeldingsopname (→Opmaak)
Instellingenoverzicht en object eigenschappen (→Geavanceerde onderwerpen)
Maatbewerkingen: Splitsen en samenvoegen (→Basisfuncties)
MIDI importeren (→Geluid en afspelen)
Instrumentwijziging in notenbalk (→Geluid en afspelen)
Partijen maken (nieuwe opties beschikbaar) (→Geavanceerde onderwerpen)
Repetitietekens, Automatisch opvolgend repetitiecijfer/letter en Zoek naar een repetitieteken (→Tekst)
Opslaan/Exporteren (→Basisfuncties)
Notenbalk-eigenschappen (→Geavanceerde onderwerpen)
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Swing (→Geluid en afspelen)
Tablatuur (→Geavanceerde onderwerpen)
Nonexistant node nid: 39841 (→Geavanceerde onderwerpen)
Hoofdpalet (→Geavanceerde onderwerpen)
Opmaak en lay-out (sommige opties zijn gewijzigd en er is een "Pas toe op alle partijen" optie) (→Opmaak)
Afbrekingen en afstandshouders: sectie-einde (→Opmaak)
Selectie modus: Selecteer alle soortgelijke elementen nieuwe optie (zelfde subtype) (→Basisfuncties)
Maak een nieuwe partituur: Starthulpscherm (→Basisfuncties)
Taalinstellingen en bijwerken van de vertalingen (→Basisfuncties)
Helpen en verbeteren van de vertaling (→Ondersteuning)
Voortekens: Herbepaal toonhoogtes (→Notaties)
Vervang toonhoogte zonder het ritme te veranderen  (→Geavanceerde onderwerpen)
Gereedschappen (→Geavanceerde onderwerpen)
Partituur informatie (→Geavanceerde onderwerpen)

Bijwerken vanaf MuseScore 1.x

Hoe kan ik MuseScore bijwerken

Download en installeer de laatste versie van de Nonexistant node nid: 27 pagina zoals beschreven bij Installatie. Indien je
versie 1.x wilt verwijderen, kijk dan naar de installatie  pagina van het 1.x handboek.

Het installeren van MuseScore 2 zal versie 1.x niet de-installeren—beide versie kunnen zonder problemen naast elkaar
bestaan en zelf gelijktijdig worden gebruikt. Dus hiermee wordt het programma niet echt bijgewerkt maar wordt er een
installatie van een nieuw en ander programma uitgevoerd.

Openen van 1.x partituren in MuseScore 2

MuseScore 2 heeft significante verbeteringen ondergaan om de kwaliteit van de partituur te verbeteren en deze makkelijk
leesbaar te maken. Verbetering omvatten veel items zoals waardestrepen, stok hoogte, lay-out van voortekens in
akkoorden en algehele noot spatiering. Hierdoor wordt de bladmuziek die gemaakt is met MuseScore 1.x iets anders
weergegeven dan de bladmuziek die gemaakt is met versie 2.x.

Dit betekent ook dat een partituur die opgeslagen is met versie 2.x niet geopend kan worden in versie 1.x.

Om te voorkomen dat je per ongeluk je 1.x partituur overschrijft behandeld 2.x deze als geïmporteerd, wat betekent:

de partituur wordt gemarkeerd als zijnde aangepast, zelf indien je niets hebt gewijzigd
bij het verlaten van MuseScore wordt je gevraagd om de partituur op te slaan (als resultaat van bovenstaande)
MuseScore gebruikt het "Sla op als" dialoog voor het opslaan, niet het "Sla op" dialoog
MuseScore gebruikt de partituur titel om een bestandsnaam te maken in plaats van gebruik te maken van de oude
bestandsnaam

Lokale her-opmaak/lay-out

Indien je geen handmatige aanpassingen hebt gemaakt aan de opmaak van de 1.x partituur, dan wordt de versie 2.x type
instellingen programmatuur gebruikt om de opmaak van de partituur op te maken. Als je de opmaak van de 1.x partituur
wel hebt aangepast, dan zijn deze individuele aanpassing nog steeds aanwezig in MuseScore 2.x maar door kleine
wijzigingen in de omliggende opmaak kunnen ze wellicht niet juist in de context worden geplaatst. Indien je ook de
handmatige aanpassingen wilt herstellen met de 2.x type instellingen programmatuur door de gehele partituur, selecteer
dan de gehele partituur met de snelkoppeling Ctrl+A (Mac: Cmd+A) en herstel de opmaak met Ctrl+R (Mac: Cmd+R).

Het geluid gebruiken van MuseScore 1.x

Het geluid in 2.x is sterk verbeterd ten opzichte van 1.x maar wellicht gaat je voorkeur toch uit naar het geluid van
MuseScore 1.x. In dat geval kun het 1.x geluid krijgen in 2.x door het 1.3 SoundFont te downloaden en deze toe te
voegen in 2.x. Je kunt dit in doen met de volgende twee stappen:

1. Download het 1.3 SoundFont genaamd TimGM6mb
2. Installeer en gebruik het TimGM6mb SoundFont in 2.0

Ondersteuning
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Dit hoofdstuk beschrijft hoe je help kunt vinden voor het gebruik van MuseScore, de beste plekken om te kijken, de beste
manier om een vraag te stellen in het forum en tips voor het rapporteren van een bug.

Helpen en verbeteren van de vertaling

Heb je een vertaling om toe te voegen? Dat kan eenvoudig worden gedaan via het web, zoals uitgelegd in Development /
Translating  ...

Software vertaling

1. Vraag in het forum om de vertaling te verbeteren
2. Verbind je met Transifex/MuseScore http://translate.musescore.org , deze zal je doorzetten naar

https://www.transifex.com/projects/p/musescore
3. Selecteer de taal en de sectie waarmee je wilt helpen (musescore of instruments)
4. Klik op de "translate" knop (de tekst van de knop hangt af van de taal...)
5. Zoek naar de "strings" die je wilt vertalen (je kunt filteren op "reeds vertaalde items")

Hier is de technische uitleg: Continuous translation for MuseScore 2.0

Website en handboek vertaling

Zie Translation instructions

Zie ook

Taal instellingen en bijwerken vertaling, Bijwerken Vertaling

Hoe vraag je om hulp en vul je een bug rapport in

Voordat je de hulp vraag in het forum  plaatst:

Zoek naar een oplossing in het Handboek  (zoek in het Handboek )
Kijk bij de How Tos , FAQ  en Zelfstudies
Zoek  het forum van de website om te zien of iemand anders hetzelfde probleem al eens is tegengekomen

Bij het posten in de issue tracker  (for established reports) of het forum  (voor vragen/discussies):

Probeer het probleem met de the latest nightly  versie te reproduceren. Je kunt ook in de oude  en nieuwe
versie historie kijken of dit reeds is opgelost/geïmplementeerd.

Zorg voor zo veel mogelijk van de volgende informatie en limiteer ieder issue in één rapport:

Versie/revisie van MuseScore die je gebruikt (e.g. versie 2.0, revisie 2902cf6). Controleer Help → Over... (Mac:
MuseScore → Over MuseScore...).
Operating systeem dat wordt gebruikt (bv. Windows 7 SP1, Mac OS 10.7.5 of Ubuntu 10.10)
Indien je een bug rapporteert, beschrijf de exacte stappen die resulteren in het probleem (waar klik je op,
welke toetsen druk je in, wat zie je, etc.).

Indien je niet instaat bent om het probleem te reproduceren met de stappen, dan is het vermoedelijk niet waard om het te
rapporteren omdat de ontwikkelaars het dan ook niet kunnen reproduceren (en oplossen). Bedenk dat het doel van een
goed bug rapport is dat je niet alleen het probleem laat zien maar ook aan anderen laat zien hoe je het kan reproduceren.

Denk er aan dat je de partituur bijvoegd waarin het probleem zichtbaar is—gebruik de "Bestandsbijlagen" optie
onderaan de pagina, net boven de Opslaan en Voorbeeld knoppen bij het invoeren van je post.

Zie ook

How to write a good bug report: step-by-step instructions

Terug naar fabrieksinstellingen

Recente versies van MuseScore hebben de optie om terug te gaan naar de standaard ingebouwde instellingen of
"fabrieksinstellingen". Dit kan behulpzaam zijn als je instellingen corrupt zijn geraakt. Het is niet gebruikelijk dat dit
gebeurt, dus het is verstandig eerst in de forums te controleren, want er kan mogelijk een manier zijn om je probleem op
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te lossen zonder alles te herstellen.

Waarschuwing: Terug gaan naar "fabriekinstellingen" verwijderen alle aanpassingen die je hebt gemaakt in de
instellingen, paletten en venster instellingen.

Instructies voor Windows

1. Als je MuseScore open hebt staan, sluit dit dan eerst (Bestand → Sluit af)
2. Type Windows toets+R om het Uitvoeren dialoog te openen (De Windows toets  is die met het logo van Microsoft

Windows. Als alternatief selecteer je Start met de muis en kies je voor Uitvoeren, indien beschikbaar.
3. Klik Bladeren...

4. Zoek naar MuseScore.exe op je computer. De locatie is afhankelijk van je installatie, maar is het meest
waarschijnlijk zoiets als Mijn Computer (Deze PC) → Locale Schijf → Program Files (of Program Files (x86)) →
MuseScore 2 → bin → MuseScore.exe

5. Klik Openen om het Bladeren dialoog te sluiten en terug te keren naar het uitvoeren dialoog. De volgende tekst (of
iets dat daarop lijkt) moet in het Uitvoeren dialoog staan:

"C:\Program Files\MuseScore2\bin\MuseScore.exe"

Voor 64-bit Windows, is de locatie

"C:\Program Files (x86)\MuseScore2\bin\MuseScore.exe"

6. Klik achter het tweede aanhalingsteken en voeg een spatie toe gevolgd door een koppelteken en een hoofdletter F: -
F

7. Druk nu ok OK

Na een paar seconden moet MuseScore opstarten en zijn alle instellingen terug gezet naar "fabrieksinstellingen".

Voor gevorderde gebruikers, het bestand met de hoofd instellingen van MuseScore kan worden gevonden in:

Windows Vista of later: C:\Users\<USERNAME>\AppData\Roaming\MuseScore\MuseScore2.ini

Windows XP of eerder: C:\Documents and Settings\USERNAME\Application Data\MuseScore\MuseScore2.ini

De overige instellingen (paletten, sessie...) bevinden zich in:

Windows Vista of later: C:\Users\<USERNAME>\AppData\Local\MuseScore\MuseScore2\

Windows XP of eerder: C:\Documents and Settings\USERNAME\Local Settings\Application Data\MuseScore\MuseScore2\

Instructies voor Mac OS X

1. Als je MuseScore open hebt staan, sluit dit dan eerst (Bestand → Afsluiten)
2. Start Terminal (in Applications/Utilities) en een sessie venster moet verschijnen

3. Type (of kopieer/plak) het volgende commando in de terminal (inclusief de '/' aan het begin):

/Applications/MuseScore\ 2.app/Contents/MacOS/mscore -F

Dit herstelt alle MuseScore instellingen naar de fabriekinstellingen en start meteen de MuseScore applicatie. Je kunt nu
het Terminal venster sluiten en verder gaan met MuseScore.

Voor gevorderde gebruikers, het bestand met de hoofd instellingen van MuseScore kan worden gevonden in
~/Library/Preferences/org.musescore.MuseScore2.plist.

De overige instellingen (paletten, sessie...) bevinden zich in ~/Library/Application\ Support/MuseScore/MuseScore2/.

Instructies voor Linux (pas aan voor andere versie dan Ubuntu)

1. Als je MuseScore open hebt staan, sluit dit dan eerst (Bestand → Afsluiten)
2. Vanuit het Ubunte hoofd menu, kies Applications → Accessories → Terminal. Een Terminal sessie venster moet

verschijnen

3. Type (of kopieer/plak) het volgende commando in de terminal:

mscore -F
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Dit herstelt alle MuseScore instellingen naar de fabriekinstellingen en start meteen de MuseScore applicatie. Je kunt nu
het Terminal venster sluiten en verder gaan met MuseScore.

Voor gevorderde gebruikers, het bestand met de hoofd instellingen van MuseScore kan worden gevonden in
~/.config/MuseScore/MuseScore2.ini.

De overige instellingen (paletten, sessie...) bevinden zich in ~/.local/share/data/MuseScore/MuseScore2/.

Zie ook

Opdracht regel opties

Bekende incompatibiliteit met andere hardware en software

Hardware incompatibilities

Van de volgende software is het bekent dat MuseScore crasht bij het opstarten:

Samson USB Microphone, driver naam "Samson ASIO Driver", samsonasiodriver.dll. Meer info
Digidesign MME Refresh Service. Meer info
Windows XP SP3 + Realtek Azalia Audio Driver. Meer info
Wacom tablet. Meer info  en QTBUG-6127

Software incompatibiliteit

Van Maple virtual kabel is het bekend dat het voorkomt dat MuseScore  goed kan afsluiten.
KDE (Linux) venster instellingen kunnen er voor zorgen dat het hele venster wordt verplaatst bij het slepen van een
noot. Wijzig de venster instellingen van het besturing systeem  om dit probleem te voorkomen.

AVG Internet Security hangt MuseScore

MuseScore heeft toegang tot internet nodig met AVG. MuseScore heeft geen toegang tot internet nodig om te werken,
maar indien AVG het blokkeert dan hangt MuseScore.

Zodra AVG je bericht kies dan Toestaan voor alles MuseScore en vink de optie "Mijn antwoord als een permanente regel
opslaan en de vraag in de toekomst niet meer stellen" aan.

Als je geen melding meer krijgt, doe dan het volgende:

1. Open AVG (rechts-klik op het AVG icoon, vlak bij de klok -> Open AVG Gebruikers Interface
2. Klik op Firewall
3. Klik Geavanceerde Instellingen
4. Klik Toepassingen
5. Vind MSCORE.EXE in de lijst en dubbel klik er op
6. Wijzig Toepassingsactie in Toestaan voor alles

Lettertype probleem in Mac OS X

Het kan voorkomen dat MuseScorte noten als vierkant laat zien wanneer sommige lettertype beschadigd zijn in Mac OX
X.
Om dit probleem te verhelpen:

1. Ga naar Applications -> Font Book
2. Selecteer een font en druk op ⌘+A om ze allemaal te selecteren
3. Ga naar File -> Validate Fonts
4. Indien een lettertype wordt gerapporteerd als beschadigd of met problemen heeft, selecteer het dan en verwijder het
5. Herstart MuseScore, indien nodig

In dit forum artikel , meent een gebruiker gevonden te hebben dat het lettertype "Adobe Jenson Pro (ajenson)" dit
probleem veroorzaakt, het maakt hierbij niet uit of deze als beschadigd of met een probleem wordt gerapporteerd. Het
probleem is verholpen door dit lettertype te verwijderen. Controleer dit ook.

Lettertype probleem in Linux
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Als het standaard applicatie lettertype als vet is ingesteld, dan zal MuseScore the noten niet juist weergeven.
Om dit probleem te verhelpen:

Voor GNOME 2.*/MATE gebruikers:

1. Klik met rechts op het bureaublad en selecteer Change Desktop background
2. Klik op het Fonts tab
3. Stel Regular style for Application font in
4. Herstart MuseScore, indien nodig

Voor GNOME 3/SHELL gebruikers:

1. Open de shell en open "Advanced Settings"
2. Klik op de Fonts optie in de lijst
3. Zet het standaard lettertype op een niet-vet lettertype
4. Herstart MuseScore, indien nodig

Sla op als dialoog leeg in Linux

Een aantal gebruikers hebben gemeld dat het Sla op als dialoog leeg is in Debian 6.0 en Lubuntu 10.10.
Om dit te verhelpen:

1. Type het volgende in een terminal

which mscore

2. Dit commando laat de locatie van mscore zien. Bewerk dit met je favoriete tekst bewerker en voeg de volgende tekst
aan het begin toe:

export QT_NO_GLIB=1

Start nu MuseScore en het probleem zou verholpen moeten zijn.

Bijlagen

Bekende beperkingen van MuseScore 2.0

Ondanks het feit dat alle leden van het ontwikkelingsteam er alles aan gedaan hebben om de software eenvouding in
gebruik en bug-vrij, zijn er toch een aantal bekende problemen en beperkingen in MuseScore 2.0.

Basisfuncties

Sla selectie op

'Sla selectie op...' is momenteel erg gelimiteerd. Indien de selectie geen muzieksleutel, maat- of toonsoort bevat dan zal
de opgeslagen partituur een viool sleutel, in 4/4 maatsoort en in C majeur toonsoort zijn, waarbij alle toonhoogten
bewaard blijven. Voortekens worden toegevoegd waar nodig en zelfs onregelmatige maten worden bewaard.

Lokale Maatsoorten

De lokale maatsoort functie, die je instaat stelt verschillende maatsoorten in verschillende notenbalken te hebben op
hetzelfde moment is gelimiteerd. Je kunt alleen een lokale maatsoort toevoegen aan een maat die leeg is en alleen als er
geen gekoppelde partijen zijn. Wanneer de noten worden toegevoegd aan de maat met de lokale maatsoort, dan kun je
deze via de normale noot invoer mode invoeren echter kopie en plak werkt niet correct en kan resulteren in corruptie of
zelfs crashes. De samenvoeg en splits commando's zijn uitgeschakeld voor maten met een lokale maatsoort.

Noteninvoer

Tablatuur notenbalk gekoppeld aan een standaard notenbalk

Bij gekoppelde Standaard en Tablatuur notenbalken, moet bij het invoeren van akkoorden in de Standaard notenbalk van
boven naar beneden worden gewerkt. Anders kunnen de automatische fretsymbolen die noot voor noot worden
toegevoegd in de Tablatuur notenbalk een onverwacht resultaat opleveren (Opmerking: Dit geldt niet voor a) noot invoer
direct in de Tablatuur notenbalk en b) noot invoer in de Standaard notenbalk die niet gekoppeld is aan een Tablatuur
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notenbalk).

Geluid en afspelen

Instrument wijzigen

Het wijzigen van een instrument wijzigt niet de transpositie, indien dit van toepassing is op het instrument. Indien dit nodig
is, dan is het noodzakelijk om verschillende notenbalken te gebruiken en de 'Verberg lege notenbalk' optie te gebruiken.
Er is dus eigenlijk geen instrument wijziging, er is alleen een wijziging van het geluid. Het is niet alleen de transpositie die
niet wordt meegenomen maar ook het bereik van het instrument en de naam van de partij blijven onveranderd.

Mixer

Het maken van aanpassing in de waarden van de mixer markeert de partituur niet als aangepast. Dat betekent dat je bij
het sluiten van de partituur geen melding krijgt of je de wijzigingen wilt opslaan of niet. Het wijzigingen van de mixer
waarden kan ook niet ongedaan worden gemaakt.

Opmaak

Koptekst & voettekst

Er is geen manier om de koptekst en voettekst in een WYSIWYG (Wat je ziet, Is wat je krijgt) manier. De velden in
Koptekst, voettekst, nummers is gewone tekst. Ze kunnen "HTML achtige" syntaxis gebruiken, maar de tekst stijl,
opmaak, etc. kan niet worden bewerkt met een WYSIWYG bewerker.

Sneltoetscombinaties

De meeste sneltoetscombinaties kunnen worden aangepast via Bewerken → Voorkeuren... → Sneltoetscombinaties tab (Mac:
MuseScore → Voorkeuren... → Sneltoetscombinaties tab). Hieronder is een lijst met een aantal van de initieel ingestelde
sneltoetscombinaties.

Navigeren

Begin van de partituur: Home

Laatste pagina van de partituur: End

Zoek (maatnummer, repetitieteken of pXX waar XX een pagina nummer is): Ctrl+F (Mac: ⌘+F)

Volgende partituur: Ctrl+Tab

Vorige partituur: Shift+Ctrl+Tab

Dichterbij bekijken: Ctrl++ (werkt niet op alle systemen) (Mac: ⌘l++) of Ctrl (Mac: ⌘) + scroll omhoog
Verderaf bekijken: Ctrl+- (Mac: ⌘+-) of Ctrl (Mac: ⌘) + scroll omlaag

Volgende pagina: Pg Dn of Shift + scroll omlaag
Vorige pagina: Pg Up of Shift + scroll omhoog

Volgende maat: Ctrl+→ (Mac: ⌘+→)
Vorige maat: Ctrl+← (Mac: ⌘+←)

Volgende noot: →
Vorige noot: ←

Noot eronder (binnen een akkoord of op onderliggende notenbalk): Alt+↓

Noot erboven (binnen een akkoord of bovenliggende notenbalk): Alt+↑

Bovenste noot in akkoord: Ctrl+Alt+↑ (Ubuntu gebruikt deze sneltoets voor Werkruimten)
Ondersta noot in akkoord: Ctrl+Alt+↓ (Ubuntu gebruikt deze sneltoets voor Werkruimten)

Noteninvoer

Begin noteninvoermodus: N
Verlaat noteninvoermodus: N of Esc

Duur/Lengte
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1 ... 9 kiest de duur/lengte. Zie ook Noteninvoer.

Halve duur van vorige noot: Q
Dubbele duur van vorige noot: W

Stemmen

Stem 1: Ctrl+I Ctrl+1 (Mac ⌘+I ⌘+1)
Stem 2: Ctrl+I Ctrl+2 (Mac ⌘+I ⌘+2)
Stem 3: Ctrl+I Ctrl+3 (Mac ⌘+I ⌘+3)
Stem 4: Ctrl+I Ctrl+4 (Mac ⌘+I ⌘+4)

Toonhoogte

De toonhoogte kan worden ingevoerd met hun letter (A-G) of via een MIDI toetsenbord. Zie Noteninvoer voor de volledige
informatie.

Herhaal vorige noot of akkoord: R (de herhaalde noot of akkoord kan een andere duur/lengte hebben door eerste de duur
te selecteren)

Herhaal selectie: R (De selectie wordt herhaald vanaf de eerste noot positie na het einde van de selectie)

Verhoog de toon met een octaaf: Ctrl+↑ (Mac: ⌘+↑)
Verlaag de toon met een octaaf: Ctrl+↓ (Mac: ⌘+↓)

Verhoog de toon met een halve toon (voorkeur voor kruis): ↑
Verlaag de toon met een halve toon (voorkeur voor mol): ↓
Verhoog de toon diatonisch: Alt+Shift+↑

Verlaag de toon diatonisch: Alt+Shift+↓

Wissel door de enharmonische noten: J

Rust: 0 (nul)

Interval

Voeg een interval toe boven de huidige noot: Alt+[Nummer]

Richting

Wissel richting (stok, legatoboog, overbinding, antimetrisch figuur haak, etc.): X
Spiegel nootkop: Shift+X

Articulaties

Staccato: Shift+S

Crescendo: <
Decrescendo: >

Tekst invoer

Notenbalk-tekst: Ctrl+T (Mac:⌘+T)
System-tekst: Ctrl+Shift+T (Mac: Ctrl+Shift+T)
Tempo tekst: Alt+T

Repetitieteken: Ctrl+M (Mac: ⌘+M)

Liedtekst invoer

Liedtekst invoeren voor een noot: Ctrl+L (Mac: ⌘+L)
Vorige liedtekst lettergreep: Shift+Spatie

Volgende liedtekst lettergreep: indien de huidige en volgende lettergrepen worden gescheiden door een '-': -, anders Spatie

Verplaatst liedtekst lettergreep naar links met 1sp: ←
Verplaatst liedtekst lettergreep naar rechts met 1sp: →
Verplaatst liedtekst lettergreep naar links met 0,1sp: Ctrl+← (Mac: ⌘+←)
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Verplaatst liedtekst lettergreep naar rechts met 0,1sp: Ctrl+→ (Mac: ⌘+→)
Verplaatst liedtekst lettergreep naar links met 0,01sp: Alt+←

Verplaatst liedtekst lettergreep naar rechts met 0,01sp: Alt+→

Omhoog naar vorig couplet: Ctrl+↑ (Mac: ⌘+↑)
Omlaag naar volgend coulplet: Ctrl+↓ (Mac: ⌘+↓)

Voor meer liedtekst sneltoetsen zei Liedtekst.

Weergave

Navigator: F12 (Mac: fn+F12)
Afspeelpaneel: F11 (Mac: fn+F11)
Mixer: F10 (Mac: fn+F10)
Paletten: F9 (Mac: fn+F9)
Instellingenoverzicht: F8 (Mac: fn+F8)
Pianoklavier: P

Zie ook

Voorkeuren: Sneltoetscombinaties

Opdracht regel opties

Je kunt MuseScore starten vanaf een opdracht regel door het typen van:

mscore [opties] [bestandsnaam] (Mac en Linux)
MuseScore.exe [opties] [bestandsnaam] (Windows)

[opties] en [bestandsnaam] zijn optioneel.

Zie ook Terug naar fabrieksinstellingen voor gedetailleerde instructies hoe en waar het programma gevonden en
uitgevoerd kan worden vanaf de opdracht regel voor de verschillende ondersteunde platformen.

De volgende opties zijn beschikbaar:

-?, -h, --help

Help weergeven (werkt niet in Windows).
-v, --version

Laat de huidige versie van MuseScore zien zonder de grafische interface te starten (werkt niet in Windows).
--long-version

Laat de huidige versie en revisie van MuseScore zien zonder de grafische interface te starten (werkt niet in
Windows).

-d, --debug

Start MuseScore in debug mode.
-L, --layout-debug

Start MuseScore in lay-out debug mode.
-s, --no-synthesizer

Schakelt de geïntegreerde software synthesizer uit.
-m, --no-midi

Schakelt MIDI invoer uit.
-a, --use-audio <driver>

Gebruik audio driver: jack, alsa, pulse, portaudio.
-n, --new-score

Start met de nieuwe partituur wizard onafhankelijk van de voorkeurs instelling voor het opstarten.
-I, --dump-midi-in

Geeft alle MIDI invoer weer in de console.
-O, --dump-midi-out

Geeft alle MIDI uitvoer weer in de console.
-o, --export-to <bestandsnaam>

Exporteerd het geopende bestand naar de gespecificeerde <bestandsnaam>. Het bestand type is afhankeljjk vam de
bestandsnaam extensie. Deze optie gebruikt de "converteer" mode en heeft geen grafische interface. Je kunt ook
een bestandsnaam toevoegen indien je bestanden wilt importeren en exporten vanaf de opdracht regel.
Bijvoorbeeld mscore -o "My Score.pdf" "My Score.mscz"
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-r, --image-resolution <dpi>

Stelt de resolutie in voor het maken van "*.png" bestanden in de converteer mode. De standaard resolutie is 300 dpi.
-T, --trim-margin <marge>

Verwijdert de wit-ruimte rondom een partituur bij het exporteren naar PNG en SVG afbeeldingen. Het opgegeven
aantal pixels wordt gebruikt als de marge voor de wit-ruimte. Gebruik 0 voor een zo veel mogelijk bijgesneden
afbeelding. Voor SVG werkt deze optie alleen bij een partituur die uit een enkele pagina bestaat.

-x, --gui-scaling <factor>

Vergroot de weergave van de partituur en andere grafische elementen met de opgegeven factor. Dit kan worden
gebruikt bij hoge resolutie beeldschermen.

-S, --style <stijl>

Laad een stijl bestand. Handig wanneer je een partituur converteert met de -o optie.
-p, --plugin <naam>

Voert de opgegeven plugin uit.
--template-mode

Sjaboon opslaan mode, geen pagina formaat.
-F, --factory-settings

Gebruik de standaard ingebouwde instellingen of "fabrieksinstellingen" en verwijder alle voorkeuren. Voor details zie
Terug naar fabrieksinstellingen.

-R, --revert-settings

Gebruik de standaard ingebouwde instellingen of "fabrieksinstellingen" maar verwijder geen voorkeur instellingen.
-i, --load-icons

Laad iconen vanuit het bestandssysteem. Handig als je de MuseScore iconen wilt bewerken en een voorbeeld van
de aanpassingen wilt zien.

-e, --experimental

Schakel experimentele opties in. Zie bv. Layer (experimental)
-c, --config-folder <bestandslocatie>

Bepaal de locatie voor de configuratie.
-t, --test-mode

Schakel de Test Mode in.
-M, --midi-operations <bestand>

Specificeer het MIDI importeer bewerkingsbestand.
-w, --no-webview

Geen web info in het Startscherm.
-P, --export-score-parts

Gebruik met -o .pdf, exporteert partituur en partijen.

Qt Gereedschap Opties

-style= <stijl>

-style <stijl>

Bepaalt de stijl van de grafische interface die gebruikt wordt voor de applicatie. Mogelijk waarden zijn "motif",
"windows" en "platinum".
Afhankelijk van het besturingssysteem zijn er nog meer stijlen beschikbaar.

-stylesheet= <stijlblad>

-stylesheet <stijlblad>

Stelt het programma stijlblad in. De waarde van het "stijlblad" is de locatie naar een bestand dat het stijlblad bevat.
-platform <platformnaam[:opties]>

Specificeert de Qt Platform Abstraction (QPA) plugin.
Voorbeeld: MuseScore.exe -platform windows:fontengine=freetype

Zie ook

Terug naar fabrieksinstellingen
Layer (experimental)

Externe links

http://doc.qt.io/qt-5/qapplication.html#QApplication
http://doc.qt.io/qt-5/qguiapplication.html#QGuiApplication

Woordenlijst
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De woordenlijst is een "werk in uitvoering", help hier aan mee als je kunt. Je kunt hier over discussiëren in het
documentatie forum
De woordenlijst hieronder bevat regelmatige gebruikte termen in MuseScore en hun betekenis.

Acciaccatura
Een korte voorslag →Siernoten.

Achtste noot
Een noot waarvan de lengte een achtste is van een hele noot.

Akkoord
De minimale definitie van een akkoord is dat het een minimum heeft van twee verschillende noten die gelijktijdig
worden gespeeld.
Akkoorden zijn gebaseerd op de keuzes die gemaakt worden door de componist tussen de harmonische van één,
twee of drie (en meer) grondtonen. Bv. in het C akkoord, G is de tweede harmonische en E is de vierde van de
grondtoon C. In C7, is de Bes de zesde harmonische van C en in C Maj7 is B de tweede harmonische van E en de
vierde harmonische van G...

Anacrusis
Zie →Opmaat

Antimetrisch figuur
Een antimetrisch figuur verdeelt zijn volgende hogere noot waarde door een aantal noten anders dan de
aangegeven maatsoort.
Als voorbeeld, een →triool verdeelt de volgende hogere noot waarde in drie delen, in plaats van twee. Antimetrische
figuren kunnen →triolen, →duolen, →kwintolen en nog meer zijn.

Appoggiatura
Een lange voorslag →Siernoten.

Basso continuo
Basso continuo is een schrijfwijze die met name in barokmuziek veel gebruikt werd. Hierbij word een basis van de
harmonie weergegeven met een uitgeschreven baslijn. De harmonieën zijn weergegeven als cijfers onder de
basnoten. Het word daarom ook wel becijferde bas genoemd.

Besturingssysteem
OS

Een zet van programma's die geschreven zijn om een computer op te starten en daarbij de elektronica componenten
aanstuurt. Populaire systemen zijn: Microsoft Windows, Mac OS X en GNU/Linux.
Zie ook →Systeem

Overbinding
Zie →Legatoboog

BPM
Beats Per Minute (Tellen/Slagen Per Minuut) is de maateenheid voor het tempo. Zie →Metronoom markering

Duool
Zie →Antimetrisch figuur

Einden
Zie →Volta

Enharmonische noten
Noten waarvan de toon hetzelfde klinkt maar die anders worden geschreven. Voorbeeld: G# (Gis) en Ab (As) zijn
enharmonische noten.

Halve Noot
Een noot waarvan de lengte de helft is van een hele noot.

Herbepaal Toonhoogtes
Probeert de juiste voortekens te raden voor de gehele partituur (zie Voortekens).

Hulplijn
Lijn(en) die wordt toegevoegd boven of onder de notenbalk.

Koron
Een Iraans →voorteken dat een verlaging van de toon aangeeft en deze wordt verlaagd met een kwart toon (in
vergelijking tot een →mol die de noot verlaagd met een halve toon). Het is mogelijk om dit voorteken in de
→toonsoort te gebruiken.

Kruis
Teken dat aangeeft dat de toon van een noot met een halve toon moet worden verhoogd.

Kwartnoot
Een noot waarvan de lengte een kwart is van een hele noot.

Kwartool
Zie →Antimetrisch figuur

Kwintool
Zie →Antimetrisch figuur
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Longa
Een longa is een vierdubbele hele noot.

Maat
Een segment van tijd gedefinieerd door een aantal tellen. Door de muziek in maten te verdelen wordt een regelmatig
patroon van referentie punten in het muziekstuk gemaakt.

Maatstreep
Verticale lijn door een →notenbalk of een →systeem die de →maten scheidt.

Metronoom markering
Een metronoom markering bestaat meestal uit een noot lengte die gelijkstaat aan een bepaalde afspeel snelheid in
→BPM. In MuseScore worden de metronoom markeringen gebruikt in tempo tekst.

Herstellingsteken
Een herstellingsteken is een symbool dat de voorgaande aanpassing aan de noot met dezelfde toonhoogte opheft.

Mol
Teken dat aangeeft dat de toon van een noot met een halve toon verlaagd moet worden.

Notenbalk
Groep van één tot en met vijf horizontale lijnen die worden gebruikt om muzikale symbolen weer te geven. In de
oude muziek notatie (voor de 11e eeuw) konden de notenbalken ieder gewenst aantal lijnen hebben.

Opmaat (→Anacrusis)
Een deel (incomplete) eerste maat van een stuk of deel van een muziekstuk.
Zie ook Maak een nieuwe partituur: Maatsoort... en Maat bewerkingen: Sluit uit van matentelling

Partij
De muziek die gespeeld of gezongen dient te worden door één muzikant of een groep van muzikanten. In een
strijkkwartet zijn dit bijvoorbeeld: 1ste partij = 1ste Viool, 2de partij = 2de Viool, 3de partij = Viola en de 4de partij =
Cello.

Rust
Een moment van stilte met een bepaalde lengte.

Sextool
Zie →Antimetrisch figuur

Muzieksleutel
Een teken aan het begin van een →notenbalk om aan te geven wat de muzikale noten zijn op de lijnen en tussen
de lijnen.
Er zijn 2 F sleutels, 4 C sleutels en 2 G sleutels.F derde, F vierde (ook bekent als bas sleutel), C eerste, C tweede, C
derde, C vierde, G eerste, G tweede (ook bekent als viool sleutel).
G eerste en F vierde zijn equivalent.
Sleutels zijn erg handig voor het →transponeren.

Legatoboog
Een Legatoboog en een →Overbinding zijn twee woorden die worden gebruikt om een gebogen lijnen tussen twee
of meer noten te beschrijven.
Legatoboog betekent dat de noten gespeeld worden zonder aanslag (legato).
Overbinding wordt gebruikt tussen twee of meer noten van dezelfde toonhoogte om de lengte aan te geven:
Kwartnoot + overbinding + Kwartnoot = Halve noot
Kwartnoot + overbinding + Achtste noot = Gepunteerde kwartnoot
Kwartnoot + overbinding + Achtste noot + overbinding + Zestiende noot = Dubbel Gepunteerde kwartnoot

Sori
Een Iraans →voorteken dat een verhoging van de toon aangeeft en deze wordt verhoogd met een kwart toon (in
vergelijking tot een →kruis die de noot verhoogd met een halve toon). Het is mogelijk om dit voorteken in de
→toonsoort te gebruiken.
Zie ook →Koron

Spatie
Ruimte
Notenbalkafstand
sp (afkort./eenheid)

De afstand tussen twee lijn van een normale 5-lijnen notenbalk. In MuseScore beïnvloede deze eenheid de meeste
formaat/afstand instellingen. Zie ook Opmaak en Lay-out, Pagina Instellingen

Stem
Voor polyfonische instrument zoals Toetsenborden, Violen of Drums kunnen noten worden geschreven van
verschillende duur die op hetzelfde moment gespeeld moeten worden in een →notenbalk. Om dit te kunnen doen
wordt iedere stem onafhankelijk van elkaar in de →notenbalk geschreven.

Systeem
Systeem: Een set van notenbalken die gelijktijdig worden gelezen in een partituur.
Zie ook →Besturingssysteem (OS)

Toonsoort
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Een set van →kruizen of →mollen aan het begin van de →notenbalk. Het geeft een idee van de toonaard en
voorkomt dat deze tekens in de hele →notenbalk herhaald hoeven te worden.
Een toonsoort met een Bes betekent een toonaard van F majeur of D mineur.

Transponeren
Een melodie kan worden gespeeld in iedere toonaard. Er zijn veel redenen waarom je de toonaard van een partituur
zou willen wijzigen:
1. De melodie is te laag of te hoog voor de zanger.
2. De partituur is geschreven voor een C instrument en moet worden gespeeld door een Bes instrument.
3. De partituur is geschreven voor een orkest en je wilt je kunnen inbeelden wat de hoorn, de fluit en de klarinet
spelen.
4. Een donkerder of meer opgewekt geluid is gewenst.
- In het eerste geval zal het gehele orkest moeten transponeren, dat is erg moeilijk zonder professionele
muzikanten. MuseScore kan dit eenvoudig voor je doen.
- In het tweede geval moet de muzikant een D spelen terwijl er een C is geschreven. Indien de partituur is
geschreven met een G tweede sleutel, dan moet hij denken dat de notenbalk begint met een C derde sleutel.
- In het derde geval moet de dirigent alle notenbalken transponeren die niet geschreven zijn voor C instrumenten.
- In alle gevallen moet de toonsoort in gedachte worden gewijzigd.
- Op sommige instrumenten (bijvoorbeeld de hoorn en tuba) kunnen de muzikanten transponeren met alternatieve
vingerzetting.

Triool
Zie →Antimetrisch figuur

Vervang Toonhoogte Mode
Een manier in MuseScore om een passage te herschrijven waarbij de noot veranderd maar het ritme niet (zie
Vervang toonhoogte zonder het ritme te veranderen )

Vlag
Zie →Waardestreep

Volta
In een sectie van de muziek die moeten worden herhaald is het gebruikelijk dat de laatste paar maten van de sectie
verschillen. De markeringen hebben de naam volta en worden gebruikt om aan te geven hoe en wanneer ieder
einde moet worden gespeeld. Deze markeringen worden ook wel simpelweg →einden genoemd of ééntjes en
tweetjes.

Siernoten
Siernoten worden weergegeven als kleine noten voor of na een normaal formaat hoofdnoot. Een korte voorslag
(→acciaccatura) heeft een streep door de stok en een lange voorslag (→appoggiatura) heeft dat niet.

Voorteken
Voortekens staan voor een noot en veranderen de hoogte.
Voortekens worden gebruikt om de toonhoogte van een noot in een stuk te veranderen. Hetzelfde symbool zoals in
de →toonsoort wordt gebuikt maar ze worden geplaatst voor een bepaalde noot. Voortekens zijn bijvoorbeeld
→kruizen, →mollen en →herstellingstekens. Voortekens zijn van invloed op alle noten met dezelfde →notenbalk
positie en gelden voor de rest van de maat waarin ze staan maar ze kunnen worden opgeheven door een ander
voorteken. Bij noten die over de →maatstreep zijn doorverbonden met een overbinding, geldt het voorteken ook
voor de overgebonden noot in die maat maar niet voor de verdere noten in die maat op dezelfde positie van de
→notenbalk.

Waardestreep
Noten met een duur van een achtste noot of korter hebben een →vlag of een waardestreep. Waardestrepen worden
gebruikt om noten te groeperen.

Werkelijke toonhoogte
Hiermee kun je schakelen tussen de werkelijk toonhoogte en de transponerende toonhoogte (zie Werkelijke
toonhoogte en Transponeren)

Externe links

http://www.robertcarney.net/musical-terms-definitions.htm
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Checking for updates

Basisfuncties

Create new score (→Getting started)
Note input
Concert pitch
Copy and paste
Edit mode
Measure operations
Palette
Preferences
Save/Export/Print
Selection modes
Undo and redo
View modes
File format
Share scores online

Notation

Note input (→Basics)
Palette (→Basics)
Accidental
Arpeggio and glissando
Bar line
Beam
Bracket
Breath and pause
Clef
Drum notation
Grace note
Hairpin
Key signature
Lines
Measure rest
Repeat
Slur
Tie
Time signature
Transposition
Tremolo
Tuplet
Voices
Volta (1st and 2nd time endings)

Sound and playback

MIDI import
Mid-staff instrument change
Play mode
Soundfont
Swing
Tempo
Dynamics
Change and adjust sound

Text

Grid-based movement of symbols and staff text
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Rehearsal marks
Text editing
Text style
Chord symbols
Fingering
Lyrics
Tempo (→Sound and playback)

Formatting

Layout and formatting (overview)
Breaks and spacers
Frame
Image
Image capture

Advanced topics

Accessibility
Album
Cross staff beaming
Custom palette
Early music features
Figured bass
Fretboard diagram
Inspector and object properties
Master palette
Part extraction
Plugins
Replace pitches without changing rhythms
Score information
Staff type properties
Tablature
Tools
Nonexistant node nid: 39841

New features in MuseScore 2.0

What's New in MuseScore 2
MuseScore 2.0 Release Notes

Changes for MuseScore 2.0 .

Album (→Advanced topics)
View modes: Continuous view and Navigator (→Basics)
Copy and paste: Selection filter (→Basics)
Custom palette  (→Advanced topics)
Early music features (→Advanced topics)
Figured bass (→Advanced topics)
Grid-based movement of symbols and staff text (→Text)
Image capture (→Formatting)
Inspector and object properties (→Advanced topics)
Measure operations: Split and join (→Basics)
MIDI import (→Sound and playback)
Mid-staff instrument change (→Sound and playback)
Part extraction (new options available) (→Advanced Topic)

Rehearsal marks: Automatic next rehearsal mark and Search for a rehearsal mark (→Text)
Save/Export (→Basics) - Staff type properties (→Advanced topics)
Swing (→Sound and playback)
Tablature (→Advanced topics)
Nonexistant node nid: 39841 (→Advanced topics)
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Master palette (→Advanced topics)
Layout and formatting (some options have changed, and there is a new "apply to all parts" feature)
(→Formatting)
Breaks and spacers, section break (→Formatting)
Selection modes, select all similar new options (same subtype) (→Basics)
Create a new score, start center (→Basics)
Languages settings and translation Updates (→Basics)
Helping and improve translation (→Support)
Accidentals, respell pitches (→Notation)
Replace pitches without changing rhythms  (→Advanced topics)
Tools (→Advanced topics)
Meta tags (→Advanced topics)
Upgrading from MuseScore 1.x

Support

Helping and improve translation
How to ask for support or file reports
Revert to factory settings
Known incompatibilities

Appendix

Keyboard shortcuts
Bekende beperkingen van MuseScore 2.0
Command line options
Glossary
Handbook for MuseScore 1.x
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